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r•'•_"· FACULTAD DE INGENIERIA U.N.A.M. 
DIVISIOI',I. DE EDUCACION CONTINUA 

C:L CE~TRO ::>C: I:-iFOR!"~\Cim: Y DOC. _:::ACIOS "ISG. BR\iSO ~.ASCA.'iZO:ii" TIENE 

PQ:t Oª,,lETIVO SATISFACER L~$ ... :lEC)::S.DAD::S DE AC7\iA:.IZACION AL -PRO?ORCIQ~:.!..'>.-

·. "'"·LA ADECüADA ~:::rOR..'t;c:q:i· Q::E··?ER..'{I-TA'·A;;::,os ?ROFESro:;ALES IióGENIERO~('¡);fcE- .. 
. 

· S ORES Y ~LL<C\CS, ES7AR A!,. p,:;;:o D.::!.. .E5JA.DO AC':::.iAl. DEL CONCCI~IC:NTO SOB?.E-

·TE:-L\5 _ESPECIFICO$ E:lFATIZA.'iDO LAS INVES7!GACIONES !lE VA.'lGUARDIA DE. LOS 

CA.'!POS. DE 'LA INGENIE?.IA :A:;ro SACIO:iALES CO~O EXTR.A.'lJERAS. 

POR LO QUE SE PONE A DISPOSICION DE LOS ASIS7ENTES DE !..OS CURSOS DE LA 

D.C:.C.r.I.; ASI CC~O AL PoBLICO C:N GENER..\L. 

EN DICHO CEH?.O USTED TEN;JR.-\ LOS s:GUIENTES SERVICOS: 

* PREST.!..'!O INTER..'iO 

. * PRESTA.'!O EXTER.'lO 

* PRESTA.'!O lNTC:RBIBLIOTECARIO 

* SERVICIO' DE FOTOCOPIADO 

* CQNSULTA TELEFONICA 

* CONSULTA A LOS BA.'lCOS DE DATOS: LIBRUNA.'! EN CD-ROM Y EN LINEA 

LOS MATERIALES A SU DISPOSICION SON: 

* LIBROS 

* TESIS DE POSGRADO 

* NOTICIAS TECNICAS 

* PUBLICACIONES PERIODICAS 

* PUBLICACIONES DE LA ACADEXIA ~~XICA.'lA DE INGENIERIA 

* NOTAS DE LOS CURSOS QUE SC: HA.'i I~2ARTIDO DE 1971 A LA FECHA. 

~ EN LAS AREAS DC: INGENIERIA INDUSTRL\L, CIVIL, · ELECTRONICA, CIENCIAS DE LA

;TIERRA, MECA.'iiCA Y ELECTRICA Y CO~PüTACro:;. 

EL C. l. D. SE ENCUENTRA t.:BICADO EN EL :-tEZZA.'ilNE DEL PALACIO DE MINERIA LADO 

ORIENTE. EN HORJ\RIO DE SERVICIO DE 10:00 .A 19:30 HORAS DE LUNES A VIER.'lES. 

1 ~. 

PJior.io do Mintro'a C•ll• do T"ub• S Prim" pi>o Oolog. CuJUhtémoc 06000 Mhico, C.F. Tri.: 521-40-20 Apdo. Postol M-2285 · 
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FACULTAD DE DNGENIEAIA U.N.A.M. 
D!VDSiON DE EDUCACION CONTINUA 

A LOS ASISTENTES A LOS CURSOS DE LA DIVISION DE EDUCACION CONTINUA 
_.-

L~ a~a~dadeA de ta Facultad de Inge~eALa, pa~ conducta det Jeóe de ta V~v~~ón 
de Educa~ón Ca~nua, ata~gan una co~tan~a de ~~tenCia a q~eneA cwmptan con 
tao ~eqwdao eAtabte~dao pMa cada· cUMa. 

Et ca>Lt~at. de. ~~te.nUa o e. Ue.vaM a cabo a tMvú de. ta pe.Mona que. te. e.~e.gó 
t~ no~. · L~ ~n~~te.n~ oe.Mn comp~ad~ pM w a~o~dadeA de ta V~v~~ón, 
con et ó~n de. e.~e.gMú co~tanUa oó!ame.nte. a. loo a!wnnoo que. te.nga.n un IIÚ.Mmo 
det' 80% de. ~~te.n~. 

Pe~oo a. too ~~.te.nteA ~e.cog~ ou co~ta.n~a et cUa. de. ta ~Ma.. Eo~ oe · 
~Ue.ndMn pM et pe.!Uodo de. w1 a.iio, p~a.do eAte. tiempo ta VECFI no oe ha.M ~eA
po~a.bte. de eA te documento. 

Se. ~eco~enda. a too ~~tenteA pMti~paJt activamente con ouo ~de~ y expe.Uen~~, 
pueA too cUMoo que o6Jtece ta V~v~~ón eA.tá.n ptane.adoo pa.Jta. que too PMÓehMeA 
expongan una tú~, p~o M bite todo, pq;ta. que coM~nen w op~~oneA de todo o too 
~nt~eAa.doo, co~tduyendo v~da.d~oo o em-i.na.~oo. · · 

Eo muy ~po!tta.nte i¡ue todoo too ~~tenteA Uenen y e~eguen ou hoja. de ~no~p
~ón a! ~~~o det cUMo, ~nóotuna.~ón que o~v~ pa.Jta. ~ntegJta.Jt un ~ecto~o de 
~.U.tenteA, que o e ent!tega.M opoll.Wnamente. 

Con et obje..to de mejoJta.Jt too o~v~~oo que ta V~v.ú.,~ón de Educa.~ón Continua o6Jtece., 
a.t Mna! det cUMa debe.Mn e~ega.Jt ta eva.!ua.~ón a tMvú de un c.ueAtion~o fue.
iia.do pa.Jta. ~ j~~oo a.nóMmoo. 

Se Jtec.o~enda. Uena.Jt ~c.ha ev~~ón canóoJtme tao p~oóeAMeA ~pa.J[}":z.n ouo cWeA, 
a. eóecto de no Uena.Jt en ta ú..U-i.ma oeA~ón m ev~~oneA y con él>;:o oean má..o 
6eha~enteA ouo a.p~eUa~oneA. 

GRACIAS' 

Palacio de Mineria Calle de Tacuba 5 Primer piso Deleg. Cuauhtemoc C6000 Mexico, D.F. APDO .. PostaiiJ-2285 
Telefonos: 512-8955 512-5121 521-7335 521-1987 Fax 510-0573 521-4020 AL 26 
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Module 1: Using Visual Basic 1? 

1 

L. Overview 

.· .. · 

• Visual Basic Tools 

• Building a Simple Visual ~asic Application 

• tit~ual Basic Menu Commands 

Overview 
The purpose of this module is to introduce youlo the key elemenls of Visual Basic. 
This is not intended to be an exhaustive revicw of all f1111L'tions and tools; rathcr. it 
is designed to get you up and running on thc prm.luct. l.illl'r mmlull!s will rlesh out 
all of the delails that you need lo know lo beco me Visual llasic programmers. 

The bes! way to leam about Visual Basic is lo revicw lhe in~ivi~ual functions in 
each majar portian ofthe Visual Basic interface an~ then w:ilk lhrough thc stcps 
you should follow to develop an application. 

The module is divided into three major sectinns. Thc rirst major scction is a lccturc 
about thc clemcnts of thc Visual Basic applicatitm thott ytHJ use in !he crcation tli' 

otpplications. Thc sccond iS a dcmonstration wllcrc thl· ¡r;,inn w;ilks yotJ thro11¡~1i tlw 
upplication dcsign proccss ami you cmlup with ;1 t:o111pilcd l'.Xl'CUtablc rill·. Thl· 

lin:1l scction is a h1h lhal gives you homds-on praclin· nsin~ snllll'lll'lhl' 1tu1ls lh;JI 
ynu htiVC jusi hecn introdw.:cd lo. 

Prerequisites 
There are two key skills that you nced for succcss inlhis moJull:: 

• _Practice in using a mousc 

• Understanding of graphically base~ applicalions 

Overall Objective 
At the end ofthis module, you will llave .<.;ucccssrully l"Jl';Jil.'d yom firsl Vi . ..;uod ]{;¡_..;rl 

application. · 
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Learning Objectives 
¡\¡ thc cnu nf this mouule, you will be able 10: 

• i>csign an applicalion user interface using the Form window, Toolbox, toolbar, 
allll Property wind9w. 

• Narne and savc thc application's forms ard próject files. 

• S tan and stop"" application from the Visual Basic menu and/or the toolbar. 

• Crcatc an cxccutablc file '-!ild add it toa Windows group. 
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L, Visual Basic Tools 

• Form and Project Windows 

• The Joolbox and Properties Window 

• Jhe Toolbar and Code Window 

~------------~ 
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20 Module 1: Using Visual Basic 

Form and Project Windows 

·.:. 

~-------F-.-~-,-------a~ 

What ls a Form? 
Fom" <liT !he hca1:1 of a grnphically based application. They are whatthe user sees 
;nul inrcrarts wirh in ordcr to accompli!-ih ~omc task. They are al so thc place whcre 
yo11 lw).!irt ro huild applic;.Hions~ onthc:m you pl<.~cc controls-commomú buttons, list 
ho.\C.'-. ''Piion hulltms-that prcscnt tllc uscr with the choiccs tho1t thcy ha ve. 

What ls the Project Window? 
Thc l'n ojee! window is a listthat Visual Basic uses lo keep trae k of the fonns that 
you are using foryour application. You will ha ve as many .FRM ti les listed in the 
Projec1 window as you ha ve Fonns in your appJication. In addition you may ha ve 
other filcs-.llAS and .VBX files-but we will hold off talking aboutthose for a 
lillk· while. 

.------
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Module 1: Using Visual Basic ------------------------------------

The Toolbox and Properties Window 

Pointer 

Label 

Frame 

Check Box 

Combo Box 

Horizontal Scroll Bar 

Timer 

Directary List Bax 

Shape 

lmage 

Custam Cantrals (·. VBX) 

What's in the Toolbox? 

-
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t=:J 
l(;l 

IG1il 

m 

~ 

I!W 
o 
(!) 

~ 

fil 
El 

~ 

' 
~ 

Picture Bax 

Text Box 

Cammand Bullan 

Optian Bullan 

List Box 

Vertical Scrall Bar 

Orive List Bax 

File List Bax 

Une 

. Data Conlrol 

As the name suggests, the Toolbox is whcrc you go to gt:t thc basic elements or 
everyWindows-based applicmion you crcale in Visual Hasic. 

There are two ways that yol.J'can place controls on u fnnn, t.:ithcr by doublc-clickin~ 
the control tool in the Toolbox or by clicking and dragging thc control. For thc nms1 
pan, either method has thc smúc rcsuii.'Whcn you dootohk-rlid a tool, the control 
shows up in the middle of the form; so you then ha ve lo olrag lhr control lo tloe 
corred position on the fonn. · 

Each control that you place on a rorm has ;1 SCI ofpropL'rliL'S that you C:lllliSl' in 
order to get the right-"look ~md ICe!" for your applicollit•ll. For thL· ti111c hcin~. ;di yt•ll 

nccd to know is thatthcrc are propcnics to cach contnd. In latL'r llHJúuk:s you will 
gct a much clo:;;er Iook at thc most commiJilly ttscd pntjlL'rtil'S 1"111' llHJst ,,flliL' lt~ttls i11 
thc Toolbox. 

Custom Controls 
You can add controls to the Toolbox. Sorne thinJ panics h<~vc nt;~lted custmn 
controls that you can purclwse .scparatcly. Thc ProiCssi~tnal cditinn of Visu;ll H;L..,¡L'· 
contajns various custom controls. 

L To Add a Custom Control 

l. From the File mcnu, choosc At.h.l File. 

2. Select the appropriatc ti le. Custom Control files l1<01'c ;o .VI! X cxlcnsion. 

3. Choose OK. 

- - _j 
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What Are Properties and How Are They Set? 
Propcrlies for a control are set using the Properties window: 

_I To scl properlics 

l. Click th~ control whosc propcrties you want set. 

2. Snoll the Propcnics Jist on the Propenies window until you find the propeny 
you want lo sct anO sclcct it. 

·'· !'lace thc valuc ror the propcny in thc Settings combo box. 

4. C:lick the check box to the left of the Settings combo box. 

What ls the Toolbar? 
. Thc toolharprovidcs quick access to common commands or functions. These 

functions-likc saving projects and starting the application during thc dcsign phasc 
--ar'l· alsn availahlc f'rom tllc Visual tlasic mcnus as wcll as through acccss mHJ 
shmtcut kcys. 

Nine o!" thL· relevan! itcms on thc toolbar are. 

·r·~~~•llwr i\·Jcnu ¡mlh Shurlnal kcys 

Nt·w·h•rln From thc ¡:¡¡e mcnu, n/a 
choosc New Form. 

Ncw f',.lodulc From thc File menu. n/a 
choose Ncw Module. 

_( Jpt:ll I'IOjl'L"1 hHm thc File mcnu. u/a 
~.:hous~.: Opcn Prujc~.:t. 

Sa\·t,· l'1o¡erl From the File menu, nla 
choose Save Project: 
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Toolbar Mcnu Polh Shurtrut Keys 

Menu Design window From the WilllJow menu. <THI. +M 

choose Menu Dcsign. 

Propenies window Fromlhe Window menu. F-1 

choose Properties. 

Siart From the Run mcnu, F5 

choose Run. 

Break From thc Run llll'lltt. (. 11<1. + IU<EAK 

dmosc Urca~. 

End From the Run mcnu .. nht 
choose End. 

Note The rest of the functions dcal with dchugging ;md will hl' covcrctf durin}! that 
module. 

Position and Size Coordinates 
Visual Basic displays thc coordinntes for the uppcr-kft l't 1rr1cr ftJI' cach control t >11 

1he form relative to the insidc upper-lefl corner of !he f, •rm. 11 al so displays lhc 
width and height of the conlrol. You can sellllese ""'"" hy placing the form or 
control approximately where you want it, or you can spccify Lcft and Top 
coordinates from the Properties lisl. The unit of mcasurcmcnl is in twips Ohcrc al\' 
1,440 twips in an inch). You wi.lllind outlalcr that yotrcan changc this unit of 
measurement to something yóifUre more famili<lr with. 

What ls a Code Window? 
CmJe windows displ:.1y thc codc that implcmcnts your appliL·atiun. Al l'irst ( 'lllk 
windows only contain the tcmplatc for proCcUurcs amltúnL·tions: you will add IIHII\' 

code to them as you dcvelop your l.lpplication. Thcrc are ..... cvcral ways to opcn ;1 

Code window. The easiest way is to doublc-click thc ohjl'l·t \','hose cmJc ye~u want 1~ 1 

vicw. For examplc, to loca te thc Clitk cvcnt tcmplatc h 1r" nlnHnilnd httllllll, 

double-click the command button on the form during de>ign lillll'. 

' Form1.frní · •· Uli!S 
Objecl: 

Sub Cormnandl_Click () 
1 
End Sub 

.} . 
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Building a Simple Visual Basic Application 

~ Helio, World! ~~ 

Walk Through- Building a Visual Basic Application 
L To st:ort IVOIU.I> 

l. Frorn the Walk Throughs program group, start WORLD. 

The purposc uf this littlc application is to give you a chance to walk through 
"""'uf thc m:rjor stcps necded for developing a Visual Basic application. 

llo\\' docs thc application work? 

lt has one text box and two command buttons . 

..., Choosc thc Fill button. 

Wlrcrr thc u ser clicks the bullan, text is revealed in the text box. 

1 ChtJoSt' thc Clcar huttnn. 

\Vhl·n the uscr di(.;ks this buuon, thc te-xt inthc tcxt box is clcan:U. 

4. ()uit tire WORLD application. 

Fro111_thc Control rnenu, choosc Clase. 
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[§ 

L To start Visual Bask 

l. Double-click the Visual Basic icon. 

Visual Basic will sta1t with a blank form 011 thc SL"I'I'l'll. 

ffi! Form1 · 1§11 

-~ 

1 

2. Resize the form to: 

Height 2700 

Width 4065 

L To dcsign thc base forn~ 
111e first stcp in dcsigning thc uscr interface is lo SL'I lhL· propL"rtics lúr thl' 

npplication's base form. In this case. sct thC propntil's i'or tlll' 1-lcllo. \VL1rhl~ 
fonn. 

l. In lhe Propenies ~indow Propcnics list, sclcct BadC'olor. 

2. Click the ellipsis ( ... ) at the en u of thc lextlmx . 

3. Selecta shade of green. 

The background of the form turns grcen. Selccting any color will automati¡:ally 
hidc the color palcuc . 

4. In the Propenies list box, select Caption . 

5. In the text box, typc Helio, World! 

The Form tille bar will conlain Helio, World 1 

6. In the Propenics window Propcnies lisl, sclcc,L N;uuc· 

7. In the text box, type frmWorld 

L To add controls and sct propcrlics 

To creme thc form's controls, doublc-click thc <~ppropri:lll' htttlnns in thc Toolho.\ . 

l. Doublc~click thc Clunmand buthm hHll in tl1c TlullhiL\ . 

2. Set the following propenies: 

Caplion Fill 

Nant!! 

FontSizc 

crndl'ill 

IX 

3. M ove the Fill button to thc uppcr-right comer uf Lile f, rrnL 
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~- 1 ¡, •uhle-clid 1hc command bullan loo! in the Toolbox. 

5. Scl !he following properties: 

Capl inn Clcar 

Nanll' crndCiear 

h1111Sizc IX 

1>. M ove lhe C/car bullan lo lhe lower-right corner of the form. 

7_. 1 Jouhlc-click thc.tcxt box too/ in the Toolbox. 

X. Se! !he following propcrtics: 

Na111c 

Tcxl 

lxtBox 1 

De/ete any text in the text box for this propeny. 

I Tu mhlthc IJ"sic codc to cnablc thc controls 

lnlhis sic p. codc wi/1 be added lo actívate the functionality ofthe controls in the 
li>rm. Thc codc wi/1 enable the text box to be filled with the words Helio World! 
whcn thc user clicks the Fill bullan and enab/e the text box to be c/eared when thc 
uscr clicks the C/car buuon. 

1. 1 Jouhlc-click lhc Fi/1 button that you just created to open the Code window. 

Whcn you doub/c-click lhis cornrnand button, Visual Basic brings you directly to 
_lile lcmplalc for a procedure that responds toa Click event for this control. The 

. lliiiiiL'S of cvcnl proccdurcs follow thc paltcrn: 

S11b ohjectname_eventname () 

In lllis c;,¡sc thc procedurc is named: 

s.n, ':rrtc1Fil1_Click ( J 

Al.so note 111:11 Visual Basic pro vides thc statcrnent that cnds thc subroutine: 

End é;>ub 

In thc graphic bc/uw, notice thatthe object name shows up in the Objectlist box 
'"' 1hc lcft, and 1he evcnt name shows up in the Procedure list box on the right . 

. :,.,;. . frmWorld.frm · Jrl&\11 
O!Jject: 

Sub cmdFill Click () 
1 

End Sub 
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2. Add the following code: 

txtBoxl. Text = •Hello. World!" 

Add a line ofcodc bctwccn thc two lincs orthc ll'111pla1L' l"nr thc Click L'\'L'Ill 

procedure. This code gives the application the targct for the action (rilling thL' 

text box) and the contents that you want assignerJ to thL• tcxt hox. In this ca . ..;e. 
"Helio, World!" is the contents. 

3. In the Object list box, select cmdCiear. 

4. Add the following text: 

txtBoxl.Text = •• 

lnside the template for this Click cvent proccU.urc. ildd it linc or cm.Jc to givc thl' 
application th'e target for the action (clearing the tc>..t h11x) ami the contcnts that 
you want assigned to thc text box. In this case the contcnts is an empty 
string (""). 

L To save your work 

~----------------

Befare you create an ~xecutable version of thi.s Visual Basic <1pplication that you 
can run directly in Windows, you should savc thc sourn· ende tu disk. You will dtt 

this through two actiorys-saving thc fonn :md ~aving thl' projcct. 

l. From the File menu, choose Savc File As. 

1! Save File As; · · · 
· · File t::!ame: 

I".FRM 

c:\walkthrulsamples 

Direclories: 

1 ... 1 
1-a-1 
1-c-] 
1-d-] 
1-z-] 

In-· ., .. 1 
:lc•'OK··' 

Cáncel 1 

2. Make the current directory C:IW ALKTIIR UISAMI'I .1 '.S 

3. Save the file as WORLD.FRM. 

4. Choose OK. 

5. From the File menu, choose Save Projcct As. 

6. Save the file as WORLD.MAK. 

7. Choose O K. 

-
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,L Tu lllilkl· ;m cxcculablc file 

TonL'ate an cxccutablc lite, m<~kc ~u re the source code for the project is open in 
Visual Ba~ic. 

l. From the.Filc mcnu, choose Make EXE File. 

2. ·Make the currcnt directory C:\WALK1HRU\SAMPLES . 

.1. Savc thc file'" WORLD.EXE. 

~· Chnnse. OK. 

5. Minimize Visual Basic. 

I Tu start the executable from Windows 

You can start :.111 cxccutable ti le from Windows in two ways: 1) cre~te a program 
)!foup. and add the namc of tlu: rrlc to thc group; or 2) swn Prognun Manager, opcn 
thc Hll' lucnu, antl chuosc thc Run command. We'll use the tirst mcthod. 

l. Fro111thc Program Manager File rncnu, sclecl Ncw. 

Tlic Ncw Progmm Object dialog box appears. 
1 Sclcct tlle Program Group option. 

:l. Choosc OK. 

Tlic l'rogram Group Properties dialog box appears. 

In lile Group Propcrties Dcscription control, name the group something like 
Si\MI'LES. 

4. In thc Group File control,typc SAMPLES 

'i. C:IHIOSC OK. 

A hlank window will appear. 

(l. FnHllthe Program Mant:~gcr File menu, choose New. 

Tlic New Program Object dialog box appears with the Program Item option 
sckctcJ. 

7. Chnose OK. 

The Program ltems Propertics c.Jialog box appears. · 

X. N ame the application. 

In the Description control, name the application WORLD or another name that 
rcflccts its function. 

Now comes the lricky pan. You need to hclp Windows !acate thc cxccutablc lile 
tiJa! you CfCiltCU. 

tJ. Click !he Urowsc buuon. 

The B1owsc winc.Jow will appcar. 

111. Sl'lcct llrives and directorics to loca te WORLD.EXE . 

. 11 sl>onld he in C:\WAI.KTHRU\Si\MI'LES. 
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11. Choose OK. 

The Program Items Propertics diaiog box appears with WORLD.EXE in thc 
Command Line text box . 

12. Choose OK. 

29 

The SAMPLES Program Group will appcarconwininp WOI<LD ;.md ;¡ pro~r;un 

icon. 

L To run your application 

• Double-click the World icon. 

The Helio, Worldl application will start in lhc samc .-.nccn location whcrc llll' 
form was created. 

L To stop your application 

l. Click the Control mcnu in the upper-left comer nf thc 1 kilo. Wnrld 1 form. 

A menu will appear. 

2. Choose the Close command. 

Windows el oses' the application for you . 

.... 
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Visual Basic Menu Commands 

• Managing Forms and Projects: The File Menu 

• Editing Visual Basic Cede: The Edil M en u 

• Testing Applications During Development: The Run Menu 

• Visual Basic Window Management: The Window Menu 

• Getting More lnformation: The Help Menu 

In otclt•t lo d¡,;vl'lup thc silllpkst uf applications, thcrc are a numbcr uf Visu;.¡J I.Jasic 
conrnwral~ that you necd to know about. Below is a brief listing of these commands. 
Thc list is not cxllauslive: therc are a couple of lopics that ha ve been lefllo a later 
lll! ldtill' 

Managing Forms and Projects: The File Menu 
• t\dding a Ncw Form 

1 :¡k rncnu, Ncw Form 

• 1\dding an Existing Forrn toa Projcct 
l'ilc mcnu, AJJ File. 

• 1 kll'ting a Form from a Projcct 
hlc menu, Rcmove File 

• Making an Exccutable File 
hit' rncnu, M;rkc EXE File 

• l'rinting Cutfc 
_ t=ilc menu, Print, select Code option 

• Printing Forrns 
File menu, Prinl, select Form option 

• Saving a File and Naming [t 

¡:¡¡l' llll'nu, S ave File As 

• Savi·ng a Form 
File rncnu, Savc File 

Nole Savinp a rilr dncs nnlmean ih:tilhc prnjcc¡ is also savcd. 

•- \¡¡\'fllg a l'rojl'ct 
l'ik menu. Save Projecl 

• Savin!! a Projcct and Naming lt 
hh.· lllL'IlU, Savc Projccl As 

• 
• 



• 
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Note A Walk Through showing you how tn s;1vc a tc).t vnsion of the code is 
located at the end of this _p011ion of thc module. 

Editing Visual Basic Code: The Edil Menu 
• Searching Codc for a Tcxt String 

Edit menu, Fino 

• Searching and Replacing a Text String 
Edit menu, Replace 

• Cutting and Pasting Text 
Edit menu, Cut, Copy, and Paste 

• Undoing Changes 
Edit menu, Undo 

Testing Applications During Development: The Run.Menu 
• Starting the Application 

Run menu, Start 

31 

' 

Notic~ the change in the title bar,whcn you sclect this uptiun to indica te that ynu

are now in Run mode. 

• Stopping the Application 
. ..Run menu, End 

Visual Basic Window Management: The Window Menu 
• Displaying the Properties Window 

Window menu, Propcrties 

• Displaying the Toolbox 
Window menu, Toolbox 

• Displaying the Projcct Window 
Window menu, Projcct WinJuw 

• Displaying the Color Palette 
Window menu, Color Palette 

Getting More lnformation: The Help Menu 
• Using the Hclp Tablc or Contcnts 

Hclp mcnu, Contcnts 

• ·searching for a Specilic Topic 
Help menu, Search 

• Locating Product Support Infonnation 
Help mcnu, Product Suppurt 
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Walk Through-Saving a Text Version of Code 
l'rocl'dural programmcrs are uscJ lo sccing all of thcir codc in onc place. 
Rcrncrnhcr, howcvcr, that thc codc is not executed in the order it appears in the text 
file you crcate hcrc. It is still cvent-driven code, and the tlow of execution still 
Llcpcnds on uscr and system events. 

L Tn save a text vcrsion or codc 

l. Rcstmc Visual Basic . 

., ho111 the File mcnu, choose Open Project. 

.\. < lpen WORLD.MAK, locatcd in IWALKTHRU\SAMPLES . 

..J. ( 'lloo"l' OK. 

l.oad the samplc projectthal you ha ve just completed, but do not run it. 

S. ho111 thc Projcct winLlow, sclccl WORLD.FRM. 

Ma~c su re thal ynu select thc corrcct file. When you load a project, the first file 
inthc list is sclccted by dcfault. 

· 6. Flu111the File mcnu. choose Save Text. 

Visual 13asic will give your text file the same name as the form, in this case 
W( IRI.D.TXT. That will probably do in mosl cases. Makc surc thal you savc 
th,· lile lo thc 1 \V ALKTHRU\SAMPLES subdirectory. 

7. ( 'lloo;.;c OK. 

X. Mini1nit.c Visual Basic. 

1J. l<l'turn to Program Manager. 

10. In tlic Acccssorics group window, open Notcpad. 

r r. _hollllhc File lllCilU, Choosc Open. 

Use thc Opcn dialog box to locate WORLD.TXT. 

1 ~- Chnosc OK. 

This loads WORLD.TXT inlo Notepad so that you can review the code. 

lf you want tu print code dircctly toa printcr, choosc the Print command from 
thc Visual Uasic File mcnu. 

You can printjust the form or code or both for the current file, or you can print 
alllúrms or coJe or both lor your entire application. Remember, however, that 
.B/\S files do no\ ha ve a fonn associatcd with thcm, so in this case you will only 
hl.' ahlc lo print codc. 

L Tosa \'t.' a tcxt \'crsion of propcrtics ami codc 

Yo11cc_m also savc thc form with the propcrtics and codc in a text file. 

l. "'"'" Visuai!Jasic. openthc project WORLD.MAK in 
1 11' i\I.KTII R< >UGHISAMPLES. 

l''"'"llw l'rojt·,·¡ windmv. st·l,·ct WORJ.J).FRM 

l. ¡:HHII rlw Fill' nrt·rnr St'h-1·1 S;rvc hlc 1\s. 

4. Scll'l"l thc check box Savc As Tcxt amJ choose OK. 

S. Tlll' lúnn is savcd in tcxt formal. Thc cxtcnsion .FRM is uscd. 

c-.. l.lsl' Notep:.~Llto compare the two text files. 
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Walk Through-Using Visual Basic Help 
I. To use Hclp 

l. From the Visual Ba5ic Hclp mcnu, choosc Contcn~:-.. 

The Visu<il Basic Help window appcars. This windmv pro vides a bri~.:f topicai 
tour of the majar campanents af Visual llasic. 

A to~icallist that might be of intcrcst lo you i;"' Prol!rarnmin!! l.anguagl'. 

2. Choose the Programming Languagc topic. 

Information on that tapie appears in a window. 

3. Chaase the Beep Statcment. 

Language reference material on thc purpt1sc. use. ;tncl ... yntax ,.r this statemcrrt 

appear on screen. 

I. Ta use the Search cammand 

Like standard Windows Hclp, thc Visual Bask l-lclp sy:-.h:m ha:-. a Scarch comn1;md 

on the Help screen. To use Search. simply typc in the ll'nn yolr are looking for. 

l. From the Visual Basic Help window. choosc Scan.:h 

2. Type Toolbox in the text box. 

The text bax is locatcd al thc top of thc scrcen. 

3. In the Search dialog box, selecl Show Topics. 

4. Select the tapie Taalbax. 

5. Chaose GaTa. 

Visual Basic opcns a wimlow with inforrn:lliunonthl' ll'nn "Toolhox." 

6. From the Help screen, choose Back. 

Visual Basic retums you to carl ier topics. 

L To tisc lhc llislory commantl 

Use the History command to rcturn tn topics that you h;I\'L' L·m·t·rcJ carlier in lhl' 

scssion. Topicallists in this option are arrangcd in I'C\'L'r~l' dmmological on .. kr. 

l. From the Visual Basic Hclp winUow, choosc History. 

The Windaws Hclp History dialog box appcars. 

2. Dauble-click the tapie af yaur choice. 

The Help scrcen far that topic appcars. 
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L Tu cut and pasle sample code into your code 

··~ . 

Thc ""'"' powcrful pill1 of the Visual Basic Help system is the large number of code 
Silllrplcs tlwt you can paste into a project and run. 

Thc following procedures a/low you to copy and paste sample code for a Click 
L'VL'II[. 

l. Vist!al Basic should a/ready be running. 

Make surc lhcrc is u new form on thc screen. 

") Fromthe Hclp menu, choose Search . 

.1. Typc C/ick in the text box. 

4. C'lick the Show Topics button. 

Click Event shou/d be hig/1/ighted . 

. <i. Choosc Go Tn. 

1>. 1\1 tht• top of rhe He/p form. c/ick the word "Example." 

T/n .... hrings up sample codc in a window. 

7. ho111thc Evcnr_Ciick cxamplc window, clwose Copy. 

This hrings up <lllolher window with all thc samplc cm.Je in it. 

X. 1 li!!hliJ;!III !he t:oUc you want. 

In this case. takc only the lines starting Picturel.Move ... 

1J. ('lid;. !he Copy hullon. 

This copies thc sc/cction to the Clipboard and hides the copy form. 

/11. Ex ir Visualllasic He/p. 

1 J. 1 l> >uhll'-click thc picture box too/ at the top of the Toolbox. 

12. Drag thc picture box to the lower-left comer of the screen. 

13. Douhlc·click thc picturc box on thc fonn. 

TIIL' CoUc winJow wi/1 opcn. 

J...J. Fntrnlhc Edilmcnu, choosc Paste. 

Jl;t"ll' rhc ~an1ple cnJc fmm the CJipboarJ tu your form. 

1 :'1. ho111 rhc f{un mcnu, cJmosc St:.H1. 

J (t. Click !he piel u re box once. 

11 will movc low;m.J thc uppcr-right corncr of the screen. 

J 7. Corllinuc clicking thc picturc. 

11 will disappear in lo !he uppcr-ri,ghl comer. 

J X. J :n tllllhc J{un mcnu, choosc EmL 

J 
11 Mininti~c Visual B~tsit:. 

t.--~----------



---------------------~---M=od::":::'• 1: Using Visual Basic 35 

Summary 

• Visual Basic Tools 

• Building a Simple Visual Basic Application 

• Visual Basic Menu Commands 

Objectives 
lnthis module, you learned to: 

• Designan application uscr interface usin!! thc Fonn windm\·. Toolhn.\. tonlhiir. 
and Property window. 

• N ame and savc thc application's forms and projL'l'l fik'-. 

• Start and stop an application from thc Visual Ba.-.il· nH'IHI and/nr thl' lotllhar. 

• Crcatc an cxccutahlc file ami add itto a \Vindm''·' 1-'H•IIIl. ·::, 

•· 

· .. ~ 
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I, Overview 

' 

' 
' 
• 
' 

i:ó-'--·----

• Event-Driven vs. Procedural Programming 

• Microsoft Visual Basic Terminology 

• Application Development Process 

• User Interface Design Guidelines 

• Configuring Your Environment 

····-·----

Overview 
The purpose of this module is to introduce yo u to SC\'l.'r;d rclaiL'd concepts that hclp 
you make the transition from thc procedural wurld to th•· cvcnt-drivcn wnriJ. Thi~ 
module creates the Jogical framework for much ofthl:' n·~t of thL· coursc. lt contra:--l' 

pi-ogramming for Microsoft Windows with t'\'lS-DOS ilnd ~tllll'r character-ha~cd 
applications. 

lt al so provides a high-lcvcl overvicw of ami cstabli:-hL·:-. rl'l;~ti~.~nships bctwecn 
objects and events. 

This module "lso outlincs thc pcncral prorcss that i~ IJ:-.~.·d tnlk'\'l·lop Vi.•q¡;\1 H;J.-.i<.· 

t1pplications amJ somc general suggcstions for ovcr;dl applil'ation th:sign. 

Prerequisites 
None. 

Overall Objective 
At the end of this module, you will understand thc p<.tradigm ~hift from prnccJlllalt•' 
event-driven programming. 

Learning Objectives 
At the end of the module, yo u will be ablc 1u: 

• Explain the key differences betwecn graphical and lharartcr-hascJ applic:nion:' .. 

• Providc high-level definitions for sume kcy Visual Ba:-.iL· tcnns. 

• Outlinc a hasic appli..:alion dl~sign aiHI dn·l'lopnt\'111 1,,,11'\'lhnt'. 

• . Explain severa\ fundanlclllal pri1H.:ipk·:-. ul n:-.n inl,·t Lt• ,. 'k'-tJ!tt. 
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Event-Driven vs. Procedural Applications 

Example 

References 

Procedural VS Event-Driven 
~ 

Programmer-Driven ~ User-Driven 
~ 

Character-Based ~,. Graphically Based 

Single Tasking Multitasking 

Programmer Control , Windows Control 
of Environment ~ of Environment 

·~·~nrN<n"Cl'Wt'''lt:NV~#tanct H®r\L.,...... e· rterr f''t'" 

1 

Troalitional progr;unming is linear. 1t has a top-down sequcncing that is controllcd 
hy tht• progranuncr. 

\Vindows-hascd progr:.1mming is evcnt-driven. Windows-based cvents can be 
. trig~_creu in onc of two woys. They con be either user-triggered or system-triggered. 

Jklow. in pscuJocode, is a very general summary ofthe structure of an event-driven 
pmgr;un for thc \Vindows operating system: 

1 

'• 

'1 

1" 

11 

1 ~ 

1 j 

H 

¡r, 

]"l 

11• ... 

ll•·uin MAitJ PROGRAM 

1\r!U i 11 l,ooup 

' Ask Windows to pass m~ssages to your program 

•dH!Ul whill events have occurred 

case Statement GETEVENT 

l·:tHJ !.1" 'JI 

CASE Click 
You can choose to insert code to respond to 

· click events for the appropriate objects. 
CASE Change 

CASE 

Yuu c.:an choose to insert code to respond Lo 
' change events for the appropriate objects. 

CASE Default: 
VB will handle other events internally 
without giving your. program access. 
One of the default cases is .the •end 
application" message that causes an exit 
1 t1ot11 I.IP! ]IH!J! ;utd CiJUS(!S y0ur illJlJllc.:t~tiull 

¡.,,.! ::AJN f'I<I)(;RAM 

¡.-,,. ;1 Clllllplctc listof lhe events that Yisuol Basic recognizes, see the lntroduction 
in lltl' MicTn.H~/; Visual Basic Languafie Reference. 

' 

1 
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Notice that there is nota linc<u flow to the pmg_ram h~..·~..·an:-.l:' thL' fltl\'-' tlt!pL'nd:-. 1111 

what events are generated and thc ordcr in which thl': ill\' r~..·p•u"ll'd to your pro~ran1 
by the Windows operating systcm. 

Applications that run in the M S-DOS environmcnt art: programmcd to be thc onl: 
application running. MS-DOS-based applicatinns d<> 11<11 llamlle multitosking \'Crl 

well. · 

Window applications are multitasking. Thcy can shar~..· ~nl'l'll sp;~cc and l'omputin~· 
time. · · 

MS·DOS-based applications are dmractcr-h:Jscd. \Vi1Hit1ws-h;asL'd <~ppli~..·atittll .... ;111 

graphically based and typically use proponionally span·d fonts. 

Applications progmmmcllto run inthc MS-DOS cnvirontuclll are ablc to colllttd 

the environment the user operates within. Thc programc;uJ ha ve controlovcr thl' 
sequencing and appearance of whcre the uscr will g<> ncxt in thc applicati<>n. 

Applications programmed to run undcr Windows givc ~..·~ 1/llnJI (Ir thc cnvinmml'nt 11 ~ 
Windows. How the user movcs between evcnts is contndlcJ through thc WinJow.., 
operating system itself rather than through the Wind11w.,-hascd application. 
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Visual Basic Terminology 

Application 

Form1 

Thl' ll'nn" on this foil Ucpicttwo m&~jor components of thc Visuall3asic 
devclop111cnt cnvironment: the graphical side of it and the code side. Put in tabular 
forn1, thcy Jook likc this: 

Applicalitlll 
h ll"lllS 

IJn1pcnics 
F.vents 

( :t 11\lrols 

l'mpcrtics . 
1: \'l'l\IS 

What ls an Object? 
Considcr this cxamplc: Thc dashboard of your car offcrs users a variety of gauges, 
di:ds. ami acccssories that takc input ami give output. The thermostat tells you how 
hotthc engine is. The steering wheellets you change direction. Each one of these 
"objc":ts" performs a specific purpose, and you use it to attain a given goal or 
ohjcctivc. Uscrs learn how to use thcse objects. 

For thc nu1st part, users do not Je;un how to install, maintain, or troubleshootthese 
thin)..!s. They do nut lcarn how thl'sc things function. Thc uscr only ncccJs lo know 
th;tt tht'St' ohjL"cls wtu·k and what to cxpcc..:t fromthcm. In a likc manncr, Visual 

·llaSicollcrs programmers objects- forms and controls-that they can use to build 
applications. For the most part, thc programmer need only use the object without 
lll'et'S.''<trily having a dctailcd undcrstanding of how thc nbject docs what it docs. 
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The Graphical Side . 
Objects 
Components of an application, usually forms amJ ~on1n1ls. 

Forms 
Forms are thc building blocks of applications. Thcy ;tn· !lit• windows th:ll usl'rs SL't' 

. whcn thcy run yourapplicollion; thcy are tln.: major s1n1clur;d units lhal 111;1kl..' 11p 

your application. Visual Basic is m;,ttlc up of scver;ll f,,m L'. · l'hl' Tt 10lbt 1>.. rl.ll' 
Propcrtics window, thc Projccl window, <md lhc Sil\\' I'H,jcl'l t\s dia!tlg htl.\ <lit' :di 
examples of forms. 

Walk Through-Forms and What You Gel Free 
L To opcn a blank form 

l. Sl:lrl Visualllasic. 

A blank form slwuld be on thc scrccn. 

2. From the Run mcnu, choosc Stan. 
e 

Notice aJI of the things that Viswll Basic givcs )'t.lllr fttl'lll. StiLh as; 

• Sizing border 

• Control menu 

• Minimize button 

• Maximize button 

You don't need to write any ofthe code for paintin,g ;m y uf thcse featurcs of y~HII 
application. You also don't need to write <lllY of the cudc for managing thcsl' 
features. 

3. From the Run menu, choosc End. 

Controls 
Controls are the tools you place on forms tl1;11 providL' n:-.L·rs with applicati~IJJ 
functiomliity. Examples of controls are the con11nand hHIHnJ .... cu1d /;~hds. 

Properties 
Fonn." ;uul controls ha ve pro¡~cflies (tlllrihllll'S) ihal )"11 (·;¡JJL·J¡:niJ.!l' dtlrÍn.!-' 1k:-.i~11 
and run time. An e~amplc uf a pro¡x~ny is tlle captio11 111:11 ••JlPL';¡rs on ~~ l.'ollllllitrlll 

button. Genera JI y speaking, you set thc values l"or conlrol :1m/ fonn propcrtiL.s \\"hL'II 

you are designing your npplication. 

Event Procedures 
E,vent procedures are coc.le interna! to Visu;tl Ha sic and Windn\\'S t!Jat is written to1 
you and provides your application with so me of its hasiL· (unction:tlity. Fur cx<nnpk 
when a userclicks a check box, thc Click c\'Cill 1\¡um; . .., I111W 111 p<lint an X intlw 
squarc. However, you must place codc insidc thc Clil"k L'vent Ji1r tlwt check !111\ 111 

cause your application to rcact appropriatcly whcn a u~cr plan•s an X in ur rl'llhl\'l'·. 

an X from thc check hox. 

6, .. -..---------~---
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The Code Side 
Project 
Your ucvelopmcnl projecl is made up of more !han graphical forms and conlrols; it 
al~o has Basic codc in it. This is managed and accessed through the Project 
willlltiW. 

Walk Th.rough-Visual Basic View of Your Project 
,~ 

L. Tu "it·w your projccl 

J. 1 f i1 i_..;n' t ;lln:ady startcd, S tan Visual Basic. 

' hHnJ !he ¡-;¡¡e menu, choose Open Project. 

.1. l.oad !he ICONWRKS.MAK file. 

This lile is l•>e·:•lcu in IVB\SAMI'LES\ICONWRKS . 

..J. horHthc Runn1cnu, choo~c st;ut to n!n thc application. 

Work wilh !he application for a minute, but the point here is that this application 
is malle up of a number of different forms. 

'l. Fn11n !he Run menu, choose End to stop the application. 

(l. J\cn·ss thc Projcct window . 

. . Thc Project window keeps trae k of the forms and modules that make up your 
ilflJllication. 

For our purpo:-;cs, Visual Basic treats each of your forms as a separate 
Clllllpi ment. 

Visual llasic kecps track of thc numbcr and kinds of files that yo u are using in 
your applic;ltion in thc .MAK lile and loads them when you want to start 
worl\ing on your project. 

7. C)uil Visual Basic. 
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Module 
In Visual Basic a module is a file that contaills only codl'. One examplc of a .!lAS 
file that you could see m the top of a Projcct wi11dow i., M<1Dlii.E l. BAS. 

Another way of showing thc relationship anu 111g ronn~. l., 1111n' b. propcrt ic . ..;.. and 
event procedures is this: 

MODULE1.BAS 
Data and Code 

FORM1.FRM 
Graphical Elements 
Data and Code 

FORM2.FRM 
Graphical Elements 
Data and Code 

1 

Project 

~-~·~"--'~"-''"• 

.MAK 

The .MAK file contains names of bolh lh,e .FRM and lhe .BAS lttr,s "' thr. projecl. 
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Application Development 

1:1 Calculator [S2 

·. Creating an Application 
I. To tTcall' an applicalion in Visual llasic, follow this suggcslcd scqucncc 

l. < Jpm a new project (or use thc ncw project created whcn you stut1 Visual Basic) 
In mganizc thc p;u1s uf your application. 

1 
( 'rL'<IIL' a form for cach winUow in your <lpplication . 

. \. 1 )¡¡¡\y tllc controls for cach l'onn. 

·l. e '¡c:ltt· thc IIICilll har for the main furm . 

.'l. SL't lhL' fonn and control propc11ies. 

(l. \Vritl' evenl procedures and general procedures. 

7. Saw yuur wurk. 

X. lkhug your coJc. 

lJ. Crcate an cxccutablc file to turn thc projcct into an applic<~tion. 

Distributing the Application 
When you distrihutc the cxccutablc of your application to users, you necd to 
Jistrilllllc a copy of the Visual Basic dynamic-link library VBRUN300.DLL wilh it. 
This dynamic-link library (DLL) is a part of the Visual Basic installation files, and 
you can distribute it royalty free. lf you build your application using any of the 
availahlc custom controls, you will also need to ship all appropriate .VBX files, and 
in -'""'e cases .DLL files. The product documentation for the custom controls will 
lcll Y'"' whal tlll'SL' fiks are. 

hn;dly. during Lksign lime, you may tlcciUc to movc the forms for thc upplication to 
illlttlhn 11\at.:hinl'. lnthis case, you will prob;1hly ncctl to rchuilú thc .MAK lile, 

hcc;utsl' it kecps !rack of allthc files that make up your application as wcll as thc 
lúllv qualificd palh 10 them. Todo this, copy all the files to the ncw machine, thcn 
updatc thc paths in the .MAK file by using the Remove File command from the File 
llll'llll. and th.:n tht· AUd File comm:md. 

'· 

.. 
• 
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User Interface Design 

General Guidelines 

• Design Basics 

.- Color 

• Fonts 

----

U ser interface design guidclincs are an agrccmenl lo crc:11e con:-.istcnt u ser 
interfaces. 

User interface guidelines are important for case of h.:amin~ hy tlic uscr. Thcy al.'~ 1 

prevcnt programmers and dcvelopers from "rcinvcllling thc whl·L·l." 

They are guidelines-suggcstions on thc way you migln wa111 1t1 Jcsign thc Ll.'>l'r 

interface. There are no hard and fast rules. 

General Guidelines 
• Design basics 

• Design for the user, not thc system 

Composition and functi01wlity 

• U ser control 

• Dircctncss 

• Consistcncy 

• Clarity 

• Aesthetics 

• Feedback 

• Forgiveness 

• Color 

• Color asan attention-gcttcr 

• Complcmcntary versus cin.:us colors . 

• J ;tiJIIS 

• Scrif vcrsw; sans-serif 

• Size 

• Numbcr (varicty) 

47 
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· .. · 

For More lnformation 
For rnorc dct<Jils on uscr interface design guidelines, sce: 

• 'lhl' H'indows fllfc'lfiu·c•: 1\11 11pplication De.\'iRII Cuide 

• Visllfll Desi~-:n Cuide contained .within Visual Basic 

Walk Through-Designing the User Interface 
As Y"" walk through this application, look al the property listed and answer the 
qucstion that follows. 

I l'riul 1/lilily #1 

l. ¡:""" thc Walk Throughs program group, start Print Utility #l. 
• 1 

First imprcssinns :.rrc irnpo11ant. Are thc function and purpose of the application 
;tpptlll'llt fn1111 a first look al thc interface? 

0 Tille Bar 

·nrl' t_itk bar s/11ruld conlain thc namc of thc application. Does it? 

.1. tvknus 

'l'lrL' rrrcnu slructure should rcveal somcthing about the contents of thc 
application. Dncs it? 

. Dt>cs the tirstmenu item follow user interface guidelines? 

1..., tht· llclp conunanLI inthc standard pi:.Jcc? 

¡,lile <)uit C<llnmand handlcd suitably? 

\\'lh'lt' docs thl' 1\hout cornrn:111d norm:dly :1ppcar'! 

·~ 
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4. Scroll bar 

ls this the most cffcctivc w;ay In ask uscrs for thl: nnnthL·r uf l·opics lhl'y will tll' 

wanting? 

Are the size and location of the scroll bar appropri;ttl' givcn the overall put"¡)tl:o.t· 

of the application? 

5. Options 

How many sets of options are therc rc<~lly 'm ihis f,lflll .. ' 

Are the check boxcs prcscnted in red, th~ hcst w;ty 111 ;.!l't inf;1nn;Jtinn rrnnttht· 
u ser? 

How should the hender, footcr, and page numbcring qucstiuns he impklllL'ntctL' 

6. FileName text box 

If the user wants to find a ti le and print it. what ulhvr toob docs thc uscr tlL't'd 

besides this simple text box? 

7. Stop and Print bwtnns 

Are these buttons appropriately sized for this form ;mil it:.; function'? 

8. Exit 

Close the application. 
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L l'rinl l!tility #2 

l. homthc Walk Throughs program group, start Prim Utility #2. 

2. ( lpcn the second version of this application. 

·ls lhe overalllayout ofthe form effective? How does the layout suggest how the 
u~.L"r might work with the form? 

llow do thc l"nnncs hclp structurc thc user's c.Jecisions? 

¡¡~,,v ís thc 111cnu structurc consistcnt with user interface guidclines? 

Whr wero lhc hcader and footcr options ·dropped from the form? 

Why was lhc Pcrcenl Done label added? 

.\. ()uil lhl' applie;ition. 
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User Interface Design Guidelines 

Device Input 
Getting Input from a Mouse 
There are a Jimited number of things that uscrs can d1 1 witll ;1 1111 ,use: 

l. Singlc-click with cithcr thc primary 11r SL'l'IHHI;;.ry ~ lt·ft 11r ri,!-!111. 111p 11r htl\1111111 

bullan. 

2. Double-click with cithcr thc p¡-imary or sccondary h1J1t•m. 

3. Drag normally with thc primary buuon. 

4. Drag and drop. 

For example, a single click with thc primary mousc hutl\111 nonnally indkatcs tll~11 ;¡ 

choice such as a bold, italic, or underlinc tc.\l formal nption ha~ hccn madc on thL' 

ribbon of a text editor. Sclection of a file to he opcnL·d i .... nonnally indicaiL'd hy ;1 
single click. 

Double-cli.cking selects the objcct to be octcJ u pon a11d initi;1tc~ thc action. Th<.1t L'-. 

ifyou want to select and opcn a ti le, you simply doublc-l'iick a filcname. Thc S<lllll' 

thing happens when you double-click an icon. 

Dragging is used to resize a window, move thc winLlnw tn <~ 111.:\\' location. or 
reposition an icon. Drag and drop is normally u sed t11 >ckct an t~bject. ror examplc. · 
the na me ora file, and thcn place it ovcr anothcr oh.il~l'l. i"t1r L'.\;Hnplc. a printcr. ~~~ 

that the file can be printcd. 

:. 
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Keyboard and M o use Functions 
Wllcnl'\"l'l" possihlc. att,nousc actions shoutd be duplicated with an equivalent 
h·yhtl;nd <~Ction. Kcyboard shortcuts and access characters should also be used to 
n:dun· 1hc numhcr of keystrokes and potenrial for errors by the uscr. 

For cxample, in most.cases you will want to give.a keyboard shoncut for the most 
com11 11mly useu comman'ds. If possible, use the first letter of a menu or control as 
thc.an:ess character. lf there is a contlict, use another letter in the menu or control 
n;Hlll'. 

\Vhl'n yon Jcsign lhc ~1pplication ;md its J'orms, specify the shortcut keys. 

' 

" • 
' 
' .. 
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Configuring Your Environment 

· .. · 

No 
Bin~1y 

No 

OK,,,,,q 

Cancei"; 1 

Aesel 

You can configure much of thc look and fecl or thc liL'\"L'hlplllL'Ill cnvironment. 1:n,111 

the Options menu, choose Environment Options. Fnuntlii~ window you can se\ 
everything from the default tab stop in codc lo !he forl't'flllllld ;mJ background 
colors of comments in code, 

S<!ling 

Tab Stop Width 

Require Variable Declamtion 

Syntax Checking 

Dcfault Save As Formal 

Save Project Before Run 

Sclcclion Tcxt 

Sclcction DackgnlUIHI 

Ncxt Stalcmcnt Tcxt 

Next Statement BackgrounJ 

Orcakpoinl Tcxl 

Breakpoint BnckgrounJ 

Comment Text 

Comment Background 

KcywonJ Tcxt 

Keyword Background 

ldentitier Text 

l>cfaull 

.¡ 

No 
No 

llinary 

No 
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St•tline Ucfaull 
--------~------------------------------
ldcntiril'l llad~ltJIIIIII 

Codc Wimluw Tcxt 

( "odl' Window Badground 

lkhug WinJow Tcxt 

Dchug Wimlow Uadgrouml 

Clrid w¡¡Jth 

< irid lki~ht 

Show t irid 

i\li!!nln (irid 

120Twips 

120 Hcight 

Y es 

Y es 

l'or a list of thc colors available, sce the Colors section of CONSTANT.TXT 
locatcd in thc \VB subdircctory. 

Note Changing toa larger grid size and then aligning the controls to the grid may 
L'lwngl' thc sizc or your controls. 

1 

Automatically Loading Visual Basic Extensions at Startup 
You can control which ofthe .VBX or Visual Basic Extensions are loaded when 
starting up a new project by editing AUTOLOAD.MAK with a text editor. This file 
is locatcil in the IVB subdirectory. The default settings are: 

GRIIJ.VBX 
MS< JI.E2. VBX 
ANII!UTON.VIJX 
CMDIALOG.VUX 
CRYSTALVIJX 
r;Ati<;E.VBX 
GRAI'II. VIJX 
KI'YSTAT.VIlX 
MSC< JMM. VUX 
MSMASKED.VIlX 
MSI ti ITI .IN. VBX 
1'11 ·¡ '1 .II'.VIIX 
SI'IN.VBX 
TI II<I'I'IJ.VBX 
ProjWinSizc= 152,402,248,215 
l,n ,_jWitlSIHJW=lJ 

1 

1 

1 ., 
• 
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• 
• Summary· 
• 
• 
• • Event·Driven vs. Procedural Programming 

• 
• Microsoft Visual Basic Terminology 

• • Application Development Process 

• User Interface Design Guidelines 

• Configuring Your Environment 

Objectives 
In this module you lcarncd to: 

• Explain thc kcy úiffcrcnccs hctwccn grapliical ;uJd dJ;Irat'hT-h;¡scd appli•:;niuw .. 

• Provide high-lcvel delinilions for somc ~e y Visu;d ILt.-..ic tcrrJL'\. 

• Outline a basic applications t.lesign aml dcvctupmcnt pt'tl(L'lhtn:. 

• Explain Severa! fundamental principies or uscr inlt'l"fiH't' lk~i~n. 

· .. · 
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• 
Lab Time 

·( io lo 1111 . .' bnplnyL·~ l>atabiiSC Application Spcdficalion porlion ur your lolb manual. 
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I, Overview 

·., -

• Forms and Their Properties 

• Message Boxes 

• Starting the Forms of the Employee Data base 

• Multiple Documentlnterface Applications 

Overview 
Thc purposc of this moUulc is to introUucc you to thc Visual Hasic programJncr's 
fundamental tool-the form. · 

E ven thnughthis is a rclativcly hril'l"modJlk, it introdlll., . .., '>OIIIt" ~ey lnJII:--. thal ;,, .. 
rctju ircd for a full u nUt:rstaml i ng of 1 ht: prot!-r: 1111111i ng l' 11 vi Hlllllll' nt. Th is 111od u k 
primarily focuscs on thc various propc11ics associalL'd wirll fonns. scpar<IIL' frillll tlll' 
Uiscussion of controls ami propcn ics. This ¡nwlulc ;dstt H ··ul"lll':--. '•n L'\'l'lll pmú·dw\ ._.., 
;md mcthoús i1Ssociatcl1 with J"onns. A lllOJl' dct:lilcd disn1ssio11 111" thcsl' isst.ll'S will 
be found in a scparatc module. 

This module also serves as the introduction tn thc mainck·mcnts of thc class 
application and walks you through crcating. naming. ;111d s;1ving thcsc forms. 

Prerequisites 
Prior to starting this module, you shoultl havl' a fund;nllt'Ht;d awarcncss of: 

• Windowing lcchnology from the uscr pcrspcctivc 

• The Visual Basic programming cnvironment 

Overall Objective 
At the end of this module, yo u willunderstamlthe J"und<JIIIL'lllals ,¡f W<lrking '''ith 

forms in Visual Basic. 

. ·\ 



11 

' ., 
1'· 

¡, 
' 

1' 

1• 

1· 

' 

l, 
·1 

!, 

1 ~ 

1 L_ 

\ 
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I. To code the message box sam1Jic application 

l. lf Visual Basic is not running, stan it. 

2. Double-click the command button tool in thc Toolbox. 

3. _Place it in the lower-right corner of the form. or any 11tlhT 11111-1 11"-llic-way plan·. 

· 4. In the Properties window Propc1ties list for the command htll\1111. L·hangc thc 
following property: 

Caption: Exit 

5. Click anywhere on the form. 

This puts the focus back. on thc fnnn. 

6. Double-click the command button. 

This wili automatically opc·n thc Co(Jc wimlow for thc f,•l'tll <llllÍ t;t~c youto thl' 
Command I_Ciick event templatc. 

7. Add the following codc: 

Msg$ = "Have you saved all your work?" 
MsgBox Msg$, 3 + 32, KHsgBox Walk Thru" 

What does the code do? First you e reate a string variahk with thc mcssagc you 
want lo display, and then you call thc Msgllox Slatcmcnl. You can pass thc 
MsgBox statement three arguments. Although the second and third argumeniS 

. are optional, in this case we have you include thcm. 

The first argument is the message string that is displaycd insidc 1hc messagc 
box. 

The second is a sum of valucs that indicatcs 1t1 Visual lbs1c thc typc of mt.:~sii~L' 
box you want. More about these numbers in a minute. 

The third argument is the title of the message box. 

8. From the Run menu, choose St,u1. 

9. Testthe dialog box. 

Use the mouse pointcr to choosc thc Exit comnlaHJ bu11tiiL Th~..· diah1g bux \\'ill 
appear in the middle of your display. 

10. To clase the Mcss<Jgc WalkThru dialog hox. chnosc tl11· l ";Lilt'l'l h111lon. 

1 l. From the Run menu, choosc Eml. 

12. In the Code window, highlight MsgBox. 

Use the mouse pointer lo highligluthis word in th~ cudc. 

·.; 
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)! 
"' 

) 

) 



j 

Module 3: Working wilh Forms --- -ss 
-----~------------------------=----'-----

.. -. 

1.1. l'rcss Fl.· 

Makc surc you are in lhe design mode, nollhe run mode. 

By adding the appropriale key values lisled in the second table in the Visual 
.llelp lopic for the Msgllox slalemenl, you can control the numbcr and typc of 
huttons, control thc icon tlisplaycú in thc mcss<.~gc box, und cvcn sct a tlcfault 
h111ton. 

·In this w<~lk through, you athJ thc valuc 3 (lo rcqucst a mcss~agc box with Y es, 
No, and Cancel bullons) amlthc numhcr 32 (to rcqucst ¡amcssagc box with :1 
Warning ()ucry or qu~,;stion mark icon). 

Therc are more sophisticatcd w<.~ys uf implementing anú using mcssage boxes, 
hutthis givcs you a starL 

IJid Y!lll nolicc thallhe Y es, No, and Cancel command bunons do much, yet? 

lf you rcad further down in lhe Help window, yo u see lhal each of lhc differenl 
hultons rcwrns n differcnt value. You will use thosc values a littlc lmer in the 
coursc, a long with somc conditional logic to code the three buttons on the dialog 
hox. For thc time bcing ... 

14. Minimize Hclp. 

1 o. Fromlhc File menu, choose Save File As. 

Save this form in \WALKTI-IRU\STUDENTI as MSGBOX.FRM. 

1 (\. J:mm thc File mcnu, choosc S ave Pruject As. 

Save lhc projecl in thc same subdirectory as MSGBOX.MAK. 

17. Sl'icct thc Visual l3asic Control mcnu, and choosc Closc. 

(_}uil Visual Basic and Hclp. 

1 
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----··-----

Modal and Modeless Dialog Boxes 

Open Pro)ed 

File N. ame: J2ireclotiet; ,,,. 
.·m::: •. , 1 

Jii!iim3 c:\vb 

P'oiect1 .IMik ., (2:) e:\ • le' --toncel · 1 
~·· CJ bitmep1 

CJedk 
CJ he 

~ 
CJ icon• 
CJ melidile • 

lill File• of Jype: D1iyes: 

!Ptoiecl F"tles[•.MAK) Jl) Jli3 e; 1•1 

Modal, Modeless, and System Modal 
You can designate a formas being eithcr modclcss or rnod;d. Thl' dl'fault is 
modcless, which means that thc uscr can opcn thc f,mn atlt 1 .-..1 i 11 t!l'l 1,' '1th~.;r r, m n~ 
within the application todo work. Modal forms. in contras!. rl'quirl' that the uscr do 
something-click a butt~n. check to make su re lhcy rcally d" wanl ¡, deletc all 
those files-before they can do any work. 

Walk Through-Modal Dialog Boxes 
L To use a modal dialog box 

·.-,· 

1, From the File menu, choose Open Projcct. 

Bring up the Open Projec1 dialog box. 

2. Access the Project window. 

Place lhc cursor on any othcr portion or thc Vist1al Ba:-.i,· inh._·rLil·c. Jlrcss L'illh..'l 

onc of thc mousc buttons. 

A becp sounds and thc cursor continucs to flash in Lht: IL' "' [)t 1>... l11 tl1is ctJsc tiJL' 
user must choose one of thc thrcc choiccs prcscntcU: Loca te thc na me of ~~ 
projcct using the list boxes, input a val id projcctnamc. and chtu1sc OK or 
CanceL 

3. Click the Cancel button. 

Clase the dialog box. 
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Application Modals and System Modals 
Modal dialog boxes do ·ha ve a limit; they only guide the user within their own . 
<~J!JIIit:ali<lll. Tllcy ha ve no cffccl if thc uscr switches 10 Windows or 10 another 
;~pplication. In order lo make a form systern modal, all you need todo is to use the 
.ll_rle'ln par;unctcr for bolh MsgBox staternents and functions. 

Thc syntax looks like this: · 

j(onn.l Shuw /Jtyten!flJ 

In <~th.Jition, you would necd to declare three global constants: 

':l··h;,J Cüns1. MODAL = 1 

';¡,,¡,;¡l Cc>rl~;l MQDELESS = 2 

!:],bA.l Const SYSTEMMODAL = 4096 

Walk Through-Making the Forms of the Employee 
Database Application 

I Tu makc thc forms or thc Employce Databasc application 

l. 11' Visual Basic isn't already running •. start it. 

2. Set thc f'ollowing propcrties for the form: 

Caption 

,N ame 

llcight 

k un 

ll'idth 

Employee Database 

frmEmpDB 

5760 (approximately) 

1 VBIICONS\MISC\MISC28.1CO 

7600 (approximatcly) 

Nole Whcn ynu sct thc lcon propcny for a form, you will nccd to know thc full 
p;llh lo thc sourcc file, but thc Yisuulllasic interface will only tcll you that you 
ha vean icon by displaying thc property as (lcon). · 

J. hom thc FiJe menu, choose Save File As. 

Makc stlll' that you savc thc file in thc appropriatc subdirectory. lf you don't, the 
.MAK file will not be able to find this pan of your project. This first puss at the 
applic:Jtion should be saved in \STUDENTIIFORMS. 

·1. N ame tllc rile EMPDB.FRM . 

. ). C:hoose OK. 

This savL's thc form. 

r •. Click the Project window. 

Notice that the filcnamc is in the left column on this list, and the na me of the' 
lúrm is in t11c right column. 

So far. you ha ve ~iven thc fon11 the na mes lhal areknown 10 lhe file syslcttt anJ 
lo Visu;d Hasic. 

'1. homthc Controlmenu for thc Employee Database form •. choose Close. 

Closc EMPDB.FRM. 

X. From the File menu, choosc New Form. 

1\dd a sccond form to the application. 

. t 
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9. 

10. 

Setthe following propenies for the form: 

Caption Employee Record 

N ame frmEmpRec 

Height 4545 (approximately) 

MaxButton False 

Width 54X5 (approximately) 

From the File menu, choose Save File As. 

Now, rename and save the file, making surc that you s;n·L· it in 
\STUDENTIIFORMS. 

1 l. Name the file EMPREC.FRM. 

12. Choose O K. 

13. From the Control menu on your ncwly crcatcd r,,nn. d11 ~~'·'l' Clt1sL'. 

Clase the form, and notice that the name of this form h;~,, lwen adtkJ to thc list 
in the Project window. 

User interface guidelines suggcst tlwt applications ha\·c a11 1\hou1 lmx-a fonn 
that indicates that the application is copyrightcd. You hil\'l' airead y crcatcd an 
About box; now you need to add itto this application. 

Note You will al so want to make so me changcs to thc A hmll form, but thc 
·' · • " directions for doing this are not inclutletl hcr<:_. You would. fnr cxamplc, changc 

the caption for the About box so that it containcd the na me .. r the application, 
but doing that here distracts from the point of this wall; throogh. 

14. Copy ABOUT.FRM from \STUDENTI\A130UT tu \STIII >loNTI\I'ORMS. 

Befare you add the About box form to thc projectlist. l''"' slloold makc a cupy 
ofthe About box formthat you ha ve airead y completcd atHI place that in 
\STUDENTI\FORMS. 

15. Fromthe File menu, choose Add File. 

ABOUT.FRM should appear in thc \FORMS sohdircctmy. so :111 vou nccd lo do 
is select the name so thnt it appcars in thc tcxt hox. 

1 (,, Choosc OK. 

The n;une oi"IIIL' ;u/ded funn .'>IHuild.;qlpl·;u inllw l'1111~·, 1 l¡·.l 

17. From the File mcnu, choosc Savc Projcct As. 

Now that you havc inadc most ofthc basif..: ftll"ltls ftJr tlll' J·.rrrJ1It,Yl't: l)<ll~lh<I~L· 

application, you need to rcnamc and sa,·c thc fik that ht'I'Jl' trad.: of thc filt.:s in 
the project. 

The Save Project As dialog box sllouiJ appcar ccntcr .... t.lt't'rl. witlltllc corrt:L·t 

subdirectory already listcd in thc current working din:cltll")' ;mt.l ;¡ suggcstcd 
filename with the appropriate file extcnsion. 

18. Name the project as EMPLOYEE.MAK . 

. 1 'J. Chnosc OK. 

~This Si.IVCS all or your curren! buiiLi informal ion. 
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211. h·umlhc Run 'mcnu, choo:-;c Sl;,u1. 

lf you W<llll to testthc application, you should see the Employce Databasc form 
appear on screen. This form appears only because that was the tirst form you 
createtl. lf you try to open the Employee Record form, you will see that you ha ve 
11nt implemented code for that task yet. 

21. l'rom thc Run menu, choose End. 
,, 

C)llit Visual Basic. 

.-

' 
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Multiple Document Interface Applications 

Placing Forms Within Forms 
,_,w Visual Basic allows you to write applications that can cr~;tlt' multipk copies 11( ;.1 

form and display all the forms within a single conlttincr fonn. Micrm.oft WonJ for 
Windows and Microsoft Exccl are both applic~tions that allow uscrs todo this. 

Walk Through~Creating MDI Applications 
L To scc !he final vcrsion of your MDI applicaliou 

l. From the Walk Throughs program group, starl M DI. 

For the most part, in this coursc, wc wi/1 focus allclllion 1111 pla~..·in~ comrob on 
forms. However, Visual Basic has tlw capacity to plat:~,.. Jin·rn .... un (ormS and 
multiple instances of forms on forms. 

The purpose ofthis walk through is to givc yotlthc fund;ulll'lllal..., o( 

irnplcmcnting an MDI ;_¡pplic:llion. Wc don'! iudtltk ;di rlw t'llh;tnn·nJcnls !llar 
yournighl wanllo implcmcnl. Delailed CO\'lTii!!L' can h1· llltnlll in 1hc fo/loW-1111 

Programm'ing in Micro.wji Visual /Jo.\·ic 3.0 coursc. 

2. Fromthe File menu, sclcct Ncw. 

Do this three times. You may not see much lwppcnin~ ;H l'irsl. hUI each timl' yotJ 
select New, annlhcr ima:u1cc of the child window is hl·in¡! dr <twrt un .-;crcl'n. onl' 
atop thc othcr. 

3. From lhc Window mcnu, choosc Ti le. 

This organizcs and displays ~1!1 of !he child wi11dows tlt;tl y1 1q lla\'l' ncatcd. 

4. From !he Control menu on the Paren! fnrm, cilOII.<l' r¡.,, .. 
In ordcr lo crcalc lhis :tpplicalion fra111nvmk. lúllow llll' o.,lt-p .... hl'l11w; lur1 llll'll' i~. 

:..<1_ w:.u-ning rcquircd hcrc. You will be lyping in a numhn Hf thin!!s tlwt h:wl'n't 
becn explained ycl. Don'l worry; lhcy will he. l'or !he 1iow he in~. acccpl 1ha1 . 
things work and thatthe dclails will follow. 
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L Tu lTcalc u simple MDI application 

l. Slart Visual Basic. 

1\ ncw. hlank form will appear on scrcen. 

' From thc File menu, choose Add File . 

. t. llsg thc hrowscr to add PARENTI.FRM located in \WALKTHRU\FORMS. 

Note Undcr normal circumstances, you wouldn't go this route. You'd selcct the 
Ncw MDI Fnrm command. lf you did that, a second form wnuld appear no 
Sl'l"l'l'll, lhl' cnlry llallll'd M I)JJ·OI{M I.I·'RM Wtllllll he <llllkd 111 Y'•ur pn1jl.'l'l list. 
;natJ thc Ncw MOl Furm COilllnanú on your File menu wouh.J be Uisablcd. From 
lhcre, you would necd to add all the menu items; but since you haven't done that 
yct, wc will give you the completed form, so that you can concentrate on the 
MDI capahilities. 

Now you should ha ve two forms in your project. 

4. In the project list. put the focus on FORMJ .FRM. 

That is. make sure that you see FORM I.FRM on top of all the other forms 
within Visual Basic. 

~.. .". Flnn.11he File mcnu, choosc Save File. 

S ave thc file as FORM I.FRM. 

c.. From thc Window meou,' select Prope11ies. 

This displays the Propcrties window for FORM I.FRM. 

7. In thc l'ropcnics window Propcrties list, locate the MDJChild property. 

Thc dcfault valuc for this property is Falsc. 

X. IJoublc-click the value in the table. 

This togglcs-thc valuc to Truc. 

'!. Sclect thc Controlmcnu for the Propc11ies window and choose Clase. 

111. In thc i'rojcct window, highlight PARENTI.FRM and choose Yiew Form. 

This placcs the focus on this form. 

1 1. e Jpcnthc ¡:¡le mcnu on thc l';.¡rcnt Fonn anli chonsc thc Ncw cummanú. 

\ 

This is thc shm1cut for gctting fromthc formto thc colic that supp'orts it. You 
should IH1w be in a Codc window that looks likc this. 



~' 

• 
~ ., 
lit 

lit .. .. .. 
' 
' • ,. 
,. 
,. 
• 
• 
• 
• 
• 
• 

' 
1 

72 Module 3: Working with Forms 

12. Place your cursor on the line bctwecn rhe Suh .;uu.l End Suh fine~ amJ adLI this 
code: 

Dim NewDoc As New Forml 
NewDoc.Show 

Thnt's allthcre is lo it. Your qucstions abmll Di m and Nt'\\' and Show will ;di lw 
answered in a little whilc. 

13. From the Object drop-down combo box, choosc Gcncr;¡l. 
' 

This moYcs you lo thc General Dcclarations scel ion of tllc L·mll·. whL'I'C you can 
declare a couple of constants that Visual Basic JH.:cds for ;nTanging thc windows 
that your application creates. 

14. Add the following code: 

Const CASCAOE = 0 
Const TILE_HORIZONTAL = 1 

15. From the Object drop-down combo, selecl rnnuWim.lnw< ';•sc<~Lk. 

16. Add the following code on the blank line beiii'L'Cil thc Suh '"'d Eml Suh lim·s: 

MDIForml·. Arrange CASCADE 

17. From the Object drop-down combo. sclcct the nHw\Vind4 1wTill'. 

18. Add the following codc on thc blank linc: 

MDIForml.Arrange TILE_HORIZONTAL 

That should Uo it. Now all you nccd todo is tn n111 yo11r ;~pplicatiorL 

L To run your ncw applicatiun 

l. Choose the Run icon on thc toolbar. 

2. From thc File mcnu on thc Parcnt form, choos~ Nt.:w. 

3. Do this a couple of times so that you ha ve severa! wiml11ws to work with. 

4. From the Window menu on your arplication, t:hnosc Ti k . 

This ti les all of your windows. 

5. From the Window menu on your application, choosc Ca .... calk. 

This re-arranges all of thc windows. 

6. From the Run menu, choosc End. 

7. From the Visual Basic File menu, sclcct Savc l'rnjcct :\:-- . 

Now that you havc thc frumework for ¡m MDI <~pplic;rtiun l'rnisllnl. savL' your 
work . 

X. Savc thc projcct as MDI.MAK amlmakc su re that it i~ irr 

\WALKlliRUISAMPLES . 

/ 
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Summary 

• Forms and Their Properties 

• Message Boxes 

• Starting the Forms of !he Employee Database 

• Multiple Document Interface Applications 

Objectives 
lnlllis module you lcarncd to: 

• Sct co.~ptiuns on forms. 

• Setthc N ame propcrty for a form. 

• ALid t.1 fonn toa project. 

• S ave al/ of thc forms ín a projcct. 

• Save thc projcct itsclf. 

t--- -
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I, Overview 

. .. · 

• Menu Guidelines 

• Microsoft Visual Basic lmplementation 

Overview 
Previous modules gave you a chancc to sec and use thl' ¡uoccssl's you shouiU follm~ 
fordevcloping Visual Basic applicatitms. lnlluJsc llltt~lttlc:-. ytnt tk'veltlpcd tt sin)!k
form application. In anothcr motlulc, you developcd :dl!he fonns tllat are th.!Clkd tu 
implement the databasc front-end, btn thcrc was a p;m 1h:n \\'a:-. missing-thc 
menus on sorne or'the forms. This modUle begins with" discussitlll of the general 
layout of menus and the u.scr interface spccific:nion. 11 ,·nds wi1h" 
dcmonstration/walk through (Jfthc Menu Desig11 witltl •• w . 

Prerequisites 
To successfully complete this module, you n1ust be ahl~· ¡,,use •• ¡nousc. ExpcriL·nn· 
with Windows-based applications is useful hui n~>t rl:l~~ircd. )-'ou should a !so be 
able to slart Visual Basic and create a form. 

Overall Objectives 
The overall objective ofthis module is to teach you hun· to design user-fricndly 
menus and create them using Visual Basic. 
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Learning Objectives 
At t hl' l'nd of thi:-. modulc'!-i lab, you will be ¡ablc to: 

• l.ist <HHI cxplain thc use ami valuc of allof tl~c k.cy mcnu clcmcnts: 

• Act:css or hot kcys 

• Shtia1cut kcys 

• Mcnu bar 

• Sepan.1tor bar 

• Ellipsis 

• Crcatc an application that uses at least one menu on an application window and 
uses more than nnc form. lt should include a least one functionality menu as well 
as a 1 h:lp mcm1 that includcs choiccs to display a simple Help form andan 
Alwut hox. 

•' ' 



1 
Module 4: Laying Out Menus 79 

~~~~-----------------------------

Menu Guidelines 

Style Guidelines 

Cut 
Qopy 
E aste 
Paste Sp§cial. .. 
Paste 

Lin!is ... 
Qbject 
[nsert Object... 

Move Pie tu re 
§ize Picture 

Ctri+X 
Ctri+C 
Ctri+V 

Menus and Their Standard Properties 
Under user interface guidelines, menus are onc of th~.: primal")' ways for 
programrners to structurc application functionalities !"or 11s~rs. No_rmally. mcnus dn 
one oftwo things: explicitly invoke a comm;.¡nJ, such a~ dosing an appliGuion 
using Exit, or invoke a dialog box that offcrs usen; morl' 11ptitms.·such as thc ht1ld 

· and italic tcxt-formatting options. 

Menu Structure 
Un<.ler normal circumstanccs, most applications will swn out lifc on.thc 
development si de with thrce main menus-Filc, E<.lit, '""1 Help. Thc File mcmr 
normally will contain commands that are rclatcd to fil~· 1nanipulation: 

• New 

• Open 

• Savc 

• Save As 

• Print 

• Print Setup 

• Repaginate 

• Exit 

QUÍltÍOg the appJicatÍOO, by COilVCntion, is done frolll llil' hollillll Hf thC fin·il lllCilll. 

Hclp is normally thc last mcnu on thc right. 
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Style Guidelines 

Thc !!l'nnal EUit mcnu normally contains al lcast thcsc four commands: 

• lindo 

• Cut 

• ( 'upy 

• l';¡_<.,lt' 

lt 111ay CPtllain severa! othcr commands as they are needed for speciflc functions 
within thl' applil:ation. 

l'in;olly. lldp is nonnally implcmcnled wilh atleast thesc four choiccs: 

• Conlcnts-Tahlc of contcnts for Help 

• Sea reir for Hclp on ... -lndcx to Help 

• llow lo Use Hclp-Directions for using Help 

• Almut applicmion name-Copyright notice 

Special Features of Menus 
Period Ellipses 
Thc linee Jots '" lhe cnd of a command on a menu indicate that a dialog box will 
appcar pffering you more choiccs rclated to thc command. A lack of threc dots 
indicatl'~ that <JS a rcsult of choosing the command, an action will be carried out. 
For c·xa111plc, ir you choose Centered from the Paragraph menu, all highlighted 
paragnrphs will be ccntered on the page. 

Checking Options 
A check 111ark ncxl to a menu ítem indicates to the user thatthe option is currently 
invokcU. 

Separating Clusters of Related Commands 
SL·p;¡r;IH 11 har~ are uscU to visually cluster rci<Jtcd comnuuH.h> su that thc uscr sccs ~~ 

slu1rt list 1 1!" rclatcd itcms, rathcr than a long list of seemingly unrelated items. 

Access or Hot Keys 
Arccss keys are m~rkcd by ;m undcrscorc bcneath a single lctter in thc mcnu ítem 
or coi!Hlland. Acccss kcys are the kcyboard (as contrasted with the mouse) input 
dcvicc lúr the mcnu. Access keys are invoked by pressing the ALT key and then the 
umlcrscored lellcr in the command. For example, pressing ALT+F opens the File· 
memt. Prcssing ALT+F+O opcns thc File menu and then chooses thc Open command. 

Fm acccss keys, you should try to selectthe leuer that will be most memorable for 
most' uscrs. Nonnally this is thc firstleuer in the word, butthat might not always 
work. Fnr cxampk. Minimi7~C and Maximizc both bcgin with "M," so a bctter sct of 
nptions n1ight llL· 111 use tllc "n" from Mi!1imizc und thc "x" from Maximize for thc 
;tCCL'SS kl'\'S. 
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Style Guidelines 

Shortcut Keys 
Shortcut keys are a second fqrm of keyboard acccs~ to rlrt· rnenrL Tn use :"honcui 
keys, the user need only prcss a functinn kcy or sume orlhT kl'y ('tllllbination (~1Jl'll 

as CTRL+A) in arder to executc a command. 

Sorne examples of standard shortcut keys are as rollow,· 

Fl 

CTRL+X 

CTRL+C 

CTRL+V 

CTRL+Z 

Hclp 

Cutling sclc~.:tcd tcxt 

Copying selc~o:ted text 

Pasting sclcctcd tcxt 

Undo 
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Visual Basic lmplementation 

N""'". 
lntle¡: c=J 
O ~ondu• bol 

O '-heeked 

The Menu Design Window 
Fn 1111 tllt' Wimlt1\V mcnu. choosc Mcnu Design window. lf thc Mcnu Design 
wimluw c••mnwiHI is unavailable (l1immcd), click any of thc forms in your Visual 
Bt1sic ••pplication. You willthcn be ablc to acccss the Menu Dcsign window. The 
Mcnu l>esign window dialog box appears. 

Thc ITIIlainder or this topic divides the Menu Design window into two units
Menu l.ayoul l(cms and Layout Manipulation llcms. 

Menu Layout ltems 
lh·m 

{ 'a pi itll1 

N;unt' 

lmk>. 

SIHll1l'lll 

Window l.ist 

1 h:lp( 'ontc:xtiD 

lldault 

Not chcckcJ 

Chcckcd 

Layout Manipulation ltems 

Dl·scriplion 

N ame that appcars 'on the menu. 

Nann.: uscd in '-=odc. Use nmu as il prcli~. 

Used for adding mcnu items dynamically. 

CTRL + shortcut kcys. 

S¡x::cilics whethcr ¡¡ mcnu control will indwJc a 
list of opcn MDI e hilO fnrms. 

Spccilics an illcntiHcr for thc mcnu itcm in u 
Hclp system. 

lnllicates whether a check mark wi\1 be 
Jisplayell to the lefl of a menu choice. 

lndicates whether a menu choice is available to 
thc uscr (disahlcd choiccs are dimmcd). 

lndicatcs whcthcr íl mcnu ítem is visible lo thc 

uscr. 

In ortkl In use most of the Layout Manipulation Items on the Menu Design .window, 
yuu "'"" first sclcctthc control (n1cnu) and then prcss the manipulation item to alter 
thc COII\1'11\ 
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Item 

LEFr ARROW 

RIGHTARROW 

UPARROW 

OOWNAKKOW 

Next 

lnsert 

Dclctc 
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Function 

Raises a menu ítem onc k,·l-·1· --fnr l'\ample. makc~ a 
submcnu into a m a in mcnu 

Lowers a mcm1 itc1n nnc IL'' 1'1 -- f11r L'\amplc. milke:-. ;, 
main mcnu into a suhmc11U. 

Movcs !he mcnu ÍIL'IIl up lllh' P""ilion in !he IIIL'Ill' list. 

Movcs lhc mcni• iiL'IIl do\\'u LlHt' p~t,¡¡j,,u inlhl· UIL'Itll li:-.t. 

Movcs the eursnr down o111.: ih·1n inthc mcnu lisL 1\bLL 

clcars thc Capli,,n;md Nan11· , •• th;ll )'tHI e;m ¡¡dd illll''' 
mcnu itcm . 

Insc11s a blank linc inthL' li:-.t ,,f mcm1s so that ynu can add 
a ncw mcm• itclll . 

Dclctcs thc sdL'(tcd mcnu Íh'lll from thl.' list. 

In order to implement acccss or hot.keys. placean ~mpL·rs~lllll t& 1 in front DI" thL' 

letter lo be used in the ALT+ combination. F(1r cxamplc. ¡, • implciJJcnt ALT +Fas tlll' 
access key combination for the File menu, you would type &Filt• in the Caption 
control ofthe Menu Design window. 

Separator bars are implcmented by cntering ;.¡single hypllcn (-)as a Capti,ln. 

Note You must assign a menu name to the separator cvcnthough it is no! really 
acting as a control. 

Walk Throughs-Startup Application with Menus and 
Click Events 

I, To scc thc fin~l vcrsion of thc mcnus -\V:~Ik Throu¡!.h 

l. From the Walk Throughs prngram group. starl Starllljl. 

This samplc application serves two purpnscs. 1t inlrothll'l'S yo1r lo thc Jllcthods 
for implcmcnting mcnus in Visu;ll Basic ;tpplicatiuu_..,_ and it }.'ivcs you ;1 sin1pk 
cxamplc of how Click cvcnts work in Visual B;.t~iL. lrlcidenli!lly. this sarnpiL· 
application also shows you how to use thc Shcll túrt<·t,.,l. 

2. Choose the Cardtile command buuon. 

This ó.lpplication starts up Ctnlrilc or \\'irult•ws l';lllltlllll...,li'" 

3. Clase Cardfile. 

4. From the Edit menu. choosc Colors. 

Thc application shows thc implementa! ion or llll'llll\. l'<!SGtding lllCilliS and 
checked mcnus. lt al so uses thc ampcrsand !'tJr hui kl·~·:-- . 

5. From !he Colors cascading mcnu, choosc Red. 

Firially it showsthe use of a Click cvcnt 1t1 rcscllhL· hackground color nf tllL· 
application. 

Now, the question is: How did we do all of that'? 

6. Clusc thc Startup application. 
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L Tu impk·mcnl mcnus on lhc Starlup applicalion 

1 . 1 r V isu¿d Basic isn · t running airead y. start it. 

A 11ew hlank limn should be on the screen . 

., ht1111 the File menu. choose New Project. 

Start a new projcct. 

.\. s,·ttlte following properties for the form in the Properties window: 

Nt~nlt' 

1\etght 

W~tltil 

frmStartup 

Startup Applet 

2X60 (approximately) 

2670 (approximately) 

-L Open thc Mcnu Dcsign window . 

.'\. Make thc fol\owing changcs. 

r\h·nu ilcm 

Red 

White 

Blue 

E~it 

lldp 

¡\hout 

Captiun 

&Edit 

&Co\ors 

&Red 

&White 

Sclect thc Checked 
option. 

&13\ue 

E&xit 

&Hclp 

&About. .. 

Deselcct the 
Enablcd option. 

N ame 

mnuEdit 

mnuColors 

mnuRed 

mnuWhite 

mnuBiue 

mnuSepl 

mnuEx.it 

mnuHe\p 

mnuAbout 

lndcntation 

o 
1 

2 

2 

2 

o 

Note Noticc th~¡t thc mcnu namcs includc only thc prctix. and thc rncnu 
IÜnl·tion. Wc :-:honcncd thc namcs for this ex.ercise to facilitate completing thc 
wtllk through. 

(J. Chuo..;e O K. 

7. llot~hle-click lile command buttontool in the Toolbox rwice. 

Add i'"" comm<tnd buttons nnd place thern appropriately on the form. 

X. Sl't llll' fnl\0\.,..ing propcnit.!s for thc command butlons. 

Hui\ un 

C.ud1ih: 

l't~illtlinlsh 

cmdCardtile 

cmdPilintBrush 

•1, hu1n 1hc l'111jt·l·1 Window. ciHIOSl! Vicw CmJc. 

· M a• e '<lfc that STARTUP.FRM is in the foreground. 

Caption 

&Cardtile 

&PaintBrush 

111. lnthe Object drop-down combo box. choose General Declarations. 

----<--~· -~----

• 

. 1 



11. Add the following code: 

Const RED = &HFF'& 
Const WHITE = &HFFFFFF 

Const BLUE = &HFF0000 
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Make surc you typ~ si_x Fs. 
Makc surc you type four /.L'fllS. 

Set the hexadecimal valucs for the colors that you want. You can finO thesL· 
colors and several othcrs in CONSTANT.TXT. 

Note . There is a second method for completing the step a hove: Opcn 
CONSTANT.TXT, and copy and paste thc appropriatc lincs into the General 
Declarations section of the form. 

12. In the Object drop-down combo box, sclect cmdC:ardlile amllocate thc Click 
event template. 

When the user clicks this command button. use lhL' Shl'll function to start 
Cardfile in a regular window. Add thc following c'uh·· 

x\ = Shell("c:\windows\cardfile.exe•·, 1) 

13. In the Object drop-down combo box, select cmdl;ai11tllrush a11d locatc thc Click 
event procedure template. 

When the user clicks this command butlon, use tllL' Shcll funL·tion to sw11 

Paintbrush in a regular window. Add the lollowing couc: 

y% = Shell ("e: \windows\pbrush. ex e", 1 ) 

14. In the Object.drop-down combo box, sclcct mnuRed alllllocate the Click evcnt 
procedure template. Add the following codc: 

frmStartup.BackColor = RED 
mnuRed.Checked = True 
mnuWhite.Checked = False 
mnuBlue.Checked = False 

15. In the Object list box, select mnuWhitc atllllocate ,¡,,. Click evcnt proccdurc 
tcmplatc. Add thc following codc: 

frmStartup.BackColor = WHITE 
mnuRed.Checked = False 
mnuWhite.Checked = True 
mnuBlue.Checked = Falsc 

16. In the Object drop~down combo box, seh:ct mnuBJul· aml lol'ate thc Click cwnt 
procedure template. Add the following codc: 

frmStartup.BackColor = BLUE 
mnuRed.Checked = False 
mnuWhite.Checked = False 
mnualue.Checked = True 

17. From the Run menu, choose Start and test your application. 

18. From the Run menu, choose End. 

Closc thc npplication. Yottmay nolirc lhatlhc 1·:.\il ;n11j Ahonl t'Oilllllands :lit' 
111_11 implcmcntcd ycl. You will cotnpkll·thnsc l'tttH·tiitiiS ittllt~· lll'XI n~t•dllit· 

19 .. Save the formas STARTUP.FRM in 1\VAI.KTHIUI\SAMI'I.IOS. 

20. Save the project as STARTUP.MAK in \Wi\LKTHIWIS!\MI'LES. 

. ' 
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.summary 

• Menu Guidelines 

• Microsoft Visual Basic lmplementation 

Objectives 
In this rnodulc you lcarncd to: 

• l.i:-;r ;111d ~xp\;¡in 1\le use and valuc of all of thc kcy mcnu clcmcrlls: 

• 1\rccss m hot keys 

• ·Shtlr\CUI kcys 

• ~knu bar 

• Scparalür bar 

• F.llipsis 

• Crcatc an application that uses at least one menu on an application window and 
uses more than one form. lt should inc\ude a Ieast one functionality menu as wel\ 
'" <~·1\elp mcnu that inc\udes choices to display a simple Help form andan 
Ahnut hox. 

) 

~ 
\ 

• 
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Lab Time 

Go to the Creating Application Menus ponion of your lah lll<lllllal. 
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L.. Overview 

• Form Management 

Statements 

Methods 

Event Procedures 

• Setting !he Startup Form 

---------------------·· ··-~··----~ 

..• 

Overview 
This module has two broad goals. Fir.st, it providcs an introUuction to the conccpt...., 
of event procedures and methods as they relate to m<~.naging thc forms of your 
application. Second, it reviews all thc important cvcnts ;md mcthnJs, and thcrcfoJ\' 
is a crucial Jead-in to the controls modules, and the general discussicin of funclions 
and statements as they are implemented in Visual Basic. 

This module also contains the first actual hands·<m cxpcricncc you will get in 
writing code that will be implemented by user actions witllthc ilpplication intcrfan:. 

Prerequisites 
Prior to starting this module. you slwuld alrcudy he f;t~ni/i;Jr with thcsc tcr111s: 

• Controls 

• Forms 

• Properties 

Overall Objective 
The primary objective of this module is 1<1 present tlw n, 11 it ,, t ,f L'Vent pnlcedure.-; 
and to discuss the esscntial cvcnts nccdcd to IIWli1ge f,Jruts . 
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· .. · 

Learning Objectives 
At thc t·nd nfthc module, you will be able to: 

• Use thc Unloau statement to un load a form froro memory. 

• Use thc Load stateroent to load a forro into roemory. 

o Use the Show method to display a forro. 

• Use th• Hiuc method to hide a form but not unload it from roeroory. 

• Sct thl' startup ronn. 

•' • • 
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Statements 

Syntax 

Example 

Further Examples 

s:\ ... \vb-disc\employee 
Cancel Eiles: 

employee.mak 

The Load Statement 
1l1e Load statement is usc<.l to load a form or control Ínl" rnemmy. lt rmrmally 
appears within other evcnt pruccdurcs. 

Load object 

'Event procedure for a control on Forml 
Sub Commandl_Click () 

Load Form2 

End Sub 

Importan! Load docs not muomatically display tlw fon11: it j11st l11ads it itllo 
memory. To makc the form visible tu thc uso, cal! the Show method. discusscd 
later in this module. In sorne cases you may choose 1t1 pr't·lo;rd all the forms in thc 
application at application startup. Doing this causes thetlllll he displaycd more 
quickly when the Show method for the forms is callcd ;tt the appropriate time. Of 
course this techniquc will acJU to thc time it takcs tostan yom application inilially . 

Applicalion Form l•ruccdun·/En·nl 

Calculator CALC.FRM 
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Syntax 

Example 

Syntax 

Example 

Modute S: Con~_ccting Forms 

.. 

The Unload Statement 
Thc Uuluad statcment is used to remo ve a form or control from memory. Unloading 
a form from memory may be necessary when the memory resources used are needed 
¡·,w sc1JJJt~ c1ther object or when you need to reset properties to their original value. 
Annther typicnl use for the Un load statement is in an OK button Click event for a 
fmm like '"' Ahnut box. There is no reason to keep the About box form in memory, 
hcc;u!sl: !t is scltlom used. 

Note th;u whcn a lilrm is unloaded. only the display componen! is unloaded. The 
coLic associatcd with the form module remains in memory. 

Unlmul 11hject 

;;q¡, l"••t"Tn'Htdl_Cliek {) 

Jlnl • •;lri Forml 

End Statement 
Thi~ st:Jtl'lllent cnds a Vi.-;ual Basic program·, procedure, or block. By itself, the End 
stiJII.'Jncnt swps pmgram cxccution, clases al\ lites, clears thc values of all variables, 
and dcstn1ys .:di fonns. 

You ha,·l..' sccn or wi\1 sec various uses for the End statement in other modules to 
end pnrtinns of code. The tapie appears here because you can use the End keyword 
;done in codc to cnJ your application. 

End 1 1 Fttnction 1 Select 1 Sub 1 Type J J 

SI;IIL'IIIL'nl Dl!scri¡>tion 

f~nrl f···ltl':". ion 

1·:n1l 1 1 

¡-:11•1 ,; .. ) '' 
~-: 11 ( 1 :.JI. 

-l·:fl•l "1'",'1"' 

Ends a Function procedure definition 

Ends a block lf ... Thcn statement 

Ends a Sclccl Case block 

EnUs a Sub proccdure 

Emb a uscr·dcllncd type dcllnition 

tvlow t'\;llnpll'." iUL' avai\;.1hlc in Visual B~1sic Hclp. 

'l·:t"! :;LilL<!UI"!llL Example 

::o¡)• l·:ndDcm(J {) 

llo 'Set up infinite loop 
MsgS = "Enter A, B, C, or X." 'Enter X to exit 

'¡ Userlnput$ = UCaseS tinputBox$ (MsgSI) 'Get u ser input 
11 select case' userlnput$ 'Evaluate input 

>< 

'1 

JO 

:¡ 

12 

1 l 

l.ol 

j') :.•.up 

16 End .c:'Jb 

Case "A": MsgS ~vau entered 'A'." 

case "13": 1-lsgS 

Case ·e··: 11sg S 
case "X": End 

Case El se: MsgS 

ATry again. 

r·:11rl SrdAC t 

f-lsqB••X MsgS 

: 

"You entered ·u·.· 

"You entered ·e·." 

'End if user entered X 

"You made an invalid choice. 

;=olsplay L"csults 
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Methods- Hide 

Syntax 

Example 

Further Examples 

..• _ 

EMPDB.HIDE 

~ Employee Dalaflase · §!al 

Employee: 
Maria Lo ez · . 

Peter Krauss 

Barbara Aichardson 

Hiding a Form 
When a form is hklden, it is removed from thc scrccn :uul i1s Visible prorcrty is sL'I . 

to False. A hidden form's controls are not accessibk 11• 1 hl' u ser. but they are 
available to the running Visual Basic application, to 11llwr <tppliL·;nions 
cummunicating with thc Visu<.~ll3asic application thnllt~h dyna111ic Ll~1ta c.\(.:h;ul~L· . 
(DDE), and to timer events . 

lf a form is not loaded when the Hidc methoJ is invokt••l. thc fonn is loaJcJ but not 
shown . 

[form.] Hidc 

Note thc optional form in thc squarc br;Jckcts.- /\lstl 114111' tlt:tl llll· pcritld \VitllitJ tlll' 

brackets is not optional. 

Thc following cxamplc i:-; ;¡vailablc from Visual B11si,· 1 klp . 

'Hide Method Example 
Sub Form_Click () 

Dim Msg$ 

1 

2 

3 

4 

5 

.6 

Hide tlide 1··•1" 

Msg$ = "Choose OK to ma k e the {o ¡·m r l:<~i ·1" "" 1· ... 

.7 

B 

MsgBox Msg$ 

Show 

End Sub 

Applicalion 

Mcnu 

Form 

MAIN.I'RM 

''Oisplu·¡ n.·::OSti~J·· 

Show l·•riB •"l•lirr 

l'ruccd 11 rl'IE \'l'll 1 ---------
llllll1Appi'v1).!1" ('lir~ 

nutuEtlih 11 ~( ·¡~~-~ 

mnuNUiro_ ( 'lil·~ 

nuHIT(li),' ('lid 
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Walk Through-Hide vs. Unload 
L Tu se<· lhe difTcrcnce between Hidc and Unload 

l. From Lhe Walk Throughs program group, start Hide vs. Unload. 

When Lhe applicalion slarts you see two forms. Form 1, on the left, contains two 
hutLons: one to show Form2, the other to un load Form2. 

Form2. on the right. contains nine buttons, Command 1 through Command8, and 
a hutLon labeled Hide Form2. The eight command buttons were placed on the 
lonn lo make su re that Form2 uses enough memory and Wiridows resources to 
llltlsll';ltC thc point. 

Th,· purpose ol lhe application is lo demonstrate the difference of the impact on 
llll'llllll")' and WimJows-based resources when hiding a form versus unloading it. 

' < 'li< • lhc Hidc Form2 button. 

Th1.' llidcs thc form . 

.\. In l'ro~ram Manager, choosc About Program Manager from the Help menu. 

h'lllll the Hclp mcnu in Program Manager, choose About Prograrn Manager. 
Note the V<Jiucs for the two lines at the bottom of the form for amount of 
r-.kn1nry ami System Rcsources free. 

-t. ChtH 1St' OK. 

Cl~ '·"L' l. he Ahout Program Manager dialog box. 

·'· l'rcs.s CTRL+ESC lo display the Windows Task List. 

l1. l>ouhlc-click Hillc. 

7. Clid: lhc UnloaJ Form2 button. 

Unl11atl your'Form2. 

X. In l'rogram Manager, choosc About Program Manager from the Help menu. 

N~ lit' 1111' valucs f"or lhl .. IWO lincs at tlll' holltllll ufthc fonu ror tllllOlllll or 
Ml'lllc •ry ami S yslcm Resourc~s free. 

Now that Fonn2 has bcCn unloadcd. notjust hiddcn. you should scc more 
lllt'IHory and/or rcsourccs tlvailablc. Thc ;unount will vary úcpcnding on your 
111;¡¡·l1im:'s cnvin111111Cill. 

1J. ( 'lloosc thc OK buuon. 

CltN' lhe Almul Program Manager dialog box. 

lfl. Pn.:ss<TRL+ESC. 

1 l. Sclccl lliJc lnunlhc Task List. 

12. Cite• lhe EnJ Task bullon. 

Tnrn.inate thc. project. 

_.,_. 
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Methods-Show 

Syntax 

Example 

Further Examples 

EMPDB.SHOW 

lll!ij Employee Database · Dr:JI 
Employee: 

Maria Lopez · 

Peter Krauss 

Barbara Richardson 

Showing a Form 
Show is used to display fonns that ha ve bccn loadcJ. IJ you u~c thc Show mcthod 
on a form that has not bccn loadcd;thc Show mcthod will iHIILIImltically lot1d tiH' 

form and thcn show it. 

[form.] Show [style%] 

Note The style% parameter is an intcger valuc that dctL'rmincS whether thc form ¡_.., 

modal or modeless. If styleo/o is O, the form is moJclcss: if .\tylt·(i'o is 1, thc form is 
modal. 

Users must rcspond toa modal dialog box by clickin!' any une ni a numbcr ol 
buttons. Any dialog box that lcts thc u ser cont in u e wur~ i ng wi 1 h other form .... in t he 
application is a modeless dialog box . 

This example is available from Visual Basic lklp . 

1 

2 

'Show Mclhod Ex<rrrrplc 

Sub Form_Click {) 
Dim Msg$ 

Hide 
Msg$ = ~chou:o;e (JI\ Lo IILi•ke u,,.¡,,,,, ''·'1·1·• ,,, .· 

MsgBox Msg$ 

Show 
6 

7 

8 End Sub 

Application Form 

Helio GETSTART.FRM 

l11 ;:¡1\ ,.,. IIICSS<I(j•· 

:"h••"N !•>1111 iHJilj¡¡ 

Prnl'cth•n·/E \'t'lll 

mnui3utkrfl~· <.'lil·~ 

11111111 lcllti .. 1 'lit"~ 

mnuShcll l 'hd 
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Walk Through-Connecting Forms in Startup 
L Tu nm lhc STA llTUP.MAK projcct 

l. Ir Visual Bask isn't running ;,¡lrcmJy, star1 it. 

A ncw. blank form should be on the scrccn. 

2. Frnrn thc File mcnu, choosc Opcn Projcct. 

.1. 1 lpcll ~TARTUP.MAK. 

TI u., """""he locatcu i11 IWALKTI-JI(U\SAMPLES. Loau the ende, hui do nul 
nru lhl' ;¡pplicaliun yct. 

~. "'""' "" MS·IlOS prompl copy AI30UT.FRM from\STUDENTIIA130UT lu 
\W ¡\I.KTIWUISAMPLES. 

S. "'"'" lhc File menu. choose Add File. 

1>. C'hoosc ABOUT.FRM. 

7. Choosc OK. 

Thi., adus AllOUT.FRM lo the .MAK lile for the Startup application. 

X. Sl'icct STAI(TUI'.FRM inthe Project Window and choose View Codc. 

'!. 111 1hc Object list bux, selectmnuAbout. 

Ci<> '" lhe Object list box and local e the lemplate for the mnuAbout_Ciick event. 
11 .... hntlld be CllliHY. 

111. Add thc following code: 

Add thc ende lhat will show the Aboul box when thc uscr selccls the Help menu 
alllllhc Aboul command. Remember thc 1 causes this form to be modal. Notice 
thl' "Yiltax hcrc? FormNamc.Show. 

Importan! You might he tempted to use thc Load statcmcnlto display thc 
f11111\hn111 fnnu. hut you will finLI that won't work hcrc. LomJing a formlmly 
llll';rus that it is in nrcmory. lt Llocsn't mc~111 thatthc form is actually <.lisph¡ycU un 
~nccr1. Forlhat par necU to use thc Shuw mcthoU. 

/l. horn lhc Runmcnu, c!wosc St;Jrt. 

Sl;11·1 thc application Lo test thc rcsult. 

1 c. r lpcll lhc Hclp mcnu and choosc lhc About command cmthc StallliJl application. 

Thl' t\holH hox from thc lab appcars 011 scrccn. 

Note You wi/1 nccd lo now changc thc Caplion propcrly un the About box fnrm 
as "'t'll as tire kon anLI Tcxt propcrlics un thc labcl to fit thc currcnl application. 

1.1. Ch<><>SC OK. 

Try '" choosc thc OK buuon un thc Aboul llox form. 

Y"" hal'\'11'1 rodcd lila/ yel. 

·-

"'t 
V!'!' 

11'! 
f!f 

""' 
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14. From the Run menu, choose End . 

15. Se_lectABOUT.FRM. 

Select the ABOUT.FRM file' in thc Project window. 

16. Choose View Code. 

Bring up thc Codc window . 

17. In the Objectlist box, select cmdOK . 

L~cate the code template for the cmdOK_Ciick cvcnt procedo re . 

18. Add the following codc: 

Unload frmAbout 

Aúd that codc on thc blank linc in thc h .. 'lllplatc. 

Notice the syntax here? Thc Unload statement con1cs first. anU thc object IWilll' 

follows. Notice also that thcre is no punctoation . 

19. From the Run menu, choosc Start . 

Start the application again to test the succe;s of yoor changcs. 

20. Open the Help menu and choose the Aboot command on thc Stariup applicati<Hl 

This should display thc Aboot hox . 

21. Choose O K. 

Choose the OK command button on the About box. antl it uisappears from thc 
screen . 

Now the question is what do you doto enJ or el ose tllc application itsclf'! 

22. From the Edil mcnu, choosc Exit. 

Try exiting from this command . 

In arder to clase the application cntircly, you stillnL'l'd to ma~L' une mnrl' ch;Jil_l!l' 

to the source code . 

Note This placcment of Exit is not standard for \Vindows. An application tll:u 
foiiOWS interface guidc/incs ror \VjnJows wnuld plill'l' J-:xil ;IS lhc Ja.~l iiC/Il.llll 
the File menu . 

23. From thc Run mcnu. choosc Entl. 

SIUp thc application . 

24. Select frmStartup in the Project \Vindow ;md clwo . ..;L' View Code 

25. In the Object list box, choosc the Exit mcm1 Clid ev,·nt proreclurc. "'"' plaec· tlll' 
appropriate codc thcre. 

26. Add thc following codc: 

En~ 

Put this code on the blank line in thc tcmplatc . 

~--··---... ------------

' 

·.' 
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'27. Fnun the Run menu, choose Start. 

Tcstthc Exit command on the Edit menu, and test the About box elements. 

2X. hom lhc Run menu, choose End. 

~Y. From the File menu, choose Save Project. 

Savc this projcct as STARTUP.MAK in \WALKTHRU\SAMPLES. 

j 
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Event Procedures 

Syntax 

· .. _ 

Event Procedures 
An event procedure is defincd as a procetlurc invokcd hy a u ser or systcm-triggcrcd 
event. Event procedures are always attllchcU toa gi\'Cil f11rlll or control, aml thc 
syntax for an event procedure looks like the following: 

Sub objectname_evenlllame 

statementblock 

EndSub 

Examples of event proccdures are: Command I_ClicK :t1t1l 1:1 lrlll .Ciick . 

Loading a Form 
A Form Load event occurs whcn a form is lootdcd. ({ IIHntt:llly uccurs whcn an 
application is run oras the rcsult or cithcr a Load stalt•tncnt or <111 implicit load th;H 
is causcd by any rcfcrcncc to omunloadcd ronn's prupl'J'lil·~ or L·ontrols . 

Typically you place initialization codc for a form in" h>nn Load cvcnt proccuurc. 
For example, you would specify dcfault scttings for cun!rols. initializc thc contelll~ 
of a combo or list box, and initialize form-levL'I vari<~hk:-. in a Form Load cvcm . 
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Summary 

•.,· 

• Forrn Management 

Statements 

Methods 

Event Procedures 

• Setting !he Startup Form 

Objectives 
In 1 h i" 1111nlu \e y1 1u lcarncd to: 

• l ''-l' lhL· Unluad statcmcnt to unload a form frommemory. 

• ¡:..,L. liiL' Load statcment to load a form into memory. 

• l ''l' IIH' Show mcthod to display a fonn. 

• 1.1"· thc Hidc mcthod to hidc a form b~t not un load it from memory. 

• Sct thc startup form. 
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Lab Time 

Lab Time 
Go to the Loading and Unloading Forms poniun or) !HII bh 11\illlll<ll. 

• 

• 
' 
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2: Overview 

• Types of Controls . 

• Properties for Controls 

Overview 
The purpose of this module is to make su re 1hat you LIIHkrstand the general 
purpose of control properties and events as well as thc l·ssential properties fnr 
each of the controls in the Toolbox. 

This is not intended to be a comprehen.sive trcatmcnl c1f ;tll thc possiblc propcni~.-·:-
and events for all of the controls. In addi'tion. this mcHluk covcrs only half of thL' 
total number of controls in Visual Basic. Thc nwc.Juk lt~llcJwin,l! this covcrs thl' 
other half. 

Thc general approach hcrc is to let you practicl' ch;HIJ!III.l' 111c prtlj)L'rlil·s ft•r t';tt·J¡ 

control anU aCtually scc how thc clwngc afkc1.-. tllc ~""lllttd. 

Prerequisites 
Prior to starting this module, you shnuld ha\'1.' il rurHLllth'Jil:d ;1\\'ill'l.!lll'S .... ()r: 

• Thc functionality of Microsoft Visual B;1sic 

• The general use for ench of tllc contn)ls in !he Tlhllllll.\ 

• The general methods for scning propcnics on con1r11l:-. 

\ 
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Overall Objective 
t\t lhl· t'IHI of this llitiJUic. you will be <JbJC lO USC kcy propcrtics Oll half of thc 
conllols locatcU in the Toolbox. 

Learning Objectives 
Al lhL· L'nd of this module, you will hove set key properties for: 

• l.ahl'ls 

• Tl'xl hoxc~ 

• Franll'S 

• Cr11n111and buttons 

• Chcc~ boxcs 

• 1 )J'''''Il hutlons 

• C\llllhll boxcs 

• J .i:-.1 ht~.\CS 

• JJ,ItÍ/.111\Ial ;rr1d \'crtic;ll scroll bars 

• Tirnns 



'·' 
M • 
• 

• • • • • • • • • • • 
~ 

t 

t 

• 
• 
1 

Module 6: Using Controls 111 --------------------------------------------

Types of Controls 

.. · .. 

Pointer 

Label 

Frame 

Check Box 

Combo Box 

Horizontal Scroll Bar 

Timer 

Directory List Box 

Shape 

lmage 

Custom Controls ('. VBX) 

... ' . 

~ 1M 
A ~ 

o o 
[8] e 
§.m . ljffiJ . 

G!J ffi 
é El 
L) ~ 

rOl ...._ 

ll2il T:il 
EB 

Picture Elox 

Text Box 

Command Button 

Option Button 

List Box 

Vertical Scroll Bar 

D'rive List Box 

File List Box 

Line 

Data Control 

···-------

This module covers the various clusters of controls foiiiHI in thc Toolbox. tia:: ir 
most commonly used properties, and the events that are normally used with lhellL 
One of the first things you will see is that ma11y of the n11llrnls ha ve the same 
kinds of attributes. In many cases, a property will be ,·o~vered only once. e ven 
though it shows up with almost every control. 

Controls will be discussed in ordcr of placcmcnt in thL' Tuolbux, with the 
exception ofthe picture box, which will be covcrcd la.,t. anJ the tlrivc, Uirectory. 
and file list boxes, which will be discusscJ in a scp;1ralL' tlltH.lult: . 

' 
A good way to get a ham.lle on propcrtie~ as thcy n:Lllt' lo n11llnds is to loo\\ ;JI 

the very front of the Microsoft Visual Basir l.af/glw,l!,t' Nt~(t'rt'lln'. Thcrc you c;m 
find a comprchcnsivc lisl or controls ant.l thl'ir propL'riÍl'S 

Adding Controls to The TooiBox 
The graphic on this pagcdisplays thc dc.faulr TnoiBtl\. Ynt1c;111 ;tdd conrrols lo lhl· 

Toolbox . 

L To add a custom control lo thc Toolbox 

l. Frorn thc File mcnu choosc Add File. 

The Add File dialog is displayed . 

2. From thc Aúd File dialog, locatc thc cusiHIIJ·contrul J'ik rlial you w;tnl lo :tdtl . 

For cxamplc, loca te the file THREED. V IJX. Thi.> fik should be in the 
C:\WINDOWS\SYSTEM directory. This is a cu.storn wntrol·providcd hy 
Visual Basic . 

3. Select the file THREED.VBX ano choosc OK. 

Thc ncw contmls :m~ :uldl'd to thr Toolh~t.\. Yott 111;1\' J!t'l allt'nor IIIL'~s;t!!l' il 
THREED.VBX has :llrcady hl'L'II adlkd lolhc To11llu._,_ 

4. Use this same process lO add any custom cuntrolto llH· Tnulhnx. 

p ~---------------------------------
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¿ Properties for Controls 

• Labels, Text Boxes, and the Masked Edil Text Box 

• Regular and 3·0 Frames, Check Boxes, and Option Buttons 

• Regular and 3·0 Command Buttons 

• Combo and Lis! Boxes 

• Horizontal and Vertical Scroll Bars 

• Timers ' 

• Picture Boxes 

·-

~ 1 

111 
1 
i 
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Labels and Text Boxes 

~ Form1 afZI 

Label1 tlli1 Form1 B:ID 

Text1 

Labels and Their Common Properties 
Labels are most commonly usctl to dispi••Y lt'.'\1 tlwt ~~~~~ dt1n·1 \\iiJ\t thl' u~~:r lltlw 

able to change. Typically tllis woui<.J be a ctption LJI~<kl ;1 }.!r;qllliL· or caption .... i'tll 

drive, directory, and file lis1 boxcs . 

Property 

Alignment 

AutoSize 

BackColor 

BorderS1ylc 

Caption 

FontName · 

FoniSizc 

ForeColor 

Heighl 

Lef1 

N ame 

Tablndcx 

· TabStóp 

Tag 

. Top 

Dcfaull 

O- Lefl Justify 

False 

While 

O- Nonc 

Labell 

Hclv 

8.25 

Black 

500 

Labcll 

Assigncd hy Vi,u:d 
Ba:-.i~.: 

True 

CtiiUIHl:llt ... 

DctermiiiL'" whcther •• ~.:ontrol aUju:-.ts 111 
fit its conl!.:nt,. 

'l'itlc hu thL t'lllllrnlult scrcc11. Thc 
c;1ption i.~ tliv dd;ndt propeny t'or lhi' 
L'lllllrnl. S~illil'· --l.:ihl!ll;:: "Fill''" 

lntwip.'-

hom h:fr I•••Hkr ~~~-¡;,rm. 

DctcrmiJW:" \diL'Ihl'l' u.,~ t:an u~~ T<1h h.L'\ 

IH 1110\1" 1 .. ,111i' lt"\llun 
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·.,· 

Text Boxes and Their Common Properties 
,.\ ll'\1 f¡,,, l·ont~td displays c.:ithcr informatinn that is proviJcJ by thc application 
or inl.,t•n;•tionthilt thc uscr can type. 

TypiL·al tt"CS of ICXI bnxes would in elude the box where userS type the string.of 
L'l!;•r;H,:IL'I" thcy want the application to find in a search function. lf you were 
lTL'atin~ ;~ front-cnU for a databasc. you could use a sequence of text boxes to 
~adll't intormation ahout mcmbers of the database. 

l'nt¡tt·rt.' 

.\li~I!IIH'Ill 

1 :• 1111 ¡\;allll' 

lki.t:hl 

I.L'II 

Natlll' 

s,- •. dlll;u, 

lnl 

TIIP 

\\'idth 

J>cfault 

O- Left Justify 

Hclv 

X.25 

)()() 

() 

Falsc 

Tcxtl 

11 - Nonc 

Tcxl 1 

Commcnts 

Intwips. 

Frum left bun..lcr uf form. 

Controls amount of u ser input. Rangcs 
from Oto ó.t charactcrs. 

Meuns no multilinc cap:.1bility. 

N ame used in code. 

Use txt as a prefix. 

Spccifics thc char;u.:tcr lo he displ<~ycd 
whcn uscr typc ... tcxt in thc lcxt hox. 

¡:or IHllll!, assign "". This is thc Jcf;¡ull 
propeny for the control. 

Syn1ux- Tcxtl = "" 

From top border of form. 

Width oflext box . 



Module 6: Using Controls 1 15 
------------------~--------------~-------

. t NNZR 

Walk Through -Text Box with a Scroll Bar 

L To use thc tcxt box with a scroll bar 

l. From the Walk Throughs program group, st;ut Tnr H11.\ \\'ith a Scro/1 Bar. 

When you start the application, you \vill SL'C a fom1 \\·irh" tc.xt hox with ;1 

vertical scroll bar in the ccntcr of the furm. 

The purpose of this application is lO demonstrate IIJL' hcha\·ior uf a tcxt ho.x 
with a scroll bar and how to crcate a text box with a scroll har. 

2. Type sorne text into the text box. 

Type enough text into the text box to cause it tostan scrolling. Noticc that the 
text will automatically wrap at the right margin. Notice al so that you can 
select text and then cut and paste it just '"in a st;mdard Windows-bascd text 
box. Use CTRL+C to copy, CTRL+V to inscrt, CTRI.t '\ lo etll ;tnd CTRL+Z to un do 

3. Double-click the Control mcnu. 

Clase the walk through. 

4. Start Visual Basic. 

5. Double-click the text box tool in the Toolhox. 

This will create a text box control. 

6. In the Properties window drop-down combo bo\. 111;J~t: thcsc changc:.;: 

Height 1000 (approxirnately) 

ScroiiBars 2- Vertical 

Set the ScrollBars property to 2- Vcrtic;ll. Notit"L· rl1;11 yon tlon't st.:L' thc 
control change. Therc's a littlc problcm hL·rc. Sl'llill)-' rht• Snui/B;Jrs pn1pL'H.\' 

for Hlcxt box Únly beco mes cllcctivc if tire Multil.illl' pn•¡wrty for thL· ll'.\1 h4t\ 

is al so sct to Truc. . ' 

7. Set the MultiLine property to Truc. 

Notice that a vertical scroll bar now appears on thc h·xr hn\. 

8. From the Run menu, choose Start. 

Test the behavior of the text box lO see if it beh<.l\'L' ..... ""' it did in thc demo. 

9. From the Run menu, choose End. 

Clase the application. 
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· Masked Edit Control 

Masked Edil Control 
This l'tllltrnl is a spCl·ial fonn ofthc tcxt box control.lt is uscU to rcstrict uscr input 
as Wl'll ;"' 1t1 for111at Jala output. 

¡\J;¡_.;k dl:lrlH"It'I"S 

11 

1 >cscri pi iun 

Dc~.:imal placeholder 

Thousands scpar<Hor 

Time scp:u<.~tor 

D;ltc scpamtor 

Trcat ncxt character as a literal 

Churacter placeholdcr 

Alphanumeric placeholder 

Lettcr placcholder 

Digit pl<lceholdcr 

Walk Through-Validating User Input 
L. Tu monitor uscr input with thc maskcd cdit control 

l. h""'the Walk Through program group, start Masked Edit. 

·¡·¡H. JlllrptlSC 11f this walk through is to-dcmonstratc une of thc routinc uses of thc 
rna\1\L'd cc.Jit control-displaying a text box that prompts for and monitors the 
~-otnTlness uf" uscr-added telephone number. · 

' Tyjll' a lt.:lt:phon~ numbcr. 

N11ti<T lhallhe use nflhc parcnlheses and lhe underlining prompls lhe uscr on 
_IIH' IVpl' aud aiiiiiUIH uf infonnationlo be typcd. Noticc also thatthc maskcd edil 
IL' )1,1 lu t.\ iltJion¡;Hically tai.Js tlJc "cur!-.or w tlu: IH!xt control as yo u Lypc thc 
tt:lcpllt me numhcr. 

J. ('lo ..... ¡' th~ appliGJiion. 
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.... 

L To create the application 

l. Start Visual Basic. 

2. Rcsizc thc fonn and sct its propcrtil:s as follows: 

Height 

Width 

2850 (approximately) 

4560 (approximatcly) 

3. Pluce a labcl control oH thc 1t1j1 of thc fonn ami-"L'l ih pl·o¡wrlic.:s ;1s follo\L':..: 

Alignment 2 - Center 

AutoSize Truc 

Caption Customer's Telephone Numhcr 

4. Place the masked edit control in the centcr of the fmm anJ sct its propcnies as 
follows: 

Mas k 

Width 

(###) ###-#### 

1635 (approximatcly) 

Visual Basic calls the parenthescs and the hyphen "litcrals." Thcy are the visual 
cues that tell the user the type of data that is cxpccl<'d. ami you type thcrn '"pan 
of the input mask. Thc munbcr signs {#)are calk·d ··,¡¡!!¡¡ plaL·cholders.·· amlthl'y 
specify that a digit is rcquirctl. As you ht1vc secn. wlll'll ynu run the applic;_Hillll. 
the control places an appropriate nu.mber ~)r undcr .... L·• II"L'S that tcll the u ser the 

·total number of charactcrs in thc numbcr as well as lhL' u ser\ i·cJative position 
within the number. 

5. From the Run menu, choosc Star1. 

Test the bchavior or thc maskcll cdit L'Oilll"ollo Sl'l' if i¡ hl'haws as it did in illl' 
demo. 

6. From the Run mcnu, choosc End. 

ValidationError Event 
If a user typcs an invalid charactcr. a Valil1ationErrur l'\1'111 oú'lJrs. Youran pLtl"l' 

code in the ValidationError evcnt lo display ;111 error llll'~~age. For cxample. you 
might want to beep if the user typcs an jnvalid charactcr. 

l. Place the following statcrncnt in the MaskcJEuitl_ ValidationError cvcnt: 

Beep 

2. From the Run menu choose Start. Typc a leucr in lhL· m••skcd L:dit rielU . 

The system beeps . 

3. Save the form and .MAK file with appropriatc "'"'"'' irr 
\W ALKTHRU\SAMPLES . 
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Regular and 3·0 Frames, Check Boxes, and Option Buttons 

m¡) Form1 fml§t 

Frame1---, 

@(option1j 

Ü Option2 

[81 Check1 

O Check2 

Thc frarnc. chcc~ box, <.IIH.l option button controls providc a way to prescnt usen.; 
with il Sl'[ of options fr0111 Which they Call ChOOSC. 

For ex;nnple, if you stélrt thc Solitairc gamc in Windows, then open the Gamc 
menu. antlthcn choose Options, you will sce a dialog box that contains two scts 
of op1i1111 hunons. lnsidc thc framc labeled Draw are the options affecting how 
many cartls are tlrawn. lnside thc othcr frame labeled Scoring are the options that 
allcct h11w thc gamc is scored. The arrangement on the screcn and thc use of 
fraii\L'S IL'll thc usc\and thc systcm that thcsc are indcpcndent groups of optíon 
hutttHJs. 1\ choice maJe in thc Draw group will not affcct thc Scoring group. anLI 
\'ICC \'l'l Sil. 

Frames and Their Common Properties 
Framcs providc a mcans for graphically and functionally grouping controls. 
Framcs are most commonly used to group two or more option buttons in a set or 
mutua11y exclusive choices. 

Note Informal ion prcsentcd in framcs and option buttons can also be presented 
in drnJHiuwn list bnxes. 

l'ru¡u·rl.r Dcf:1111t Cummcnts 
------------------------------------

Framc 1 

Truc 

On scrcclliabcl. This is thc Ucfauh 
propcrty for this control. 

Syut;tx-Fnamc = ''Dl•finitiuns'' 

Nounc uscd in t.:odc:. 

Use rra as a prefix. 

Falsc hides the frame and any control!' 
insidc it. 
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Events 

Caution When Placing Controls on Frames 
There are two methods for plnci_ng control.' 1111 a fonn Tllt' si1nplcs1 mcthod ¡_.., ~~~ 

c.Jouble·click a control icon. An instancc of thc conn~ d w ill appc<n· in thc ccntl.'r 111 

the form, and you can position thc control fn111i tlll'l\'. Tllis is ;1 particu/¡¡r/y u:-dul 
approach when you are p/acing severa/ controls on ;¡ -,in.ck fnnn. 

The second approach is to singJc.cJick a too/ in thc Twdhox. n1ove the cursor 111 

the form .• and drag the control on the form unlil ir is tht• siz1..' ynu want. Thl.\· 
secoud metlwd is required for placinJ.: cmuro/,\· tm a¡i·ruur. Jf yo u U o nol use 1 h i :
method, you will lose the controls when you try to nwvc lhc frame aroum.l tlll lflt' 

form. 

3-Dimensional Frames 
Added property Default 

Alignment O· Left Justify 

Caption 

Font3D O- None 

' N ame Frame3Di 

Curnments 

You cannol Ll.'lllc:r- or rigln-ju .... tify frame 
caplions with 1hc othcr controls. 

This is lhc dl.'(:•ull propc11y for rhi .... control 
Synl<lx-Fn;~uu:J = "l>clinitions'' 

Se!~ lile i.IIIIOI/111 :md difl'l"lion or shadin~ in 
lhe Captiou. 

Nmnc usetl in l'ndc. 
Use fr:1 as prcfi,. · 

Check Boxes and Their Common Properties 
Próperty Dcfaull 

Caplion Check 1 

Enabled True 

N ame Check 1 

Value O· Unchccket.l 

Visible Truc 

C Ulllllll'IIIS 

On-.scrccu ';dtt~· 

Fnl.w disabk~. ;dl ust•r ;KTc . ..,s. 

Numc uscd inl·Hdc. 

Use rhk a .... ;¡ prdi.\. 

J - Chcckcd: 2 - ( iraycd. 

(Fills hox wilh !!f;ry). This is thc dcfaul! 
rropcrty for llil' l"lllllfOJ. 

F;~lsl' hidcs lite drú·k bnA. 

Click Normally a CJíck evcnt indica tes thal thc u~n h;r." rnadl' ;r sckctinn. In lilv 

case ofa check box, the Click cvent acls ~1s a loggll'. 1( rhcrc is ;111 X in~iúc thc 
check box when the userclicks it, the X will he rcllrtlvc<L lf thc check b11x is 
empty, an X will be placed iríside tire check hox aflcrrhc uscr clicks i1. 111 cithcr 
case, the Value property wi/1 be rcset. A typical use or' a chcc~ hox might hc tn 

.allow rhc uscr to choosc bctwccn boiJ or nornwl fon1 

..• -

' 
,>, 

;¡ 
li 
1 

\\ 
1 

li 
1: 
1, 
¡:. 

1 

\ 

1 
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Style Guidelines 

Events 

Option Buttons and Their Common Properties 
Opliun huuons, as noted previously, are used to display an arra y of choices from 
which thc user may select only one. An examplé is found in the Microsoft 
Winduws Writc Print Setup dialog box, where the user can select either the 
d~fault printcr or <1 spccific printcr and eithcr po~rait or lantlscupc pagc 
tlricJJtalitm. 

Dcfault Comments l•rupc.-l_r 
~----------------------------------

( 'apiUHl 

N;um· 

Vallll' 

()plionl 

Optionl 

Truc 

Falsc 

On-.,crccn valuc. 

Nmnc uscd in coJc. 
Use optas a pretix. 

Uscr has access to control. 

This is the Oefault propcrty for this control. 

Syntax-Optiunl = Falsc 

Always ha ve one option buuon in a group selected as the default for the user 
when the form is úisplayed. 

Click When the user clicks an option button, the Click event actually invokes 
severa! activities. lt paints the dot on the selected option button, removes the dot 
from any nther option button within the frame, and resets the appropriate values 
ror all option buuons in the same group. 

Walk Through-Option Buttons and Displaying Their 
Values 

L Tu mrupare thc crrcct of thc Click cvcnt for a check box versus an option 
hulton 

l. Fnn11 the Walk Throughs program group, start Check versus Option. 

Will'n you start the application, you will see a form with three option buttons, 
two check boxcs, ;.md a clcar scrccn butt?n on the right side. 

Thc purposc of this application is to compare the effect of the Click evcnt for 
;1 l"lll'd:. hox Vl'r~ll~ <.111 option hutlon. 

' <"lid. tllc Optiun 1 option butlon. 

Thc ,·alucs for all three buttons should be displayeú on the left side ofthe form . 

.1. Cl1d the Option2 option button. 

Thc opúated valucs for all three butlons should be displayed on the left side uf 
thc form. 

4. Click the Check 1 check box to placean X in it. 

Thc value of Check I.Yalue is printed on the form. 

C"ornpare the number that is printed for the value of a check box when it is 
sck,·lnl ( 1 1 to the value that is printcd for an option bu non when it is 
,.¡,.,·h·d (-1 ), 
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5. Click the Check2'check box to place an X in it. 

The value of Check2.Yalue is printed on the form. 

Compare the effcct of thc Click cvcnt for check ho\l'S vc:rsus option hu!lon~. 
Clicking one option buuon allccts thc statc of tht.: ¡flfll·r uption buuon~ in ii." 
group. Clicking a check box will not affcct thc :-it<llc..' qf otllL'r check hoXL'S. 

6. Double-click thc Control mcnu. 

Clase the walk through. 

L, To Code values for option and check hoxc."i 

J. If Visual Basic is not running alrcatly. start it. 

2. Double-click the framc control tool in thc Toolb"'. 

Add a frame to the form. Click and drag thc sizing hanúlcs to make it big 
enough to hold three option buttons. Place it near thc lowei'-right corncr of tlll' 
form so that therc is plcnty or room to display tht.: valw . .:s fur thc thrcc option 
buttons you will add. 

3. Click the option button tool in the Toolhox. 

4. Movc thc mousc ovér thc frt~mc you just ncatcd on Forn1l. 

Note that the mouse pointer has changed rrom an. arrow to a cross ha ir. 

5. Click and drag inside the area of Frame 1 to draw "" option button thcre. 

6. When the button is the size you want, release thc mmiSe. 

7. Draw two more buttons insidc Frame l. 

8. Double-click the top option button. 

This displays the FORM I.FRM Code wimlow witl1 lht: Optioni_Ciick ncnt 
procedure templa te. 

9. Add the following codc: 

Print ·optionl.Value 
Print ·option2.Value 
Print •option3.Value 

Optionl. V11 l tlfC' 

Option2. v;, l11" 

Option3. Vn ltw 

This adds the code that prints the values ror !he hiii!<IIIS. 

10. In the Objcct list box, sclcct Option2 and locatt: tl11· 1 'lid; L'vcnt tcmplatc rn1111 

the Procedure list box. 

11. Add the following codc: 

'Print woptionl. Value 

Print ~option2.Value 
Priñt ·option3.Value 

Optionl .Vnl01e 

Option2 .V<t]Uc> 

Option) . y,,]llt; 

This adds the same codc Lhat prints thc valucs fur tiiL· hutlollS to thc Clid; 
event for Option2. 

12. Using the Copy command, place the ende abovc into the Clipboard . 

13. In the Object list box, sclect OptionJ amllocatc !he· Click e ven! tcmplate fn•n• 
thc Proccdurr. list hox . 
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1 ~. l.lsing the Paste cornmand, copy the contents of the Clipboartlto this event 
pn 'L·edure tcmph1tc. 

Tht• rodc slmuld look likc this: 

f'r int "Optionl. Value .. Optionl. Value 
J'r irt' "Option2. Value .. Option2.Value ,., in t. "Option]. Value .. OptionJ. Value 

This adds thc samc cotle that prints the values for the buttons to the Click 
rvl·nt hir Option3. 

1 ). ¡:ronl thc Run menu, choose Start. 

TL·.o.;r ~·our code. 

lh 1.-n,lntllc Run mcnu. choose End. 

( 'ltto...¡· thc application. 

17. ()uit Visual B;.1sic. 

3-Dimensional Frames, Option Buttons, and Check Boxes 
For thc most par1, these three coñtrols are identicalto the three controlsjust 
tliscusscd. Howcvcr, there are a few subtle differences that need to be noted as well 
as thc pmcedurcs for setting the 3-D qualities for these controls. 

3-Dimensional Option Buttons and Check Boxes 
AdciL•tl fii'HjJCflJ 

Nan11.·! fr •r check 
hoxe:-.1 

. Nmlll' !hu·~~plillll 
hutt1Hl~l 

Dcfault 

Check3DI 

Oprion3DI 

3 · lnset with Light 
Shading 

Comments 

Name used in code. 
Use chk as a prctix. 

Name uscd in code. 
Use optas a pretix. 

Sets or retums the three·dimensional style 
of the caption. For example, you can set 
Font3D lo have font appear raiscd or insct 
with light or dark shading. 

' ... _. 

... ., 
~ 
f!J' .,. 
·"' ~ 
"' .,. .,. .. .. .. .. .. 
• a. .. 
• 
• • 
• • • • 
fl' 

• .-
fl' ,. 
e ., 
~. 
~ ,. 
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Regular and 3-D Command Buttons 

Style Guldellnes 

Events 

~ · ·Form1 . al 

( CommandD 

-----------

Command Buttons and Their Common Properties 
A command button performs a task when the u ser presscs it. 

Property 

Cancel 

Caption 

Default 

Enabled 

· Height 

Lcft 

Nnmc 

Tnp 

Withh 

Value 

Default 

False 

Comm~ndl 

False 

Truc 

500 

Command 1 

1215 twip., 

Cumrucnts 

Truc-bull•lll a\·ti\·atL·tl hy ESC. 

On- ... crccn \ alt~c: 

Trut•-hutlllll al·ti\·atctl hy ENTFR 

FHbc dis<~hll.':-. tilt' hullon ror USCfS. 

u ... l'l'lllll ,,., ;¡ prdi.\. 

Synlax -Cunuu;tnd 1 ; EnaiJlcd 

P·lace buttons in a group on a form, eithcr horizontally ;don~ thc hottom nf thL' 
form, or vertically along thc right si de of thc fonn. 

Click With command buttons, a Click cvcnt normally lltl'<lns that thc uscr wants 
sorne ~ind of action to take pl«ce. In the case of an OK htHton, for cxamplc. uscr." 
might want a form removed from the scrccn so that tlll'y can cuntinuc work. In 
this case, you will be providing couc . 

-. 

'•' .,.-;:¡·.fl';;;"";;.·-.-------------------
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\VhL'Il 1 he u ser uses the mouse pointer to choose a command button, the Click 
<'Vclll ,·ha11ges thc color of the button (to simulate its being pressed) and executes 
whatl'\'l'r cotlc you ha ve added to the Click event procedure. A user can also use 
the keyhoard to gcncrate a Click event for a button by tabbing to the button and 
thcn prcssing the SPACEBAR. 

Example ~;,¡¡ •. ,.,,TIIII>'Indl_Cl ick 11 

;~1 "r' all execution of the program 
¡.:¡¡•] 

3-Dimensional Command Buttons 
This l"onn of the command button behaves in much the same manner as the other 
t'niiHllalld hullons. hut thcrc are a couplc nf intcrcsting Uiffcrcnccs. 

l'rupcr·ly llcfault Cnmmcnts 
----· -----------------------

N aun· 

( lUIIinc 

l'iclltll' 

ComnwntiJD 1 

Truc 

Non e 

Spccifics thc thickucs:- or thc highlight ;uul 
shm.low around the bunon. Valid rangc is 
from O to 1 O. 

N;une uscd in ~o<.lc. 

False disables the border or line cdging thc 
button. 

Enablcs placing ;,a picturc or icon on a 
..:onunanU button. 

l'--"--------------------------------- .. -

,. 
• "' "' , ,. 

ti' ,. 
~ ,. ,. 
1!" 

• .. 
e • @!' 

@!' 

f/!1' 

t'i' 

• • 
~ 

• • 
f1'f' 

• 
f1'f' 

r, 
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Combo and List Boxes 

O - Drop-down Combo Box 1 - Simple Combo Box 

Form1 

List Box 2 -. Drop-down List Combo Box 

There are actually four kinds of list box controls, cach .. r which has a slightly 
different functionality. 

Both drop-down styles of boxc.s are designcd to saYt' 1111 thL' initial amountof 
screen space in use by the control. 

Users can only add neW items directly intn cithcr a drop-down or simple comho 
box. With a list or drop-down list, they are limitcd '" thc clwiccs providcd hy thc 
application. 

List Boxes and Their Common Properties 
List boxes display a list of items from which thc user ~·;111 sell'L·t only one :11·,, 
time. Through the list box control, users can nnly sdt·~·¡ frornthe givcn Jist of 
articles, but you can write codc that aJJ(¡ws then1 to add and tk·lete itcms Llurin); 
run time through sorne other control. 

Automatic Scroll Bars 
Alllist and combo boxcs will automatically add '-' ,.t'IÚ\·al :-.l..'roll bar if the nu1nht·1 

of items contained in thc list is grcatcr than what will fit in the maximum Uisplay 
size of the control, which is sct by !he Hcight propcny. 

Property 

Columns 

List 

ListCount 

Listlndcx 

Dcfault 

Dcfault 

Cummcuts 

Enahlc~ muhipk-,·· durm1 di:-.play of dat;r ir1 01 
single list box. 

Acccs~ihlc only ;rt rurrtinlL'. Scts or n:turn:-. thl· 
ilcms ~.:outaincd irr a routrol'~ list string arr;ry 

RciUrns thc nutnhl'f of itCm:-. in the Jist. 

~------------------------
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Evenls 

Methods 

l)n,pl'rl~· Default 

~·lutli.Sekct . O- None 

N;Ulll' L1stl 

Soncd False 

Comments 

Other options: 1 ·Simple and 2 ·Extended. None 
means that the user can select one within the list. 
Simple means user can select multiple items 
using the cursor. Extended means user can press 
CfRL to select multiple items. 

N ame used in code. 

Use 1st as a prefix. 

This is thc default propc11y for this contn1l. 

Syntax-Lisll = "ltcml" 

Click \Vith ;m y nf thc list boxcs. a Click cvcnt occurs whcn uscrs sclcct an itcm 
frt1111 thr list to indiL·;nc thcir prcfcrcnccs. 

DbiCiick ,\ Jouhlc click nornwlly is uscll as a shortcut that combines two actions: 
lhl' Sl'll'l'lion iiiHithL: starting Up of a proCCSS. 

Thcsr illl' uscd for list managcmcnt. 

NH llll' Function Syntax 

Used 10 udd individual itcms to Listl.Addltcm "uame" 
list box. Secding a list box is 
done from Form_Load. 

Reme ''Tilcm Used to remove items one ata Listl.Rcmovcltem (ListCount) 
time from a list box .. 

Ck;u Used to rcmove all itcms in a list Listl.Clcar 
box in one stroke. 

Walk Through-Adding and Removing List ltems 
L, To mhl and rcmnvc list ilems 

l. ~'~'"" thc Walk Throughs program group, starl Lis! Box. 

Whcn the application starts up, the cursor should airead y be placed in the 1ex1 
he l.'\. 

Thc purpc·,sc uf this application is to dcmonstratc a simple proccdurc for 
;aldin~ itcms lo <nu.l removing items from a list box. 

' TyJ'l' llarwood, Gene in thc tcxt box. 

Add a ncw na me in thc tcxt box. 

CIH H ISC AdJ. 

Youl·an t.lo this with cithcr thc mousc or thc ENTER key. 

~. SL·kL•t ihC 1CX1 box. 

Tt~h 1c1 or click thc tcxt box. 

:'i. Tv¡w Simous, t\nna in thc 1cx1 box. 

1\dd ,, '-l'Cund nanu: tothl' list hox, anda vertical scroll bar should appcar on 
·'y111.11 dl' . ..,pJ;Jy. . 
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•., 

6. Choose Pfeiffer, Terry. 

Single-click this list item. 

7. Click the Remove button. 

The list item is removed from the display. 

The question here is this: How does alt of this worh. ·.1 

L To code list box handling 

l. 11' Visualllasi.: isn't runuin~ alrcady. ,t;\1\ it. 

2. From the File menu. choose New Projcct. 

Note If you want todo a JI of thc work for this ,\:;tll\ throu~h. go to thl' n~x1 
step ami start changing thc propcrtics l"or tht.: fon11 lf you \\';tntto start fnHII :1 

completed interface, you can also find a parti:dly ~··Hnplt:tcd form callcd 
LIST.MAK in \W ALKTHRU\SAMPLES. 1 r yo u , lo"""' thi' option. skip 
down to step 12, thc point whcrc you stan '-1Lh.Jint ~·odL· to thl' Form_l.o;1d 
event. 

3. Sct thc propcrtics for thc form as follows: 

Caption Consultants 

N ame 

Height 

Width 

Forml 

3075 (approximatcly) 

3420 (approximatelyJ 

4. Double-click the list box tool in thc Toolhox. 

Add a list box to thc form. 

5. Set the following propenies: 

Name Listl 

Height 

Soned 

Width 

1005 (approximatcly) 

Falsc 

2775 (approximately) 

6. Double-click thc tcxt box tool in thc Toollmx. 

AULI ;,¡ tcxt box tn thc form. 

7. Setthe following propertics: 

N ame 

Height 

Tablndex 

Tcxtl 

555 (approximatcly) 

Text Blank 

Width 2775 (approximatclyJ 

8. Double·click the command button too! inlht.: T1udhi1\. 

Add a COilllllillld hutlnn ltl tiH~ ronn. 
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' 

·.;." 

'i. Sl't tire following properlies lo creale an Add button. 

(';¡pi ion 

Nan1~· 

Add 

Commandl 

l>cl:nrlt Truc 

lkl~lll 

\Vidlh 

)).) (approxirnatcly) 

1215 (approxirnately) 

111. l>otd•le-click thc cornrnand bullan lool in the Toolbox. 

J\dd a scconú t.:ommand button to the form: 

11. Set tire following properlies lo create a Rernove bullan. 

Caplion 

Nallll' 

1 ki~lil 

\\'ullll 

Remove 

Cornrnand2 

555 (approxirnalcly) 

121) (approxirnalciy) 

No\\' tlrat you ha ve crcntcd lhe interface, you need lo add lhe codc lo make il 
1"111\l"llllll. 

12. In the Pr~jccl \vindow. choose the View Code button. 

r-.·lah· su re that thc Form is sclccted. 

1 :l. irr tire Objcctiist box, selcct Form. 

i-1. irr tite l'roccdurc lisl box, sclcct Load. 

i\dtl tire initialization code thallonds lhe narnes in lo lhe lisl box whcn the form 
is loadcd al run time. 

1· i :! the 1 i st box at run t._ime 

•.•. -' i ./,drllt.r!lll "/.'lorton, Joan" 

· .l•.cldlt••rn "\oJhile, Don" 

l.• : _t,cJdi!J:m "11arshall. Lynn" 

,_,-r 1 r,ddllenr "Pfeiffer. Terry" 

1 S. In thv Ubjcct list box, selcct Command 1 and locatc the Click event procedurc 
in !he proccdurc list box. 

lh. /\dd thc following codc: 

¡,¡_._! i .Addltcm Textl.Text 

Tlris ende t¡¡kcs whalever is in thc Texl properly of lhe texl box and adds ilto 
tire list box. 

17. i'rorrr the Run rncnu, choose Start. 

Rtrn your applic<Hion. 

i X. Type_ Harwood, Gene in the texl box. 

Typc Gene H¡¡rwood's name in the lexl box and press ENTER or click Add. His 
n¡rrrre should be added lo lhe lisl box but nol deleled from lhe lext box. 

1 'J. l'rorrr the Run menu, choose En d . 

. Jn·onln lo clcar tiH.~ tcxt hox, you nccLito add a sccomJ linc In thc Click cvcnt 
· · . pre~n·tlurc hcrc. 

• 
•• 

.. 
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20. Add the following eode to Command I_Ciick: 

Textl.Text ·= ·~ 

This takes care of thc simple adUition of itcms tu t1 li . ..;t ho.x. 

21. From the Run menu, ehoose Start. 

Try adding Gene Harwood's name·one more timl..'. 11 should work ju:-;t fine.:. htn 
wh.at about removing it0 

22. From the Run menu. ehoose End . 

Removing ilems from a lis! box is fairly straighti111Ward . 

23. In the Objeellist box, selccl Command2_Ciick . 

24. Add !he following ende: 

f,i sll. Removr-:1 Lcm l.i st 1 .J.i :-;1. 1 THh:x 

This codc rcrnovcs.thc ítem indict~tcd hy the v:lltH' of 1 :istl.l.istlndex. Thc 
n.cmovcllcm mcthml fCIIIOVCS itcii\S lllil' al alillH' With ~ln;dl lists. this ini~hl 
be suitable. With largcr Jists, you would use thc t 'h-ar n{L·tiHlll. . 

The above code will cause an error if no list itcn1 i .... sckctL'd. You can avoid 
lhis by modifying thc ende as follows: 

1( Listl.Listindex = -1 'I'Iwn 

El se 

msg$ = ·Ple~se Seh:cL <l Consllll."''' ·· 
MsgBox msg$, 64, ~List Selectiron" 

Listl.Removeitem Listl.Listindex 

End If 

25. From !he Run mcnu, choosc St;ll"l. 

Add and delete a couple of na mesto scc that thc l·~•dL" works . 

26. From the Run menu, ehoose End . 

Close the applieation. 

How about sorting this Jist? Don't you llave to udd ;1 lot of cm.lc to sort thc 
items in the list? No, you don't! You simply sct thL· Sortcd property to Trul' 
for Listl, and all items insertcd in the lis! will be sorteJ autornatically. 

27. Close !he Codc window. 

2X. From thc Propcrtics li:-;t box, sclcct Sul"ll'd lor tlh· 11 .... 1 hu.\. 

Cliek !he Lisll lis! box on !he form. 

Se! the Sorteo propcrty lo Truc. 

29. From !he Run menu, ehoosc Starl. 

Note that thc namcs in thc listare now sortct.l. Add ;111d lk·lt·tc a couple 111" 

names to see that the sortcd order of thc list is nwintaincd. 

30. From the Run· menu, ehoosc End. 

Close the applieation. 

:11. Savc ynur fnrm·and .MAK riks with otp¡nupri;lll' nan11'" in 
. \WALKTHRU\SAMPI.ES. Youcan tn·cLwdtt· tlw fih· if 11 ;Liwady l'\Í~Is. 

···------------------~---~ 
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Walk Through-Combo and List Box Differences 
L. To adtl t.·utrics lo combo and list boxcs 

l. ~'~'"" lhc Walk Throughs program group, start Combos. 

'"'~ Ty¡•e Frcd in thc drop·down combo box. 

Ir you prcss thc ¡)owN ARROW kcy, thc Jist ofnames is displaycd. 

3. l'll'SS t:NTEK. 

Thl' n;tlnc Frcu is added to thc list. lf you add severa! more names. a vertical 
scrnll har is al so added to the list. 

4. Typl' Natasha in the simple combo box. 

). Prn.~ ENTEK. 

TIH' ncw na me will be added to this list. Notice hcre that the scroll bar is also 
oultll·d. 

(}, Scll'ct thc namc Larry in the drop-down list box. 

Thi.s na me appcars in the box at the top of the list, but users cannot add items 
to thc list dircctly. 

7. Fron1 thc Control menu choose Clase. 

Clnsc the application. 

~ ,. ,. ,. ,. ., ,. 
' ., ., 

f/1 
.f/1'¡ 
~ 
~ 
~ 
(!, 

_JI 
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Events 

Combo Boxes and Their Comrñon Properties 
Property 

N ame 

Style 

Text 

Heíght 

Text 

Default 

Combol 

O- Dropdown Combo 

Combol 

300 

Cnm_urt·nt .... 
------~ 

tJ...,c e hu;,~ ;¡ pn.:fi :-.. 

1 - Simpk 1 .'n111ht1 

2- Drop-thtwn List 

Simple L'' •tuhcJ--Ilu: hciglu displaycd 
hnth ¡¡¡ tll'sigu time ami runtinu .. ·. 

J>rop-tluwu · Sct hcight prnpcl'l y ;ti 
tlcsigu tillll' tor· nw lime). hut fulllici!!hl 
will not h~..· tli.•·.pl:rycd untiltln: u~cr 
drops dt1wn thc list al run time. 

This is llw dt'(aul! p1npc11y fnr thl' 
l'tllllrlll. 

SyntaA ( 'urul1ul = ''No.~t~sJ¡;¡'' 

Change A Change event indicares that thc contcnls of ;¡ ccllllrol h;.ive changcd. In;, 
combo box, a Changc cvcnt occurs wlJcncvcr you cdit till' tcxt hox p011ion of tlll' 
combo box or when you assign a new valuc to thc Tc>.t pmpcrty from cm.lc. 

Drop-Down and Simple Combo Boxes 
Drop-down combo boxes are an alternative to opti{Jil lnnlons within framc.s: t!J;¡¡ 

is, they are designcd to display a limitcd numhcr of h,~¡l·;dly ;1rr;mgcJ choico 
from which the user may select one. A chissic cx;.unpk of a drop·down cornhP 
box is found in thc Windows Control Panel. FromlllL' Sl·llin¡;.s menu. lllL' user c;111 
choose Ports and then set the baud rate for tllc nmdelll tll ;1ny onl! of cight possihk 
val u es, or type a val u e into the text box ponitlll of thc l'! Jlllnll. Thc ncw valuc 
typed can then be added to thc list. The Urop-duwn í..'llJIIhn hox cnablcs <~ 

scrollable Jist that allows the user to review more choin·s th:m can"be casi/y 
presented on screen. Thc user's choice is displaycd in liJt' lop ho.~ . 

Drop-Down Lis! Combo Boxes 
Drop-Uown list combo hoxcs o1rc usl'd ro prl'senr u.'\l'f."> wirh <~ lin1ited 1111111hn ,.¡ 
choiccs. from which thcy may sclccl only c111e . 

Key Feature 
Both drop-down combo nnd drop-down list combo ho.\t'S displ;1y daw from whicll 
the user may select only one choice. But with a Urop-dH\\'11 lisr users can unly 
select from the list; they cannot add to it. 

.....¡¡., .... ~------~----------
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. Scroll Bars 

Events 

Scroll Bars and Their Common Properties 
Scroll hars are most cnmmonly u sed to enable quickly moving across a long list 
of iterll>. >uch '"a long list of filenames. They can also be used for indicating the 
curren! position on <J .scale, such as shades of coloring for customizing the look 
and I"Ll'l of thc scrccn. Or. scroll bars might be used to indicate the vol u me of an 
;¡udio sys1e111. 

l\.-lin 

S111all< 'ltange 

Vahll' 

Dcfault 

1 ( 1-32.7(,7) 

32,767 

() 

I!Scroll t 

-or

Vscrolll 

1 (1-32,767) 

11 

Comments 

Amounl of chnnge when user clicks scroll 
bar shaft. 

Maximum value of scroll bar handlc in 
bottom most position. 

Mínimum value of scroll bar handle in 
topmost position. 

·N ame used in code. 

Use hsb as a prefix. 

N<~me uscJ in coJe. 

Use vsb as a prelix. 

Amount of change when user clicks a scroll 
arrow. 

This is thc dcfauh property for this control. 
Can be set by user's direct interaction with 
the control or through code in response. to 
other events. 

Chnnge 1 lc'l'ttrs wlrctl tite conlenls of tite control ita ve citangetl. 

• 
• 

\ • 
41 

• 
• 
41 

.. 
41 

.. 
o 

o 

o 

.. 

.. 
G 

4 

4 

4 

4 

4 

4 

• 
• 
• 
• 
• 
• 
Cl! 

Cl 

o 

o 

.. 
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Walk Through-Scroll Bars, Properties, and the Change 
Event 

. L To scc scroll bars, propcrtics, and !he Clwn¡;c cnlll 

l. From the Walk Throughs program group, s1art Scrull l!ars. 

You will see a form with a venical scroll h¡¡r on il. 

133 

The purpose of this application is to dcmonstratc tlll' hchavior of a scroll har 
and the effects of the properties LargeCiwnge '"'" SlllaiiChange on rhe Vahl<' 
property . 

2. Click the arrows on both cnús of thc scroll bar. 

Note the change in the Valuc propcrty. 

3. Click on the shaft of thc scroll bar both ah11vc ;md lwlow lile scroll hnx. 

Note the change in the Value property. 

4. Close thc application. 

5. Start Visual Basic. 

6. From the File menu, choose Ncw Project. 

Stan a new project. 

7. Set the following form propcrtics in the Propertic., window: 

Height 

Width 

4425 (approximatcly) 

5430 (approximarcly¡. 

8. Double-click _the vertical scroll bar IOol in rhc Tuulhus. 

Add a vertical scroll bar and cbangc somc of its propl'nks: 

Height 

LargeChange 

Max 

SrnaliChangc 

Wiúth 

3495 (approximately) 

20 

100 

JO 

.175 (i!pprnxinwtely) 

lJ. In thc Projcct window, choost: thc Vic\\' Cntlc htlll4111 

Makc surc th;ll Forml has hL'l'll Sl'kcr~.·~J. 

10. In the Object list box, sclecr VScroii_Chaoge. 

Locatc thc Ch<mgc cvcnt proccJurc for thl' verti~.·;d '>~THII h;¡r. 

JI. Add the following code: 

Print "VScrolll.Value = ~; VScrolll.Value 

Display the Value property each time ir changc.,. 

12. From the Run menu, choosc Starr. 

Testthe application you ha ve wrirtcn. 
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:-._ 

1.~. h'n111 thc Rlln mcnu, choose End. 

('h'"l' thc application. 

1·-L ()uit Visual Basic. 

L'. S;1w your forlll ;md .MAK files wilh appropriate names in 
\WAI.KTHRU\SAMPLES. 
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Timers 

~ Form1 ~ lila 

Timers and Their Common Properties 
Timers are uSed to run events ata spccific time or witllin an intcrvalthat you 
specify. Forexample, within a scheduling application. ti111crs wouiJ be uscd 111 

enable alarms for the user. 

A special characteristic of this control is thut it is nen:r visihil· ;Jt run timL'. 

Property 

Enabled 

Interval 

N;unc 

Default 

Truc 

o 

Timcrl 

Comments 

This is thc dc1aull p1upcny for lhÍ\ 
t.:ontrnl. 

Syntax·· Tinwrl = Ennhlcd 

CountJuwn intcrval for thc tim~.:r. 
lllt'a\tlll'd 111 LIIÍIIÍ\l'\'lliHis . 

....... -----------------------
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Walk Through--Clock Application and the Timer Control 
L To USl' tht.· timcr c01ltrol 

l. hom lhe Walk Throughs program group, start Clock (Timer). 

Wht·n you starl thc application. you will scc a form containing a digital clock 
displaying thc date and time. Thc clock will be updatcd e.vcry sccom.l. 

ThL' purposc uf this appliC<Ilion is tu Ucmonstrate the bchavior and use ur a 
tinlL'I L·imtrol. 

1 )o11hll'-click t he Contml mcnu. 

ClosL' thc walk through. 

3. St;nt Visual Basic. 

~- Fnunthc File ntcnu. choose New Project. 

Stilrl <.1 IICW pro_icct. 

.-... SL't thc propcnics for thc formas follows: 

llackColor Ycllow 

HonkrStylc ~- Fixcd Doublc Also removcs Min/Max buttons 

Ca¡Hitlll 

lkighl 

Ni!IIIC 

Widlh 

Clock 

22:15 (approximalely) 

frmCiock 

4:145 (approximately) 

h. IJuuhlc-click thc labeltool in the Toolbox. 

Add a labcllolhc form. 

7. Sc1 lhc propcnic., for the label as follows: 

·1\li!-!lllttL'Ill ~- Ccntcr 

Hadd ·,dor 1\l:ll 

¡:urcCnlor \\'hite 

1 k1~l11 1:140 (approximalcly) 

l.r 11 

T~~p 

\\'idllt 

1211 

lhl Date Time 

~211 

..to 1 :'i (approxilllatcly) 

K. IJuuhlc-click thc timer tool in thc Toolbox. 

1J. Se! thc fol\owing propcrtics: 

N it nlL' tmrTimerl 

lntl·n·al 1111111 

l'littT a tintcr onthc fonu. Sct thc propcrth;s J'ur il. You can place it anywhcrc. 
· · Hchiml the lahcl will be fine, because timers are not displayed on screen at run 

lillll' 

4) .,. 
.. .. 
• .. _, .. .. _, 
OJII .. _, 
_, 
_, 
f!' • 

------- ------------------.::10 
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10. In the Project window, choosc thc Vicw Cmic \nndll\\', 

Make sure that frmCiock has lhc focus . 

11. In the Object and Proccdurc list boxcs, locatc tlw lllliTÍtlll'rl';'"""Timcr. 

Locate the Timer evcnl in thc codc . 

12. Add the following code: 

.. lblDateTime .Caption = Format$ (Now, "uuunun rl, ; , ,..,. ¡,: nw: ~-;:; ;uu/¡,n•" ¡ 

AJJ the code on ihe blank line in thc Clid cvcllll<''"P'"'''· 

13. Double-click the Control menu. 

Close the Code window. 

14. From the Run menu, choose S tan. 

Test the clock application that you havejust creat<'tl. 

15. From the Run mcnu, chnnsc End. 

Clase the clock. 

16. Quit Visual Basic. 

17 .. S ave your form and .MAK files with appropriatc n;unc:-. in 
IWALKTHRU\SAMPLES. 

Using¡a Timer to lnitiate a Task ata Specific lnterval 
You.can use.the timer to initiate a task after a spccific interv;d. lnthc followin!:! 
exampic, the timcr evcnt starts a backup procedurc .. Thv litncr l'\'L'rH occurs alkr ;~t 
lcast 60 second~ ha ve clapscd. You coullJ place cotk in tlll' Titncr L'VCnt to ch-:c~ tll,
current time and s(art the backup routinc only :•1 ccn;.inll~llL'.'-. 

1 Sub Form_Load () 

2 Rem Timer will go off after 60 seconds. 

3 tirnerl.Interval = 60000 

4 timerl.Enabled = True 
S End Sub 

6 

7 

8 

Sub Timerl_timer {) 
x = Shell("c:\mybackup.bal"'J 

End Sub 

~----- ---
.~;::: : .. -.... ~ -~·-·. -.. -- .... ~ ·~· 
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Lab Time 

fio lo lhl' Adding Conlrols lo Forms porlion of your lab manual. 
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L. File Browsing 

• Scenario 

.• Properties and Events for File Browser Controls 

• The Common Dialog Control 
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Scenario 

~ · Open 

File ~ame: ºirectories: 
•.txt c:\windows 

3270.1xt r+; E) e:\ & 
byle.txl 
nelworks.txt E)windows 

printers.txt CJ system 
readme.txt 
sysini.lxt 

~ sysini2.txt l .. : 

Lis! Files ol T ype: Orives: 
1 Texl Files (".TXT) /f±11 /r -1 e: llt'l 
''''•"'"'""'"'·-~-,. .... _.,..,__,..,..,,_-. 

File Browsers 
A quid review of the workings of the file browser in Notepad shows that a number 
of events occur when the u ser selects a different drive or directory. lf the u ser 
.,clcct.s a new drive. the directories and files list boxes are automatically updated, 
,l,.,win~ the curren! working directory for the system and any files (ofthe file type 
'pecili,·d inthe List Files OfTypc list box) .. 

~l 

•• . . 

• 
• 
4! 
~ 

4! 

4! 

4! 

4! 

f 

f 

• 
• . ~. ~ 
4 
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Style Guidelines 

Walk Through-How File Browsers Work 
L To use lile browsers 

l. In the Accessories ilroup window, open Notepad. 

AJI of you ha ve used a file browser of onc. sort or :Ult 11hcr. hui you may nol ha ve 
.looked closely at how it works. 

2. Fron:t the File menu, choose Open. 

Orives list box The Drives lisr box is :1 spccial fom1 of drop-tfown lisl hox. Thc 
user can see options presentcd in the lis¡ hui cannul ;1dd ilt:IIJS lo ir. 

The more important element to notice at this poi ni. lluwcvcr. is thut whcn 1hc 
u~er sclects a ncw drivc,thc changc in sclerlion ¡_, rcfh·cied inlhc dircclory and 
file list boxes as wcll as in thc current working dirct'lory. 

Directories lis! box The Direcrories lisr hox is a spc,·ial fonn of lisr hox. Ir 
behaves Jike a regular list box but displays only dirl't'loric:-. ;uuJ subdin.·clorics. 
Users cannot add items to or delete·items fn1111 tht• lis1. 

File Name combo box The File N ame combo bm. ¡, ;¡ spL"cia/ form of tllc Ji..;¡ 
box that send.s and reccivcs mcssagcs fmm tllcxt /l,~_,_ Tllc tcxt box <.JI/owS uscr~ 

. to add items to tbe list, somcthing that cannot be Uonc with a /ist box. 

List Files ofType Combo Box Noticc thtlt this. !tul. i .... ;1 drop-downlbt ho>... 
Users can select items from it, but thcy cunnnl add ill'llls lo it themsc/vcs . 

. .... Curren! working directory Finally, nolicc rharrhcr\· i.s ;r lahl'l rilar rells rile u.scr 
lhe current drive and direclory. 

3: Choose Cancel, and clase Notepad. 

End walk through. 

Typically, file browsers can be set 10 display rrnly a givcrr ly¡ll' of file in lile 
specilied drive and directory. Bccause Nolepar.J is dcsigrrcd rrr rcaJ files lila! '""·e 
!he .TXT extension, .TXT is thc default file rypc anr.J * * is rile sccond choice. 

Bcc:.1usc thc Employcc Databas~..: application is dcsigncd lo loc;n~..· .HMP ;wd .\\'f\·11: 

files, they will be the defaull file rypes. 

:.1 
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Properties and Events for File Browser Controls 

- bample 

~ Form1 1§~ 

oc:\ 

l:t:l 11 1 e 
., 
:í 

*R *OW e umaxtm .. J 

. . . . .Orive, Oirectory, and File List Boxes 
AIIIIHcc nf thcsc conlrols are spccial fornis of list boxes. They ha ve many of the 
~ame charactcristics, but thcrc are also a number of special propcrties that they use 
1t1 cnahlc navigating through ;;¡file system. 

Orive List Boxes and Their Common Properties · 
The l"ir:-;~ nf thcsc comrols is thc drive list box. ll is a special form of the drop-down 
lisl ho.x. lnilially il only shows the current drive for the form. However. ifthe user 
dicks llic drop-down arrow, lhc conlrol will display all of lhc olhcr drivcs currcnlly 
availahle tlll thc systcm. · 

l'rupt'lii.r IJcfaull 

Nann: Drivcl 

1 lrive 

Synchronizing the Orive Property 
::11¡, 1 ,, i ·-···l_.Ch;trrq•' 1 l 

Commcnts 

N ame uscU in code. 

Use drv as a pretix. 

Accessible only ut run time, this property 
returns the selected drive. This is the default 
property for this control. 

·~¡¡, .. ,, <Ir iv<• is <'hiHHJt~d. lt~Scl Lile Uirectory lisl box p<rth 

!Jir 1 .Path = Urivel.Drive 

l·:nrl :~ • 11 , 
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Directory List Boxes and Their Common Properties 
Property Ddault 

N ame Dirl 

Path 

Synchronizing the Path Property 
Sub Dirl_Change () 

Cummcnls 

Nmnc used inL·ntlc. 

Use dir as <1 p•t·lü •. 

... A~.:~.:cssihk only 011 run timt:o this propcrty 
rcturns the <th.,!Jiult.: path for thc sclcctcli 
Liirccwry. Thi ... ¡_., thc dd'ault propc11y for thi~ 
control. 

' When directory is changed, reset the filE2 l i.st. br•x ~ath 

Filel.Patb = Dirl.Path 
End Sub 

File List Boxes and Their Common Properties 
Property 

Archive 

N ame 

FileName 

Hiddcn 

List 

ListCount 

Listlndcx 

Normnl 

Pmh 

Pattem 

ReadOnly 

System 

Default 

Truc 

File! 

Fnlsc 

Truc 

• • 
True 

Falsc 

Accessing !he FileName Properly 
Sub Filel_DblClick () 

Labe~l_.Caption 

End Sub 

Filel.FileNa.me 
f 

Cnmmcnts 

Displays all file .... with archive bit on. 

N ame uscd inl'odc. 

Use lilas a pt'L·i"iA. 

Scts nr rcturn.' thl' sckvtcd file from !he li~• 
(XIrlion of ¡¡ fill' li:-.1 ho.\. Act:cssihh: only at 

nmtimc. Thi:-. •~ the d\'1\ndt propcrty for thi .... 
Ctii\IIOI. 

Does not displ;1y hiddcn files. 

Acccssihk onl_\' ;11 rtlrr tirnc: rciUrn . ..; th~.: ÍIL'Ill.\ 

containcJ in a 11.,1 hn.\. 

Acu:ssiblc lUrly al nrnlimr.::.rciUrns lhc lntal 
numbcr of itcnrs in thL' lisl box. 

Acccssihlc Drdy al n1r1 lime: rcwrns lhc indl'.\ 
of !he l:llfiCIItly .\l'lcL"IL'd itcm. 

DispJ;¡ys all fd~·-' wi1h ;ul·llivc hit .\l'l 1111. 

An.:c.ssihh: onl\ ~•1 run 1ir1rl'. 

Display a JI rik.'> . 
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Click l'ur "11 lince or the basic controls, a Click event indicates that the user has 
nwtlc a sclection. Th:H is, the user is selecting or.changing drives, directories, 
suhúirl'ctorics, ur rilcnamcs. 

Double·click The only time that a double click is routinely used in a file browser is 
whcn the user uses thc File Name combo box .. In this case, the double click 

.. inuicatl's th"t thc.uscr has located a specific file of interest and wants the 
applicatíonth"t uses the file browser to actually open that file. 

Change The real workhorses of a file browser are the Change events. Code that 
)'tiU <Hitlttl thc cvcnt procedurc template keeps the three controls synchronized 
whcncvcr the uscr sclccls a new itcm in one of the list boxes. 

PathChange This cvenl occurs when the selected path has been changed by setting 
thc FilcNamc or Path propcrty from code. 

PallernChange This event occurs when the pattern has been changed by seuing the 
¡:jJcNaHil" or Pallcrn propcrty from codc. 
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L. Change Events 

• Change Event 

• PathChange Event 

..• · 
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The Change ~vent 

Example 

Example 

Dirl_Change () 

auloexec.bat 

autoexec.bak 

command.com 
config.bak 
config.sys 

O discover 
O dos 
O lm.dos 
O lmdos.old 
Owindows 

Changing the Path for Differing List Boxes 

( ) 

Change Events Change events indicate that the contents of a control ha ve changed. 
Changc cvents are associated with a wide variety of controls including combo 
hoxcs. horizontal and vertical scroll bars, labels, and picture boxes. For our 
purposes. this module focuses on thc Changc cvents for dircctory and drive list. 
hnxc:-. only. 

Direclory Lis! Box Thc Chango cvcnt is invukcd whcn thc user clicks a ncw 
dircclmy or whcn thc Path propeny is ~hanged frorh the code. 1t indicates that ~he 
contl'nts of lhc control ha ve bccn changcd. 

S11b Dirl_Change {) 

Wl1~n direclory is changed, reset the file path 

FilE>l.Path:: Dirl.Path 

F.nd S•ll• 

Orive Lisl Box Thc Changc evcnt is invoked when the user selccts a new drive or 
whcn tllc Orive property is changed from the code. lt rescts the path for the 
dircctory list box. 

:·•¡!J Drivel_Change () 

· ~lh··n drive is changed, reset the directory·s path 

IJi' 1 f';lth = Dt ivel.Drive 
1-:r rtl ~~fd · 
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Walk Through-Drawing and Coding a File Browser 
L To draw and code the lile browscr 

l. From the Walk Throughs program group, slán Browser. 

When this application stans, you will see a simpiil'ied ll>rm of the file browscr 
used in the Employee Database. This form has file. dircctory, and drive ii.'l 
boxes only. · · 

Ciick a new directory and notice the file list is uptlatcd. 

The purpose of the appiication is to dcmonstrate the Path ami Orive propcnics 
and the Change events that are useú lo synchronizc n 1111rnl ..... 

2. Clase Browscr. 

3. Start Visual Basic. 

4. From the File, choose Ncw Projcct. 

5. For Form J, set the following propertics in thc Propcrtil's windnw; 

Height 

Width 

3930 (approximatciy) 

4290 (approximatcly) 

6. Double-click the file list box tool in thc TIH>Ihox. 

7. Set the following propcnies: 

Height 2760 (approximately) 

Width 1455 (approximatcly) 

8. Double-click the directory list box tool in thc Toolhox. 

9. Set the following propenies: 

Height 2 f 75 (approxinwcly) 

Width .1455 (approximately) 

10. Double-click the drive list box tool in thc Toolbox. 

1 1. Set the following propcnics: 

Width 1455 (approximatcly) 

The first step of ímplcmenting a file browscr is tn add thc Change event ende 
lhal synchronizes changes in the statc of thc drive <~nd dircctory list boxcs. Todo . 
th is, yo u need to: 

12. Double-click lhe drive list box. 

This úisplnys !he Cndc window wilh 111~· 1 hivc 1 l '!l;ut¡._•t' n·~·u¡ prm·t·thuc in il 

13. Ad<l thc following ende: 

Dirl.Path = Dcivel.Drivc 

This code resets the Path propcrty of tite dircctory ii't 1)\)x 111 that uf thc Drivc 
property of the drive Jist box. · 

Now the directory list box wili he kcpt nttll'tll witlt ··h""~''' in tite driv1· list ¡,,., 
llutwhat about thc file list hox? 

14. Fmm thc Objcct list, sclcct Diri. 

The Code window wilh lhe Diri_Ciwngc cvcm tclllplatc is displaycd. 

1 

1 

\ \ . . 
' 

í 1 
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1 ). Add !he following code: 

l·"il•·_l.l'ath = Oirl.Path 

1 fl. Clid Form 1 lo display lhe interface. 

Thc code added abo ve resels the Path propeny of the lile lisl box lo thal of the 
. Pa1h properly of the directory list box. 

Thc chmaclcrislics of the Path propeny of a directory lis! box vary depending on 
whclhcr lhe uscr's curren! working directory is the root dircc10ry. 

lf !he u ser selccis the roo! directory, the path will be "\"-that is, a path (in this 
case the root), which is n bnckslash. lf the user selects any other directory, the 
path will end in thc curren! working din¡ctory, with no backslash atlhe end. 

This is imponant whcn a program needs to build a fully qualified filename. The 
codc must check to see if a backslash must be added to the current value of the 
Path _pmpc11y bcforc concatenating it toa filename. 

Thc codc to handlc this rcquires a knowledge of conditional processing. To see 
how this is don~.:. inspcct the cmd OK_click procedure in the AddPhoto.FRM 
codc in \SOLUTION\PR!NT!NG. 

17. Pron1 the Run mcnu, choose Start. 

Test to see if your code works. 

1 X. hoin thc File menu, choose Save As. 

IY. Savc the file as BROWSER.FRM in IWALKTHRU\BROWSER. 

:'11. Sal'<' !he projcct as BROWSER.MAK. in \WALKTHRU\BROWSER. 
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Filel_PathChange () ~ 

() 

e7wlndowa 
Qsystem 

Path: c:\windows 

PathChange 
The eyeot.occurs when the selected path changcs by selling cither the FileNamc or 
Path propeny from code. 

These two examples are from Visual Basic Help. 

Sub·Dirl_Change {) 

Filel.Path = Dirl.Path 
End Sub 

'Pil thChilnge Ev1•n l Exmu¡J 1 ~~ 

Sub rilel_PathChange () 

Labell.Caption = -Palh: "+ Dirl.i'fll./1 ~ 

End Sub 

Notice in this example that tbc ParhCh:mgc cvcnt i~ g~.:¡ll'l;Hcd hy coc.Jc in;¡ Changl' 
cvem in the directory list box control to synchronizc tht.: v;duc of !he File I.Ptllh 
propeny to the new value for Dir I.Palh. 

For funher examples using the PathChangc cvcnl, sce tlll· lúllow1ng. 

Application Form Pruccdurc 

IconWorks VIEWICON.FRM l;ilc_/:ikl.i~l_/ 1ai/1Changt: 

: ¡ 
1 
'j 

. 
. ! ,:: 

':! 

:í 

:. 
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The Common Dialog Control 

Examp\e 

·2-:· Save As 

File Neme: ' º-ireclories: IW~óK~I 
c:\vb 

/ll{é~l 
¡!!. 

O !l.ead O nly 

1:¡-

S ave File as .!J'pe: Orives: 

lil 1 ¡¡;;;¡ e: 1@ 

The Common Dialog Control 
The common dialog control is a versati\e too\ provided as a standard pan of the 
Profcssiona\ Editiun of Visual Basic. The most common use for it is as a file 
hrowscr. but as you wi\1 see, it has many other possible uses. 

::qb rnrHrFileOpen_Click () 

CMIJi;ti<)gl.AcLion: 2 

l·:nd ~.; .. ¡, 

llc\ow is " list of thc Action property settings and their associated dia\og box type. 

AL'tiun sdting TypC of dialog box 

11 No<:~ction 

File open di<:~log b~x 

2 File savc di<:~log box 

\ Color dialog box 

Choosc font dia\og box 

·' Prinlcr (.]i;.llog box. 

¡, lnvoke WINHELP.EXE 
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2, More Controls / 

• Grid Control 

• 3·0 Panel Controls and Group Push Button 

This final ponion of thc module dcals, bricfly, wilh cach of lhc rcmaining too!~ in 
the Toolbox. 
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Using the Grid Control to Display Output 

123 

456 

Sam X. 863 

Gridl. Col = f 
Gridl. Row =1 

Gr idl . Text = "N ame" 

Thc Grid co·nlrnl allows you 10 display oulpul on a grid. 

Thc Cols and Rows properties sellhe lotal number of columns and rows you want 
in thc grid. Thcsc properties are available at design lime oral run time. 

The Col and Row properties set or return the current cell in the· grid. These 
propcrlies are available at run time only. The Text property sets or returns the text 
in thc cmrent ccll. 

···11, ··¡wlh•ldText_Cl id: () 

·::•<~. the current cell; remember that the first row and 
·,·.,] i'lre O 

Gridl.Col· • 1 

Gridl.Row • 1 

Gridl.Te'xt • •Name" 

)·;¡¡¡] .':•Ji) 

·¡·11c <. '1 ip ¡m)pcrty scts or rcturns thc colllcnts of thc gritl's sclcctccJ rcgion- for 
cxamplc: 

r;ridl .Clip = "ABC" 

You can include tubs and carriage returns in the string expression to indicate new 
colun1ns anO ncw rows, respectively. 

'· 
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The following example places text in a two-hy-two ran~e of ce lis. 

1 Sub cmdClipText_Click () 

2 Gridl.SelStartCol 
3 Gridl.SelEndCol = 2 

4 Gridl.SelStartRow 2 

S Gridl.SelEndRow 3 

6 tbS = Chr$(9) 'Tab eh u r .. - -¡ '"r 
7 crS = ChrStl3J 'Carriity•· : >- T ,IJ r 11 

8 dS = •Joe J" + tbS + •12) .. + crs . • 51:~: 1•'' . • i·S . • 4 56 .. 

9 Oridl.Clip . d$ 
lO End Sub 

The grid control is used to display output. Howcvcr, yu11 can simulatc input on a 
grid with code. The following example updates a grid c:cll whcn the user types into a 
text box: 

Sub Textl_Change () 
Gridl.Text = Textl.Text 

End Sub 

Sorne of the key propcrtics that you willnced in 11rt.kr ltt IISL' tl1í.-. Clllltn•l are"·" 
fo!lows. 

Property 

CoiAiignment 

Cols, Rows 

CoiWidth 

FixedCols, 
FixedRows 

GricJLines 

Picturc 

Derault 

O- I..efl Justify 

- 1 · Truc 

Cc1mmcnts 

Sets or return~ lhl' ••li!-!BIIIent of data in a 
column 

Scts or rcturn:-. tllt' IOt;d numbcr or ni\\'~ nr 
columns in thl' grid 

Scts or rcturn~ lhc width (in twipsl of a 
specilicd cnlwnn 

Scts or rcturn~ tl1L' totalnumbcr of fixt.:d 
columns or 1'11\\'~ for a ~rid 

Ddt.:rmint.:s wlictln:r linl' ..... hl!twccn ccll ..... arl· 
displayctl 

Scts or rcturn ..... ;¡ !!l'aphil· for lhc c.urrcnl cl.'ll 

~~~-------- .. ---·-
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3·0 Panel 

¡,~, "'"~----- ---~-- -- .. - ------

This control has a numbcr of possible uses. Jt has, however, two primary uses-the 
first is to providc greater thrce-dimensional (3-D) quality lo another control or · 
group <rl' controls. For example, you can place other controls on the panel; it can be 
uscd in place of a frame. You mighl also use this control as a background for the 
cntirc form. Thc thrce-dimensional panel, because il has FloodPercent and 
1-'loodType propcrties, can be used as a status or progress indicator. 

St Hlll' 11f thc kcy pn)pcnies that you will necd in arder to use this control are. 

l'rupt·rt~-

1\lignllll'lll 

lkvdlnllL'r 

lkvd( Jukr 

lkvl'IWidth 

j.'J¡ultJI\'Il'Cill 

Floodlypc 

Dcfaull 

O- Lcft JustillcJ Top 

O- Nunc 

2 - Raiscd 

O· None 

Commcnts 

Caption alignmcnt for this éontrol oiTcrs ninc 
possiblc dmiccs. 

Sets thc style of the inncr bcvel of the panel: 
none. inset. or raiscd. 

Scts the style of thc outer bevcl of the panel 

Scts or rcturns thc width of both thc outc'r muJ 
inncr bcvcls of thc panel. 

Scts or returns the color used to paint the arca 
inside the panel's inner bevel when used as a 
status indicator. 

Scts or retums the percentage of the paintcd 
arcu insidc thc inncr bcvcl whcn uscd as a 
sw.tus indicator. 

Determines whether and how the panel1is 
uscd as a status indit.:utor. 

-··-.... 
;.,) 
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Walk Through-Creating a Percent Meter 
L To sct thc Pcrccnt Meter at work 

l. From the Walk Through program group. chtJtJSC p~,.,·,·nt Ml'tcr. 

The purpose of this walk through is lo demonstratc thc status reporting · 
capability of the three-dimensional panel controL 

2. On the Percent Meter application, choosc Swrt. 

163 

In a 'few seconds !he panel will progressivcly change ""'"'· inJicating ¡dong the 
way the percentage completion of the proce" . 

3. Open the Control menu on the Percen1 Meter application. anU choose Clo:-;c . 

L To create the Percent Meter application 

l. Start Visual Basic. 

2. From !he File menu, choosc Ncw Project. 

3. Sct the propertics for thc formas follows. 

Property 

Caption 

Height 

MaxBullon 

... Minllutton 

Width 

Sctting 

Pcn.:cnl Meter 

4425 (apprnxin_latdy) 

Falsc 

F;1lsc 

25.15 (apprP.\ÍI11;11L'IyJ 

4. From !he toolbar, doublc-click thc 3-D PancltotJI and set its propctties '" 
follows. · 

l,rnpcrly Sdlin¡.: 
... --··-

Ucvcllnncr 1 - lnst.:l 

lJeve!Outer 2- Rai:-;cJ 

BeveiWidth 3 

BurderWidth 2 

Caption 

FloodColor · Ydlow 

Flooófype 4 - BoHom lo Top 

Height 2655 (approximatcly) 

Left 240 (approxirnatcly) 

Outline TrúC 

Top 240 (apprm.inlaiL'Iy) 

Width 1935 
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). !'mm the toolbar, double-click the Command button and set its properties as 
ft1lh•ws. 

l'rupcrly Sclling 

Caplillll Start 

Fn11L~it.C 13.5 

lki~hl 495 (approximately) 
¡_....¡, 480 (approximately) 

Tl~l 3240 (approximately) 

h. Douhle-click the Command button in design mode in order to open the Code 
window. 

Visual Basic displays aCode window with the Commandi_Ciick event 
pn lU..'durc tcmplatc in it. 

7. 1•\;llT the h1\h;wing Jincs llf CllLll! bClWCCI1 thc lWO part~ of thc tcmp\atc: 

l'o~n•· l \•11 . Fl ()ndPercent = O 
l·••r il = 1 Tu 100 

l~nelldl.FloodPercent i\ • 1 
fl•·.~.' i l 

X. Fmmthe Run mcnu, choose Start. 

Test your application. 

lJ. Fn1111 thc Run menu, choosc EnJ. 

\ti. S" ve your form and .MAK lile with appropriate names in 
\W Al.KTHRUISAMPLES. 

\l. ( '\o~t: Visual Basic. 
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Group Push Buttons 

..• · 

Group push buttons work like combination command h1r11ons otnd nption hullons. 
They are like command buttons bccause whcn thc ust.!r did,s thL' hutlon. somcthing 
happens-a file is opened or savcd, or 1ex1 is righ1-jus1iflcu. Gruup push bullo"'. 

· however, are also like option buuons because, with !he pr<~pcnies sel properly. 
selecting one option can automntically rcmove the sclection frurn anothcr option. 

Sorne of the key properties that you will nceu in ordcr 1" use lhis control are'" 
follows. 

Properly Dcrault 

GroupAJiowAJIUp -1 -Truc 

Lit uup1 ~ utrdJL:f 

Outline 

PictureDisabled Non e 

Pit:turcDn Non e 

PictureDnChange o 

PictureUp Nonc 

O~rumcnts 

Dcr~rminc~ whl'rlu:r ;LII hulton~ in a logir;d 
111 •.··· 

SL'L\ 111· rcturn:.. tlu.: ,!!IIHijl numbcr for a ¡;ivl'rr 
group push hultnn. Thi~ propcrty is uscJ lo 
l.:fCíiiC logiral !-!IHliJl:O. uf hUIIOilS. 

Scts or rcturn .... whL'Iht'l 1ht: hulloll has <L 

bcmler iLrtHILHJ Íl. 

Spct:ifics tln: hitnLap to di.'>play on thc 3D 
group push huuon whl'LL it is r.Jisuhlcd. 

Spccifics tllt• hitu1ap lo u.v.: whcnthc hutton 
is dcprcsscd. 

Dctenninc~ how thL' /'•• 1urclJp hitmap JS IP 
he u .... ed ro L"IC;Jtl' tlu.: l'~t·tun.:On bitJuap: 2 
mcrcly invcn .... 1/11.' PiL"ltiLL'Up bitJli;Lp. 

Spe.:ifics thL' hi11nap ll•tL~c whcn thc hullon 
IS u p . 

' . ! 

. i 
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··• -

Walk Through-Creating a Toolbar 
L Tu scc lhe inlerl'ace you will be crealing 

l. Fromlhe Walk Th'roughs program group, choose Toolbar. 

This littlc applicalion doesn't do very much. What it does show is thatthe user 
can sclcct any oral\ of the lirstthree options, whereas they can only select one 
t~lthl· sccond thrcc. More lO thc pnint, it is "" cxamplc of'how you wnukl go 
aht,u\ Llrawing a tnolbar likc lhc one fountl in Microsoft Word for Windows or 
tvlil:rusofl Exccl. 

""~ hu,nthe Controlmcnu on thc Toolbar form, choose Close. 

L Tu cn•atc thc toollJur 

1. < l¡wn Visual Basic. 

, 1-"!tllH thc Fik mcnu, choosc Opcn Project. 

\.oca te TOOL\lAR.MAK. It should be located in\ WALKTHRU\SAMPLES. 
This form airea~ y contains the basic form-TOOLBAR.FRM with al\ of its 
propcrtics airead y sct. In order lo add the toolbar, you need lo complete thc 
folluwing stcps: 

.1. \'lilcc scvcn group push buttons on the toolbar panel atthe top of the form. 

~. Use thc mousc pointer and the control key lo select al\ seven of the group push 
huttons, and thcn sctthe fo\lowing properties for a\1 ofthem. 

l'rct¡H.•rty Setting · 

llcight 420 
' Top 30 

Widtl1 450 

~. i'lill'l' threc of !he push bUltOilS sidc by sidc Oll thc left emJ of thc panel. 

Tlll'se wi\1 hcc<>mc thc tcxt formatting buttons for Bold, ltalic, and Underline. 

. -.-.-.., .. ·-
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6. Select the first button in this group and setthe properties '" follows . 

Property Sctling 

() GroupNumbcr 

PictureUp 

PictureDn 

BLD-UP.BMP located in \VII\BITMAPSITOOLBAiü 

BLD-DWN.BMP 

These changes e reate thc first button on thc 10olh;1r ;llltl ma~l' use of 1 wc, 
separate bitmaps to indicare the status of thr butlon 111 tia.• uscr. 

7. Select the second button in this group ami sct thc prnpl'rtics 01s !"ollows. 

Property 

GroupNumber 

PictureUp 

PictureDn 

SeHing 

o 
ITL-UP.BMP 

ITL-DWN.BMI' 

8. Select the last button in this group and setthc prope11ics ;¡s follnws. 

Property 

GroupNumber 

PictureUp 

PictureDn 

Sctting 

o 
ULIN-UP.BMP 

ULIN-DWN.BMP 

Notice'that all thrce ofthcsc buttons ha ve thc samc nunthcr -0. A group 
number of O means that they are not pé.u1 t)f a logical gn1ur. ;tnU thcrcftm: 
changing the state of one will not change thc statc of uthcrs. Aftcr al l. your uscr 
may want to havc bold and it<.Jiic and 4ntlerlining. CltLsters of controls with any 
othcr group numbcr will act just likc option hutltJJJs only Olll' willlll' in l"orn· · 
at any one time. 

For purposes of contrast, wc will takc a slightly dit"ri:rl'nt appmach on thc scctnltl 
group ofpush buttons. Hcrc you are givin);! thc user thL' oplitlJJ nf fonn~lltin);! ll'.\1 

as either left-, centercd-, or right-justilicd. lnthis c;t.\L', you will want thcsc 
buttons to work as a group bccausc a11y onc bit oJ" tcxt c;ul IJ;¡vc only onc of 
these three states. 

9. Create the second group of buUons si de hy sidc towanlthc 111iddlc of thc panel. 

In alllikclihood, you willnot he ahle lo kcL'p the hLLIIon .... ill¡wrl"cct to¡Htl·hulhHJI 

alignment. Don't Jet that bothcr you. You t.:an sch:ct thL' cntirl' group f.lt thc cnd o!" 
this walk through and setthe Top property fnr all or tlicm in ""e stcp. as you u id 
abo ve. 

JO. Sclectthe first buuon in this group and sclthc propcrtit:s as lúllows. 

Property 

GroupNumbcr 

PictureUp 

PictureDnChangc 

Sctting 

2 

LFr-UP.IJMI' 

2 · lnvcrt PicturdJp UitllLiifl 

Notirc what we llave tforH·Ilae'! \Vl·IJ;¡w ncatl'd llw'·.l'il'ltnl'l )own hiltn;tp l1y 
invcrting thc imagc w;ing the pmpcrly Pictlln.:UpCh;lllfl'. 
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1 l. Scll'ct thc sCconU buuun _in this group anú sctthc prupertics as folluws. 

Gnu1pNumber 

PictmcUp 

JlictureDnChunge 

Sclting 

2 

CNT-UP.BMP 

2- Invert PictureUp Bitmap 

12. Set"ectlhe lhird bullan in lhis group and sellhe proper1ies as follows. 

l'rnpcrly 

Gn1upNumber 

PiclurcUp 

l'ictmeDnChungc 

Setting 

2 

RT-UP.DMP 

2- Invert PictureUp Dilmap 

Wh:ll lhis cxamplc cmphasizes is lhallhc proper1y GroupNumber is your way of 
tl'lling Visu:d llasic how you want individual sets of buttons to be grouped. 

1.1. As a linlc extra challengc, you sellhe propenies for lhe lasJ control.ll's 
sup¡1oscU to rcprcscnt a printcr, so you will need to use the PRT-UP.BMP. 

14. Sa\'l' your work in 1\VALKTHRU\SAMPLES. 

L To Cudc Thc Toolbar 

· '· · .. l"r you wanJIO implcmenllhe loolbar so il funclions properly, you can add 1he 
fnllowing code. 

l. IJouhlc-click lhc bold button lo open lhe code window for GroupPush3DI_Ciick 
cvc111 and add lhc following code: 

ll•lf·l,~.c;sage.FontBold =·Value 

' 1 louhlc-click thc ilalic bullan Jo opcn lhe code window for 
Gn •upl'ush31J2_Ciick evcnl and add lhe following code: 

11' 1 Ml?ssage. F'onti tal ic = Value 

.1. Douhle-click Jhc underline bullan to open the code window for 
GrnupPush3D3_Ciick event and add thc following code: 

ll!ll·l<?:!ssage.F'onlUnderline = Value 

4. DPuhlc-click thc lcft-justify bullan lo open the code window for 
Grnupl'ush3D4_Ciick cvclll and add lhe following code: 

11·11·1·~ssage.Alignment =O 

"· 1 )tHihJc-cJjc]\ !he CCil!Cr bU\IOI}!O Oj)CillhC COÜC WillÜOW for 

Gn:upl'ush31J5_Ciick cvcnl and add the following code: 

1 1>1 l·i~ssage. Al ignment = 2 

h. D"uhlc-click thc right-justify button lo open the code window for 
firoupl'ush311!l Ciick cvelll ami add Jite following couc: 

7 S;~\'l' ynur work in \WALKTI-IRU\SAMPLES. 

., 
1 



fl 

f Summary 
• 
" • 
• 
• 
• 
• 
1 

1 

Module 7: Building a File Browser 169 

• File Browsing 

• Grid Control 

• 3-D Panel Controls and Group Push Button 

Objectives 
In this module you learned to: 

• Design and develop a fonn that lcts users browsc Urivl's. dirl·ctories. anJ file~. 

• Use the Change and PathCiwngc cvcnts. 

• Use the grid control. 

• Use 3-D panel controls and thc·group push hutton. 

,. ,. 
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L, Overview 

• KeyTerms 

• Using Variables and Constants 

• Scope 

• Additional Visual Basic Data Types 

----------------------------------

· .. _ 

Overview 
The overall purpose ofthis module is to introduce airead y knowlcdgeable 

· programmers to the data types of Visual Basic and thcir scopin~ rules. This module 
is designed as the first of a series of modules on thc impll'mcntatinn of Basic within 
Visual Basic. 

Prerequisites 
Prior to startilig this module. you should airead y be famil1ar with: 

• Data types and scoping rules within sorne othcr proú'dttral l;tnguagc_ 

• The general Visual Basic programming systcm 

Overall Objective 
At the end of this module, you will be ablc 1t1 corn;ctly and l'llil'tl'lltly use ;dmo:-;t all 
of the Visual Basic daw types. 

Learning Objectives 
Atthc cnc.J nf lhis module, you will he ah le to: 

• List ami describe thc se ven variable data typcs in Visu;d !Lt~h·. 

• Correctly identify the six type dcclaration characlcr symho\s. 

• Use the contents or CONSTANT.TXT. 

• Distinguish among the various levcls of scopc in Vis.t1al llasi.-. 

• Explnin thc rule!-~ for using c:1ch levclof scopt~. 

• Declare and use a uscr-dcrincd data typc. 

• Declare and use simple arrays. 
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Key Terms 

·.,· 

------ -

• Variables 

• Constants 

• Procedures 

• Statements 

• Scope 

• Module 

Variables Changcablc values thatthe program manipulates 

Constants Unchanging values that the program manipulates 

Procedures /\ctivitics thallhc progr;.un pcrl(mns 

Statements Subactivities within procedures 

S cope 1 i\ccessihility) Which pa11 of a program can access specific data or 
\lnlL"L'lllll"l.:S 

Module File containing code and data not attached toa form 



Module 8: Using Visual Basic Data Types 175 

L, Using Variables an~ Constants 

· .. _ 

· • ·Data Types of Variables 

• Data Types of Constants 
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Data Types of Variables 

------. 

• .lnteger. % 

• Long & 

• Single 

• Double # 

• Currency @ 

• String $ 

• Variant (none) 

Thl'l'l' ill'l' se ven fundamental Ottta typcs of variables that you can use in Visun.l 
lbsiL. 

Typl' IIHllll' Dcscriplion 

----
lntc~c1· T wo-byte integer 

l.llllj..! Four-byte integer 

Sinl!,lc Four-byte tloating-
point number 

1 )uuhiL' Eight-bytc llo<lting-
point number 

CurrcnQ Eight-byte number 
\\'ith a tixcd decimal 
point 

Strinl! String of chamcters 

Vurilllll IDcfault) Date/time. !loating-
¡Xlint number. string 

Type-dcclaralion 
charactcr 

% 

& 

# 

@ 

$ 

(none) 

Rang~.: 

-32,768 to 32,767 

-2,147,483,648 to 
2,147,483,647 

-3.40E+38 to 
3.40E+38 

-1.790+308 to 
1.790+308 

-9.22E+14 to 
9.22E+14 

Oto 65.500 characters 
(approximatcly) 

Date values: 

January l. 0000, to 
Oecember 31. 9999: 
numcric values same 
as Uoublc; string 
v¡¡Jucs samc as string 

., 
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Declaring Variables 
In polite society you always formally introduce strangcrs to cach other the lirst time 
lhey meel. Visual Basic is no exception. You should introduce. your variable lo 
Visual Basic by declaring the name of your variable hcforc you use it. You do this 
in one of lwo ways: by using the Dim slalcment, or by using one of lhe 1wo 
keywords-Giobal and Sta tic. As you wi\1 see in a couplc of pages, not declaring 
variables can be risky business in somc situ<llions bccaw .. c thc lk·faull Uata typc in 
Visual Basic is Variant. 

You have lwo choic~s on how lo explicitly declare variable' data typcs. 

Using As 

Dim 1 As Integer 

Dim Amt As Double 

Dim YourName As String 

Dim BillsPaid As Currency 

llsin~:t thl' ly¡w-dl't'lunltiun l'lmnlt'll·r 

Oim U 

Uim AruUI 

Di m Your r~.,p, .. ::; 

I.Hru Bi] 1 :·.1'., i ,j(.o 

In arder to make compound variable declarations. you nwrdy stalc: 

Dim X as Integer, Y as Long 

Caulion If you declare three separate variables with tlw following slatement. Y'"' 
will gel K$ as a slring and 1 and J as variants, nol as strings. 

. Di m. I, J, .K$ 

Explicit Declarations 
To require explicil declaration of variables in all of your et tdc. place thc follnwing 
statement in the General Declnrntions scction of ;,1ny fnnn or module. 

Option Explicit 

If you want to requirc thttt al\ variables he cxplicitly dL·l·lar'l'd irr :di of ymrr pm_i~L·ts. 
frnm thc Optinns mcnu clmosc Environmcnt ;rnd sct lliL· l~nprirl' V;rriahk 
Declaration option lo YES. 
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Variable-Length Strings 
Sonlctilllcs you nwy nccd a variable that can holc.l strings of dilTcrcntlcngths at 
dillcrenl limes. This is callcd a variable-lenglh slring variable. You declare illikc 
this: 

:•iu• 1-l• .. ;sit(Je As SLring 

Fixed-Length Strings 
Al olher limes you know lhallhe slrings lhal will be assigned lo a certain variable 
will IH.'vcr ha ve more than a ccnain number of characters. In this case, you can 
declare a.fixed-ll~ll~lll variable like this: 

1•1n• Fl>'.r·dl.engt.iiString As String • 50 

In tlli .... L·xar.nplc, yuu an.: úcclaring a string variable with the namc 
hxcdl.l'ngthString. am.J you are tclling the application that the variable may contain 
up 1t1 )11 charactcrs. 

Yoo can lakc lhis onc slcp funhcr. For cxample, sellhe lenglh using a Global 
constan! with thc namc FixedLcngth, sct the valuc of the constant to 50, and then 
poin.t to that constan! namc using the follo,wing syntax: 

¡;Jobal· Const FIXEOLENGTH = 50 

Global FixedString As String • FIXEDLENGTH 

Rules When Working with Variables 
l. Variable namcs can be up lo 40 characlers long . 

.., Na111cs can includc only lcucrs, numbers. and umlerscores . 

. ~. Th!.! l'irst characlcr in thc namc must be a lctter. 

~. You cannol use Visual Basic reserved words. See lhe lisl of programming topiés 
in Visual Basic Help for a partiallisl of reserved words. · 
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' ' 
As the chan above shows, the Variant data typc is thc dcfault. The Variant data 
type can store numeric, string, or date/time information. Ynu don't necd tn convcrt 
between these kinds of data when assigning them lo a variant variable: Visual Basiv· 
automatically performs any necessary typc convcrsion~ lúr yon. 

Rules for Using Variant Variables 
l. If you perform arithmetic opcrations or functions on a variant. it rnust contain ;1 

number. If you want to test a variantto scc if it conwins llliiiJCric data, use thl: 
IsNumeric function. 

2. Normally, when you concatcnatc two strings you would u .... L'Ih.c plus(+) si~;! !l. T11 

avoid ambiguity with variant dala, use the ampcrs;tnd l&J to inJic;.¡tc 
concatcnation. 

Note When concatcnating, be carcful tn lea ve a sp;tú' IK·t \\'L'C/1 ;.t V<triahlc nanh' 
nnd the ampersand. If you don't, Visual Basic assunll''> th;tl ynu are typecastin~ 
the variable into a Long data typc. 

3. When passing a Variant variable asan argttrncnt. chcd; thL' proccJure 
p01rameters. Jf thc corrc:-;ponding argurm:m is an cxplil·ir data typc. you Jlltrsl pa."·' 
thc Variant vnriablc with p;rrcnthcscs aronnd it in ordn lo p;tss it hy valuc. 

Dim V As Variant 
v~ •Te:Sting• 
Debug.Print PrintString(fVJ J 

Sub PrintString(S As String) 
'Do something 

End Sub 

·¡.;x1.ru J)i¡J•~JJII¡•·.-:··:: ¡,, pils.o..; /,y v .. IOJ· 

4. To determine the interna! representation for a varia111 v;triahk. use thc VarT.\'fll' 
function. See documentation for spccific rcturn v;dttl'~. · 

5. A variant variable has thc Empty val u e hcfore it ¡_, ;t~~ignL'd 11 valuc. Tlu: 
Empty value is a special valuc, diffcrcnt fr~m1 <1 zcro, <ti.CI"IJ-/cngtll string. nr ;t 

NULL valuc. To test your Varhmt vari;~hk fnr ;¡n Empty \';dtu.'-. use thl' 
IsEmpty function. To rc;.tssign a Variaul·variahk h;1r~ tntltc Empty \·;tlnL'. 

you rnust assign anothcrcmpty Variaut v;¡ri;thlL· 111 il. 

6. To test fora Varh~nt vari<Jblc containing NULL. lt~l' thL' l.o,;NlJLL l"utll'tion. 

Note For a listing of lhe string convcrsion functitJ/lS ftlr t/JL' Variant data I)'PL'. 
see the appropriate table al the cnd of lile Vi""¡J fla.,iv· cmk module. i ,, 

!' 
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Example 

1Zi1 " Modulet.bas Bll"' 
~O:br:•'~'=' ~~~~g~e~ne~•~al~)====~fl±~·f~~P•:o~c:~[~id~e~c~la~•a~tio~n~s~)~jl=f~'J========~·I 

' Al ignment ( label) 
Global Const LEFT_:_JUSTIFY 
Global Const RIGHT_JUSTIF 
Global Const CENTER = 2 

What Are Constants? 
ConSiallts are justthat, enlilies within your program whose value you need, bul 
which will not be changed during the running of the program. For example,.if your 
program needcd tu work with circles, you would probably need a conslant like 
1'1 = :1.145Y. 

"·"'"'i'b uf tyrical constants can be found in CONSTANT.TXT. lf you look at 
this fik. you wil\ find severa! conslant values declared that are familiar to you from 
thc owrvicw of propcrties for controls. 

'll"t der Style 

r·rq¡;;;t. NONE = 0 

,·,n::;t: FIXEIJ_SINGLE 

r· .. ;¡:=;f. SIZABLE = 2 

,.,>ll~l FIXE::IJ_DOUBLE 3 

How Are They Declared? 
Vi.sual Hasic conlains a CONSTANT.TXT file, which lists allthe common 
~.:onslallls. You can copy and thcn modify this lile to mcct thc application's spccitic 
nc,·<ls. You can then load CONSTANT.TXT into the General Declarutions section 
of" III<Hiulc (.lli\S) lo he uscd hy thc application. Following is a partiallisting or 
tllL· i-!l'nnal t.:alcl!mics of constants Uclinc~ in CONSTANT.TXT. 
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L, Scope 

• Scope of Data 

• Declaring and Using Local Variables 

• Declaring and Using Form-Level and Module-Leve! Variables 

• Declaring and Using Global Variables 

----------------------- -------
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Scope of Data 

Form.FRM 

Form $ 
i 

Dim A 

Declarations 

Local ·~ 
Sub X 
Dim B 

'SeesA,B,C 

Procedure 

11 ¡Sub Y 
. 'SeesA,e -~ Procedure 
·---~~-·-- -

What ls Scope of Data? 

Global 
Module 

Local 

Module 1.BAS i Global e 
Dim D 

Declarations 

Sub Pl 
< DimE 

'Sees e, D, E 

1 Procedure 

Sub P2 · 1 1 
·sea 

Proced:_:re . -

Thc scopc of a llata variable or constant is its level of visibility within an 
application. Scnpc of data falls into three levels of visibility: local variables, form
antl module-leve\ variables, and global variables. 

Scope of Data-An Analogy 
Scopc· ol data basically deals with who can use what. The easiest way lo think of 
this is hy.ana\ogy. 

Say you hada refrigerator/freezcr full of all kinds of goodies-candy, soft drinks, 
ice ere¡¡ m: Almost cvcryone likes these goodics and would like to geúo them. Your 
joh '" lhe manager of these resourcesis to make sure that the right people gel to 
thcm ami thc wrong pcoplc don't. 

lf you putthesc guodics out where everyone can get to them, they will be used, 
ri!!ht'.' lf th<~t is what you \\'f.Hlt, thcn fine, tnakc them J.:lohally availablc. In Visual 
lbsi~.· t~.·nninology, Jcd~m! anU Ucl"inc variables that a u functions will nccLI acccss 
1<> u.siug thc Glohal kcyword in the General Declarations section of a module 
t. HAS l. not a form. 

h1r thn . ..;c gooJics that you unly want sume pcoplc to gctto, forcxamplc,just thc 
· ttH.:nJill·rs {lf your W(H"k group, thcn pul the rcfrigcrator/frcezer .where only they can 
~el lo it- for cxamplc, in your work group area. In Visual Basic, declare and 
dcrinl' thcsc variables using thc keyword Dim in the General Declarations section 
of cithl'r lile form or the module. You'll see an example of how this is done in just a 
fl'\\' tttiltllll'S. 
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Finally, for those goodics to which only you slwuld haVl.' ill.'CC:-.s. pul thc rcfri~crator 
in your office. That is, declare and detine thnsc variahks l<~c:1lly- insiue a 
procedure. Again, you'll see examples of this is justa minute. 

Variable Declaration Keywords and Their Scope 
The table below details how the diffcrcnt variable· dcclar;ll ion kcywmJs are u:-~cd. 

S cope 

Local 

Module 

Global 

Dcclaratiun 

Di m, Static. or ltcDim cwitllin ¡¡ prcx:edurc) 

Dim (in General Declurations scction of a form ora cndt· 
module). 

Global (in General Dcdar;11inns scction of a nHx.lulcJ 

A simple example of data declarations can he found this wa~· 

l. Start Visual Basic. 

2. From the File menu, choosc Opcn Projcct. 

3. Go to the C:\VBISAMPLESICALC suhdirectory . 

4. Double-click CALC.MAK . 

5. Click CALC.FRM in thc Projcct window . 

6. Click View Code in the Projcct winuow . 

. Visual Basic displays the form-lcvel variable declarati<JilS rm the calculator 
application. Notice the declaration of scvcn variahlcs and the Optiun Explicit 
statement. 

Note When you are writing ende and you want to crea le module-'" form-lcvcl 
variables, make sure that you are really in thc general dl'clarations scction nf tlll' 
code·before you make changes or additions . 

Always be sure that the top of your form wimlow has thcsc twt~ options ;\CicctcU. 

General Declarations 

ICONWRKS.FRM -
Proc: 
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Style Guidelines 

L Fur a mure cumplcx listing or global dcclarations 

\. hotulhc File mcnu, choosc Opcn Projcct. 

, c;o 111 the C:\VLIISAMPLES\ICONWRKS subdirectory . 

.1. Dt~uhlc-click ICONWRKS.MAK. 

~- Click ICONWRKS.GLIL in the Project window. 

). ( 'lil·k Vicw Codc in thc Projcct window. 

Scroll dt~wnlo Lhc General Declaralions section of ICONWRKS.GBL and inspecl 
lht: \'ttritllts valucs dcclared and defined. 

Rules lar Using Local Variables 
l. 1\ lt~cal variable is recognized and declared only within the procedurc in which it 

appt.·ars·using thc kcywunJ l>im. The variable is re-inilializcd to zcro ora 
NULL string when Lhc proccdure bcgins. unless the local variable is declared as 
Statlc. A local variable is a good choice for any kind of temporary calculation. 

, lf youuse a variable without declaring it, then Visual Basic assumes iL is local 
aiHI assumcs Variant as thc data type. However. this technique may waste 
sL11rage space and is notas reliable as declaring the variable in Lhe appropriate 
prucedure. lt is al so notas efficient. 

Rules lar Using Form- and Module-Leve! Variables 
l. A lúnn-level variable is declared in Lhe General Declarations section ofthe 

fm111, u .... ing thc kcyword Dim. A form-level variable is available to any 
procedure on thal form and only Lhat form. 

, 1\ llltJdule-level variable is declared in the General Declarations section of the 
module, using the keyword Dim. A module-leve\ variable is available to any 
pr11éedure in Lhal module and only that module. 

Rules lar Using Global Variables 
l. 1\. gh,ba\ variabh:: tJr constant is sharcd through6ut an application. Multiple 

r. """ and mouulcs can usen global variable. They are declared in the General 
llrclamtinns scction uf a module using the Global kcyword for variables anu 
< ;lohal Const ror cnnstants. 

' Gluhal \'ariahlcs are persisten!; lhcy rctain their vnlue throughuut the entire 
applic;¡tion. 

< i1 ~ 111 1'~'~ ~~rallln1in~ pract ices when using variables ami ctmst;!nts incllu.lc: 

• 1 J...l· fon11-kvcl and moUule-kvcl constants amJ V~lri.:Jblcs as oppo.-;cd to global
l~vl'l il" possiblc. 

• lkdarc thc variable or constant with the Dim statement rather than accepting 
Ba:-.ic automatic variables. 

• .Usl' lntcgcr declnrations instead of default Variant declarations whenever 
po:..;..ihlc. lull'J.!CI" dcclaratiuns takt! lcss sp.:u.:c, avuiJ ruuuJing crrurs. ¡tml 
1,."tlll'-llll!C k:~:. l'I'U ti1nc than Varhmll.lcdaratiuus·. 
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Declaring and Using Local Variables 

Example 

Example 

~ EMPREC.FRM . · ·. , 

Sub AddEmp ( ... ) 

Sub AddEmp ( ) 
Dim CurrentLocation As Integer 

Local variables reset to value zero (0) oran empty string whcn thc local proceuure 
begins. 

To declare a local variable, place thc Di m U:~ta declara! ion si<IIL'Illt.::lll in si de thl' 
local procedure. 

1 

2 

3 

' 
5 

6 

7 

Sub Form_click () 
'The local variable below disappC'ars '11'"" t•n··· .. dlln'! exi~. 

·and is reinitializecl to zer·o wh•~n lJ¡o· ¡ .• , .... ,,<!,,,,. i:~ n..:-•·tJI··r··· 

Dim EmployeeNumber As Integer 

EmployeeNumber = Val(Textl.Text) 
Print •The Employee Number is: • :.;11 ·:. (t·:rupl••·,····~numb0r J 

End Sub 

In the example above, EmployccNumbcr is dcclarcd ;ts ctn lnh·J.:cr. How would tlw 
code be different if you handlcd itas a Variaul" 

V Sub Form_click () 

2 Dim EmPlcyeeNumber 

3 ErnployeeNumber = Textl.Text 

' Print •The Employee Number is: • EmployeoNumber 

5 End Sub 

Note Notice the use of the ampersand to concatenate thc lilcr<il String and thc 
Variant in the Print statement above? 

·i: 
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Example 

11 you want a local variable lo be persisten!, declare itas Static. Slatic local 
variahll's will rclain thcir (.]ata valuc whcn thc procedurc pcrl"orms u rcturn. 

::qJ, Stat.it:DP-mO () 

'The -static variable below will ·retain its value across 
calls and is used to keep track of how many times 

.¡ StaticDemó is called, 

•, Static Runcount As Integer ' Create a persistent vari:able 

RunCount = RunCount + 1 ' Use it to keep run count. 

MsgS=flThe RunCount for the StaticDemo.Procedure is: • 
~ MsgS = ~sg$ + StrS(RunCount) ., Pdnt Msg$ · Display message. 
i t'l End Sub 
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Declaring and Using Form-Level and Module-Leve! Variables 

Example 

AccessCount As 
Data 

Use form-Jevel variables or module-level variables when sharin~ Jata only within" 
form ora module. The data rema in~ persisten! within thl· f,ll"lll '1r llHHJulc hut is 111•1 
~ccessible lo proccdurcs in othcr rorms or /llodulcs. 

To declare a form-Jevel or modulc-lcvel variable, place lhc llim slatcmcnl inthc 
General Declarations section of the corrcsponding fnrm or module. 

The declaration below appears in thc General DcclawtiLlll., scction of the llliHJuk' 
DEMO.BAS: 

Dim UserName As String 

When thc procedure bclow is ca/lcd, it can acccss this module-lt·vcl variable. For 
example, suppose that a tcxt box· is supplicd for thc uscr lo t)'pl' his or hcr namc: 

UserName = txtUserName.Text 

Thcn thc appropriatc valuc for UscrName will b~: printt·d whl'n lht: Suh proi.'L'lhtt\' 

WelcomeDemo is called: 

1 Sub WelcomeDemo () 

2 Variable declared in module's Declarations .-;o:'<:"ti,_,n can be 

3 referenced here 

4 Print ·welcome • + UserName 

5 End Sub 

:.! 1 
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Example 

Thc moJule-lcvcl variable is also available to all other procedures defined in 
DEMO.JlAS. 

~·11• V~ri fyUserName () 

~lsg$ = ftUserName = M 

Vil¡· i able declared in module· s Declarations section can 

.1lso be referenced here 

MsgBox MsgS + UserName 
1-:n•l Sub 

/ 
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Declaring and Using Global Variables 

Example 1 

Example 2 

~ MODULE1.BAS 

Global GlobalNumber As Integer 

ri·hllil'd', 
GlobaiNumber 
Accessible Here 

r··h'!fU", 
-~' --· ··--·=-""<"-~ .. ----·· 
GlobaiNumber Also 
Accessible Here 

Use global variables and constants whcn sharing Uat<tlllrouglullll an ~1pplic11ion. 
The dala remains persistcnr ;uH.l acccssible from al! form.-, and rnodules within thl' 
application. 

To declare a global variable, place the Glohal statcmcnt inthc General 
Dcclarations section of a modulc-that is, <1 .HAS file: 

Global GlobalNumber As Integer 

The variable Globa!Numbercan now be rcfcrcnccd thrtHJ!!houl thc application. 

1 

2 

3 

4 

5 

1 

'· 

' Code for Forml 
Sub Form_Click (} 
' Global variables can be referenced here 

GlobalNumber GlobalNumber · l 

End Sub 

• Cede for Form2 

sub Form_Click () 
J 'lilubdl V<llict!Jll!ti <.:nll ,J::;u lJt.' l•,l•·l•·ll•'•:tl 1,.·¡·· 

4 Print = ·GlobalNumber " • StrS CGlobalNumll~rJ 

5 End Sub 

Load any constants you w~nt dcclarcd for an en! irc pro!!r•un into lile GcnL'ral 
Declarations section of a module. 

. ' 
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·.,· 

Walk Through-Scope 
L. Tu dcnwnstralc lhc conccpts of scopc of data in Visualllasic 

l. ¡:,.,,, the Walk Throughs program group, start Scope. 

Whl'll thc application sta11s, you sce two forms. Form 1, on thc lcft, contains a 
CtiiiJJll<llld 1 hutt¡m: Form2, on the right, contains a Command 1 buuon. 

TiJ,··purposc of this walk through is to demonstrate the concepts of scope of data 
in Visual IJasic. 

' Clid Forml Ion thc form, not the command button). 

Thc Form_Ciick event will display values of data items as their scopc permits. 

Thl' global anll form-Jevel data values are displaycd. Note, however, that the 
Furm2 module-level variable and the Forml.Commandi_Ciick and 
Funn2.Command I_Ciick local variable values are not displayed. Remember, 
yuu just requestcd a Form_Ciick event, so the Command I_Ciick variables are 
not yct in scopc and Form2 variables are not in scope until Form2 has focus . 

. 1. Clid Form2 (on tlie form. not the command button). 

Tlic Form_Ciick evcnt will display values of data items as their scope permits. 

Thc global and form-level data values are displayed. Note, however, that the 
Fonnl modulc-level variable and the Form I.Command I_:.Ciick and 
Funn2.Command I_Ciick local variable valucs are not displayed cither. 

·. Rcmember, you just requested a Form_Ciick event, so the Command2_Ciick 
variable is not yct in scope and Form 1 variables are not in scope until Form 1 has 
ru~..:us. 

-l. Clid.;. the CommanJI button on Fof-ml. 

Thl' Command 1_ Click cvcnt will display values of data items as their seo pe 
pL'nnits. 

Yuu ha ve just gcncrated a Form J.Command l_click event, and this places the 
h mui.Command 1 '-Cl ick variable in seo pe. Form 1 stillhas focus, though, so 
Forrn2's variables are not acccssiblc. 

'í. Cl1ck the Commandl button on Form2. 

Thc Command I_Ciick cvcnt will display values of data items as their scope 
rcnnits. 

Yo u ha ve jusi gencrated a Form2.Command I_Ciick event. and this placcs the 
Fonn2.Comnwndi_Ciick variable in scopc. Form2 still has focus, though, so 
Fonnl 's variables are not acccssible. 

fl. Douhlc-click the Controlmenus on both forms to clase them. · 
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Additional Visual Basic Data Types 

Syntax 

Example 

• User·Defined Data Types 

• Arrays · 

User-Defined Data Types 
Earlier in this module standard Visual Basic dala typcs wcrc discusscd. Visual 
Basic also allows you 10 create your own dala lypes. Uscr-dcfincd data lypcs, c:liled 
records or structures in sorne othcr programming l<mgu;tpes. must he dcc/ared in tlll' 
General Declarations section of a module. using thc Typ(' statcrncnt. 

Typc usertype 

clementnamc As typcnamc 

[elementname As typenamc] 

End Typc 

This feature allows you to crcate ncw variables tlmt can he custornized to fit th~ 
needs of your application. For examplc, yo u mighl wanl to define a daw 1ypc lo hold 
customer information as follows: 

1 ' Place this declaration in a module 
2 Type CustomerRecord 
3 CustNum As Long 

4 CustNarne As String • 38 

5 CustAddressl As String • 38 

6 CustAddress2 As String • 38 

7 CustZip As String • 10 

a End Type 

SLreel ;,JriJ ·:ss 

City, Slñll-:' 

) 
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Example· · 

Example 

Example 

Y ou can then declare and use variables of this new type in your application 
wherever you need them. To refer toa particular element, use the syntax 
¡·a riahl t'llame .el ementname. 

:;11¡, GeLCusLomerinfo () 

ll,.clare a variable of your user-defined type 

IJ i 111 NcwCuslomer As CustomerRecord 

l!s~ contents of various text boxes on a form to fill in values tci. 
1 he elements tfields) of your new CustomerRecord variable 

N~wCustomer.CustNum = Val(txtNumber.TextJ 

~~~:wCus tome r . CustAddressl = txtAddrl. Text 

).<; N~wCustomer.CustAddress2 = txtAddr2.Text 

N~wCustomer.CustZip = txt.Zip.Text 

: 'J Fnd Sub 

Arrays 
Visu;d Basic, likc many other programming languages, allows you to create arrays. 
An anay is a gmup uf variables of the same data type that share a common name. 
I:.<H.:h ~l'paratc clcmcnl of th~ arra y is identified by a unique index number. 

Decl-1re an array 

IJim A1 rayName lUpperBoundsJ As DataType 

Pim 'J'nstScoresl23) As Single 

Note Hy ucfault, thc tirst elemcnt in lhe array is referred to with the indexO (zero). 
This ncatcs an <HT<~y of 24 (not 23) single-prccision numbcrs in which you could 
stnre the scorcs for 24 studcnts. 

lf )'11\1 wantcll1t1 print this scorc out to thc form, you wuuiU use thc following: 

¡·..-int ~The test score for the first student is: ". 

!'rint' TestScores(OJ 

Thcrc is an altcrnatc syntax for declaring arrays that allows you to specify the lower 
ibcginning) and upper (ending) indexes, or bounds, of an arra y. You could declare 
an arra y lo holtl 24 test scorcs likc this: 

llim T~stScores(l To 24) As Single 

Y ou wnu hJ thcn rcl'cr to the lirst elemcnt in the army as TestSc.ores( 1 ). 

lf you,lidn't ha ve arrays, you would ha veto create 24 separate variables, named 
sotnctlling likc Scmc 1, Score2, Scorc3, and so on. 

In thc n1oUulc on looping structurcs, you will discovcr that loops are a vcry useful 
llllll for acccssing clements in an arra y. 

Note To changc thc delilUit lowcr bound to 1, placean Option llasc statemcnt in 
thc General Dcclarations scction of thc module, like this: 

''PI!'"'' 11·1.•;•• ! 
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Variations on Array Declaration Syntax 
Depending u pon where the array is dech1rcd and lhc ~pl'l·iallll'L'tb of your progr<~llL 
the syntax to declare an array may vary u bit. Hcrc i:-i a l>~h!t.: ¡IJ;H summarizcs lhL: 

rules. 

Scope or variable declaration 

Application-wide 

Form or module leve! 

Wilhin a procedure 

Kcyword tu use 

Global (U sed cmly in the C icncr<~l Dcclar.Hicm., sccl i1111 

of a .BAS m<Kiulc.) 

Di m (Used inthc Gencralllcdanuions sec1ion of a 
form or module.) 

Sta tic (lf lile Clllirc prt)I.'L'tlurc hit!>. hccn dcdarcJ Slillic. 
thcn you may use thc word Di m 1!1 declare thc ilrray. J 

Multidimensional Arrays 
The array described in the last section, TestScorcs, is an exarnplc of a une
dimensional array. You could think.of itas rcprcscnting a single co/umn (or row) of 

numbers. You can also declare an array of severa/ dimensions. Thc maximum 
number of arra y dimensions allows in a Dirn statcment ¡, r,o. For cxamplc: 1<> 
representa table of numbers you can declare a two-Uinwnsion;d ~trray as follow .... : 

Sub GetNumbers {) 
Static Tablef4, 23) As Single 

.:.or-

Static Table(l To 5, 1 To 24) As Single 

End Sub 

This would crcate an array of five rows of 24 lcst scoh:s L'ach anJ proviUc room to 
hold five scores for each of 24 studcnts. 

Dynamic Arrays 
111ere are times when you want to use an anay, but the sit.e nc.:L·t!cU wi/1 ch.:m,ge ;1[ 

run time. Visual Basic allows you w e reate dynamic. or varitthk-lcngth :uTays hy 
doing the following: 

Declare the array without dcclaring its sizc with cithc.:r tltt• Di m .\tatcmcnt ( for a 
form- or module-level arra y) or !he Global statcmcnll for a ~lohal ;may). Todo 
this,just placean empty set of parenthcscs lo !he righl of thc arra y na me: 

' Place in General Oeclarations section of a funn <¡¡· n1r•rfule 
Dim DynArray() As String • 25 

-Or-

Global DynArray() As String * 25 PlAce i1. J-¡'lllUi !-:! .8:\S 

. Here is another example: 

(jJolllll l)ynlulAI"nly() As lnt••qnr 
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Example 

Thcn insi~c a procc~urc, whcn you know the size you need for this array in sorne 
particular circumstance, redimension the array to the size you need: 

Sub UseArray ( J 

tl!Jtice you can use a variable from your program to set the size 

t!<>llim DynArray ( Listl. ListCount) 

Importan! Each time you use thc RcDim statement, allthe values currently stored 
in thc arra y are \ost, and cach c\cmcnt is reset to zero ora NULL string depending 
onthc tyre of the clCmcnts in thc array. lf you want to preserve the values during 
n.!-din1cnsioning of thc arra y. use the Preserve keyword. 

F•.:!JJJn I'J"!serve 11yArray!UBound (MyArray) • 10) 

lnthi., c:J>e, you are rc-dimensioning an arra y called MyArray to be 10 elements 
\;rrgcr while maintaining cxisting data. 

Control Arrays 
Visual Basic has a specialtype of arra y called a control array, which has special 
fcaturcs and docs not follow all the rules of standard arrays. 

Ynu willlearn to use control arrays in the course that follows this one in the 
Microsoft University Visual Basic curriculum. · 

~ 

• 
• 
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.Summary 

• Key Terms 

• . Using Variables and Constants 

• Scope 

• Additional Visual Basic Data Types 

Objectives 
In this module you lcarncd to: 

• List and describe thc scvcn variable J;:1ta types in Vi.-.ual Ba:-.ic. 

• Correctly identify the six type declaration charactcr syrnhols. 

• Use the contents of CONST ANT. TXT. 

• Distinguish among the various le veis of .scopc in Visual Basic. 

• Explain thc rules for using cuch leve! of scope. 

• Declare and use a user-dcrincd data typc. 

• Declare and use simple arrays . 

. · .. _ 
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Lab Time 

Go lo the Using Conslanls and Variables ponion of your lab manuaL 
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L, Overview 

• Visual Basic Procedures 

• Scope o! General Procedures 

• Writing Code in Visual Basic 

• String and Numeric Conversion Functions 

Overview 
This is the "Everything You E ver Wantcd to Know About Writing Codc ... But Wcre 

.. ·"Afraid to Ask" module.lt gives you the background ond proccdurcs needcd to bcgin 
writing the Visual Basic codc that implements thc interfaces. 

Prerequisites 
To successfully complete this module and its associatcd lah, you . ..,lwu\J h:.1vc a 
detailed understanding of fonns, controls, and propcrtie~ as tlu:y are imp\cmcntcJ in 
Visual Basic. 

Knnwlcdgc of any block strucHm.::d progranJining la11~ 11;•~~l- i~ n·1 p1 irl'd. 

Overall Objectives 
There are two overall goals for this module: 

J. To quickly review most of thc fundamental proccdtlrl·~ of B;1sic as it is uscd in 
the Visual Basic product 

2. To show students thc first stcps rcquircd for cornpletin~ thc L'oJc for <.In 

application 

Learning Objectives 
At the end of this module, you will be abk to: 

• Define important charactcristics of funclicms and S11l• JWKl'llltres aml wrilc 
code that correctly uses both. · 

• Oclinc i\1111 COIH'CIIy code fnr :tppropri;tll' .'>l'IIJle ur d;ll:l. 

• Writc codc that uses any o!" lhc Cll1llllHlll ll;1sic c.Jal;• 1 YJlL'S. 

.\ 

. ' 
'.i 

. i 

1 
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Sample Code 
Thc bcst way for you to learn how to write Visual Basic code is toread it. Sample 
codc for a four-function calculator application can be found in the 
IVB\SAMPLES\CALC subdirectory. 
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2, Visual Basic Procedures 

Syntax 

Syntax 

• Sub Procedures 

• Functions 

• Arguinents and Parameters 

• Procedures 

Event Procedures 

General Procedures 

Methods · 

· What Are Procedures? 
A procc<.Jurc is a block of Visual Basic state1ncnts that ;u-l· cdktl as a logicaluniL 

Two Types of Procedures-A First Pass 
Sub Procedures 
After the Sub procedure completes its. work (cxccutcs its L·mlcJ. it rcturns to thc 
procedure that called it. 

Sub SubName () 

s/a/emenJblock 

EndSub 

Functions 
A Function is similar toa Sub procetlurc. In addition. it has a dolla typc just <~s 11 

variable does. After it completes its work, it rcturns <1 \';dtlc of ti Lit typc tn thc 
procedure that called it. 

Function FunctionName() As SomeDma"l\¡w 

.'if al eme m hlock 

FuncrionName =So me Vol u e 

End Function 
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Calling a Sub Procedure with Arguments 

Syntax 

Syntax 

. · .. · 

Event Procedure 

Sub Commandl - Click ( ) 1 
DisplayError .. MyError .. 

~ -,. 
End Sub 

;·~ ~w4' wtr W'.t'ztn»r: " 

Sub Procedure 

~ ~ Sub DisplayError (ErrMsg As String) 
. 

lblError. Caption = ErrMsg 

L.:::;¡ End Sub 

Arguments 
Any prucedure can be defined to receive data when j¡ is called. A piece of data sent 
to ~~ procetlure is callcd an argument; andan argument is matched to its equivalent 
par;unclcr entry in the procedure list. Each pa!"amete!' is dc.clar(:d to be of a specific 
dat<~type. 

Thc follnwing is a Suh proccdurc that receives two arguments: 

Suh .\n111t'.\'uh (l'oraml As Intcgcr, Param2 As Single) 

SI ( 11 t' 11/C 111 /;/ f !f ·k 

En<l Suh 

\Vhl'll you callthis procedurc yot.: must make sure Lo pass it the same numbcr and 
typl' of arguments in thc same orUer thcy appcar in the Sub tlefinition. 

.\'onwSuh ;\rJ;IIIIIC'IIf 1, Argumeul2 

-Or-

Call .\'umcSuh (¡\rgtflllelll 1, Argwilellt2) 
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Syntax 

Example 

M~dule 9: Writing-Visual Basic Code 

The fo!lowing calls a Function procedure wilh argumcnh . 

Dim ResultAs Intcgcr 

Resulr = SomeFunction (Argumem/, A r~umt·nt2) 

Function SomeFunction (Paraml As Intcgcr, l'aram~ :\~ SinJ.:lc) 
"As Intcgcr 

StatementB/ock 

SomeFunction = Return Value 

End Function 

203 

Note The argument names used whcn you callthe proccdurc do not ha ve 10 match 
the argument names used in the detinition of thc procedurc as thcy do in the abovc 
example. The number, data type, and arder of thc argullll'llls must match in thc 
procedure definition and cal l. 

An alternative notation for the function rcturn valuc lbta 1ypc is ;tY• fnlhJ\vs. 

Function SomeFunction% (Paraml As lntcgcr·, Pcuwn:! t\.c.; Single) 

Statemell/8/ock 

SomeFunction = Return Value 

End Function 

Not~ Funclion procedures with tlll cxplicir rL'Itlrll v;dttl' d;tlit typl' ;trc mmc 
C!'Jicicnt than thoSC with a V01riant rcturn V<tlttl' d;t[;t l)'jll'. 

Remember what we saitl about Variant <.lata typ~s e;¡rJit'r'.' JI" yo11f ar~ument Í.' ;¡ 

Varianl and its corresponding para meter is ntJI. thc Variaut ;¡r~urncnt must he 
passed by value. This is accoinplishctl by putting a sct tJ( L'.\lr;l p;¡renthcscs artJund 
the Variant argument. 

You can accomplish the samc objcctivc by using thc ByVal kcyworU whcn you 
declare your parametcr in thc proccUurc. 

1 Function aeverse (S As String, ByVal N As Integer) As variant 

2 ' ... someStatements 

3 End Function 

4 Di m u As Variant, V As Va:riant. " As vari<JJJI 

S V •Testing• 

6 w = 10 
7 u Reve:rse ((V). W) 

·' 
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Passing Arguments by Value 
Visual Basic ¡wsscs argumcnts by rcfercncc as a default. What this mcans is that 
the proccdurc can modify thc values of thc argumcnts in the procedurc list becausc 
it knows thc tuJLlrcss for thc data. This in etTect allows you to pass back more thun 
onc valuc mcrcly hy changing thc argumcnts within thc proccdurc. 

In contras!, you can pass an argumcnt toa procedure by valuc. which means that thc 
proccdurc rcccivcs only a copy of thc data and cannot modify the value of the actual 
argtllllCIIl. Any cha11gcs mude lo the argumenl within the procedure are local and 
ha ve no ellcct on thc <ICtual data. 

To pass an argumcnt by value, use the keyword By Val in the parameter list or pul a 
sct of parcnthcscs ;.1round thc argument in the calling statement. 
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Types of Procedures 

Syntax 

··.-

• Event Procedures 

• Ge.neral Procedures 

Types of Procedures-A Second Pass 
Visual Basic applications ha ve two catcgorics of.proccdurcs: cvcnt anO gcncral. 

Event Procedure 
An event procedure is a procedurc invokcd hy a uscr- 1Jr ~ystcnHriggereJ e ven!. 

Event procedures are al\.~ays attached toa givcn form ur control. ·¡~he rirst pan or :111 

event procedure's namc indicatcs which ohjcct it is auad1t~d 10 . 

Sub objectname_eventname () 

statemellfblock 

End Sub 

Examples of event pr<icedurcs are: ComrnanJ.I_Ciick allll Form_Ciick. lf thc tN'r 

clicks on the command button namcd Comm~md 1, thc cwnt pro..:cdurc 
Commandi_Ciick will be callcd; but if thc u ser clicks tlll thcjiHm. thc cvcnt 
procedure Form_Ciick will be callcJ . 
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Creating the Event Procedure 

Example 

. Procedure Name Determines 
What Event to Respond To 

Sub HelloButton_ () 

Readout.Text = "Hello, World!" 

End Sub 

Templares CSuh ;md End Sub starements) are supplied.for al! the evcnts Visual 
l:lasic autom<Jtically rccognizcs. 

All younccJ lo do is lill in thc coJc: 

l. Opcnthe Codc wimlow. 

, In llll' < >hjcct li:-.t hox, sclcct thc appropriatc objcct. 

.1. lnrhc Proccdurc list box, selcct the appropriate event. 

4. Typc collc into thc tcmplate providcd by Visual Basic. 

Calling the Event Procedure 
You don't ha veto do anything to call thc event procedure. Visual Oasic 
automatically recugnizes al! tite events foral! Visual Basic objects (forms and 
controls). As soon as a user or tite system triggers an event for an object, the code in 
tite appropriate cvcnt procedure will be run by Visual Basic. ' 

Scope of Event Procedures 
Evcnt proccJurcs are only avaii<Jblc on thc fonn whcrc they werc dcfined. 

Note J:vcnt pron~Jurcs 111<1)' only be Sul> proccdurcs, not Function procedures. 

Tllc l_.,dl_m•.:ing is a C!ic.:k cvcnt pruCcUurc for a command button. 

.::q¡, LC'IliJT!Cllldl_Click () l 

This v~lue can be found in CONSTANT.TXT 
r: .. mst I~EIJ = &HFF& 

~;,.¡ 1),.. )o,lf'kqroottrt•l ,.,,]or ,,f Llt(' funu l'.fl·((!d 

.l··•rtrd 1\o~• H"•llnr ..., Hl~fl 

!. ¡.,¡,,¡ :.;o¡IJ 

( 

• 
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Event Procedu(es in Visual Basic 
A large number of event procedures are ~vailahlc for your use in Visual Basic. Tlw 
ones sct in italic typc bclow are covcrcd in this coursc, and tht: remaining cvcnt 
procedures are covered in the Programming in Micrr.J.\"1~/i Visual /Jasic 3.0 coursc. 

Aclion 

Change to control 

Drag and drop 

Dynamic data ex.change 
(DDE) 

Keystroke 

Mouse 

Shifr in focus 

Timer interval 

Forms and picture 

Ennt \ 

Change 

DropDown (combo box only 1 

PathChauge, PaueruC/wnge <lile li .... l hox only) 

DragDrop, DragÜ\'cr 

LinkCiosc, Link Error. LiukExcculc. LinkOpcn 

Kc)'Duwn, Kl'.\'Up. KC)'Prcs."i 

Click, DoubleC/ick. MnuscUuwn. 1\luuscUp. 
Mouscl'vlu\'c 

GotFocus. LostFm·us 

Timer 

l'aiut, Resi~e.l.oml, Unloml 

Use the online Help or the Microsoft Visual /J(Isic Lall.l!,llfl.l!,l' l<t~f(·rencc to !'ind 
descriptions of the event procedures in Visual Basic. 
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General Procedure 

Example 

El _ New Procedure 

~Type 
@§ub O Eunction 

Name: NewProc 

A general proceuure is a procedure executed only when explicitly called by another 
pn)CCdllrC. 

Creating the General Procedure 
l. Opcn thc Codc window . 

., Fmlll the Vicw mcnu, choose New Procedure. 

3. Typc tllc na me for thc procctlure, and choosc cilher Sub or Function. 

4. Add lile couc lo 1hc pruccdurc tcmplatc provided by Visual Basic. lf you are 
LTL'<II ing <1 ncw runction, rcmember to define the return type of the function amJ 
lo include a slatement in thc code assigning the value you want returncd to the 
functinn narnc. 

1 Function SlockValue (NumShares As Integer, SharePrice As Single). 

2 1\ As Single 

~tockV~lue = NumShares • SharePrice 
·1 Ertd Function 

S Sub TotalSt.vck () 

•J l'rint "TrJtal value of all stock is: " 

Print StockValue(lO, 123.25) + StockValue(200, 19.75) 

¡.. !·:ttd Sub 

Calling the General Procedure 
You n1ust cxplicitly calla general proccdurc, or thc code will ncvcr be run. 
Typically. you place acallto a general Sub or Function insidc an evcnt procedurc 
or in:-;idc ;mothcr ~cncral proccdurc. 
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Seo pe of General Procedures 

Syntax 

.... ,.,...¡__~-·---

~~!~(e~ITextl_Changel._ ............ l 
return 

~~~~~ --+ Cmdl_Click 1 ~ 1 DisplayBarChartl 

'-----------' return . t 
Click ·-~ Cmd2_Click Event L....-____ ....J <ff·he-•:•··'-~''"" 

return 

Form-Level Scope of Cede (.FRM) 
The scope of a general proccdure dcpcn<.Js 1111 whcrc il i~ tkfim~d. lf ytJU ftllltlW !he 
steps listed above whilc you are in the Code winc.Jow for one of your forms. then 
that procedure is avai.lable from anywhcrc on lhat form ooly. 

Global Scope of Code (.BAS) 
·¡r you ha ve a multiplc-form ;Jrplication allllm·L·d to hl' ;1hk toc;dl ccrtt1in 
procctlurC~ from anywhcrc in your application, yuu will llt't'd 111 n\:atc a st•parak 

.BAS module to hold those proccdllrCS. 

Note, for example, if DisplayBarChart is LkfineLl <.ts a tt'IJL'ral ¡m ICCtlurc ftlr Ftmnl 
thcn Tcxt 1, Cmd 1, and Cmd2 must all be cPnt n ds on h •r1nl . 1 r. IH 1wcvcr. 

DisplayBarChart is defined in a scparatc . B1\S mmlult.:. Tcxll, Cm U l. and Cmd~ 
could each be on a different form and stiJn,c ah le to ,·all 1 )isplayBarChan. 

Prívate Scope of Code (.BAS) 
In sorne cases, you will want to limit thc ;.¡cccssibility of a pnlccJurc containcd 
within a module. In arder todo this, use thc Priva te keywonJ in rront ofSub or 
Function definitions. 

Declaring a Prívate Sub Procedure 
Priva te Sub SomeSuiJ () 

SomeStatements 

EndSub 

'J 
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Syntax 

References 

Declaring a Private Function 
Priv;Jll' Funcliou SmneFunction () As lntcgcr 

Soflll! Stat e m en t J 

End Fuuction 

Method 
A mclhoJ is a spccial type of procedure provided for you by Visual Basic for 
spcci ric objects but not associated with a specific event. 

Special Characteristics of a Method 
l. You cannot crcatc a method; you can only call it. 

2. You cannot vicw or change the code for a method. 

\ Thr 11ames or all Visual Basic methods are keywords. You cannot create a 
gl'nnal proccdurc of your own with the same name as a Visual Basic method. 

Thl' follmving ca lis 11 mcthml from an cvent procedure attachcd toa form: 

: ;IJ 1 ' 1· "1 t" ! : 1 i ! : ~. ( 1 

V• • 1 no2 • Show 

l·:nd ::;,JI. 

Methods in Visual Basic 

form Click event for Forml 

Display Form2 

A largr number or methods are available for.your use in Visual Basic. The ones set 
in iwlic 1ypc bclow are covcrcd in this course. 

Drawin!! amJ graphics 

l'rirlling 

DDE 

Lis! hox management 

Cliph1la1d 

Moving controls 

¡:,1rm lll<umgcmcnl 

Circlc, Cls, Line, Point, Psct 

EndDoc, NcwPage, Prinl, PrintForm, TcxtHeight, 
TcxtWidth 

LinkExecute, LinkPokc, LinkRcquest, LinkSend 

Addllem, Removeltem, Clear 

Clcar, GetData, GctFormat, GctTcxt, SctData, 
SctTcxt 

Drag, Move 

Hide, Show, Rcrrcsh. Scalc, SetFocus 

Use thc online Hclp or the Microsoft Visual Basic Language Reference to find 
Jcscriptions of thc methods available fo'r Visual Basic objects. 

'-

·-• • 
• 
• 
Cl 

• 
Cl 

~ 

• 
Cl 

Q 

Q 

Cl 

Cl 

4 

4 

4 

• 
• 
4 

4 

.4 

4 

4 

4 

4 

4 

4 

4 

4 

4 

4 

4 

4 
-· 
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Writing Code in Visual Basic 

• .. 
• 
• 
• 
• 
• 
• 
• 
• 
' • 
• 
• 

• 
• 
' 
• 
1 

1 

; 

j 

j 

---=-'-·--~ .. ---

Copy Ctri+C 
Paste Ctri+V 
Past Link 
Dele te Del 

Find ... Ctri+F 
Find Next F3 
Find Previous ShiK+F3 
Replace ... Ctri+R 

Bring to Front Ctrl+; 
Send to Back Ctrl+-

1 lo Grid 

There are severa! facilities built into Visual Basic that makc writing couc casy. All 
of the search and replace proccdurcs discusscd hclow kt yo u search in thc cutTcnt 

procedure only, in thc current module only, or in all modtllcs. 

• Cutting, copying and/or pasting code 

Edit menu, Cut or ,Copy, anu Paste 

· • Finding strings (variable namcs. for exampk) in cmk 

Edit menu, Find 

• Finding the next instancc of a string in ende 

Edil menu, Finu Ncxt 

• Finding the previous instancc of a str·in~ in ende 

Edil menu, Find Previous 

• Finding and replacing a string in ende 

Edit menu, Rcplacc 

• Loading text from the hard disk 

File menu, Load Text 

• Saving codeas text out to the hard disk 

File menu, Save Text 

Note Visual Basic offers a useful feature for pcopk writing ende. By ddault it 
checks the syntax of your codc as you are wriling it. Thi.-.. is good ncws bcc;¡u.-..c you 
get constan! feedback on thc corrcctncss of thc syntax. l!ccmisc thcrc might be 
times whcn sorne pcoplc find this inlrusivc. this oplion ,·:m he disahlcd. 

_ ¡._; 
__ ""t" ___ _ 
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L. String and Numeric Conversion Functions 

ucase$ Function 

p 
m 

~ 
M--=:--.. 

Text1 

Visual Basic proviLics a numbcr of prcwritten functions that makc your work with 
strings a lot C<lsicr. Bclow is a partial list of prewritten functions. Thc focus here is 
on what many rccl are thc most important library functions. For a more detailed 
lisling uf library ltlllclions, see Table 1, "Functions, S!atements, and Methods by 
Progranuning Task" in thc Microsoft Visual Basic ÚmJ.!.Uagc Reference. 

ltcturns Vari:ml Rcturns String 

Chr Chr$ 

Fnrnwl Furmat$ 

I.CoiSl' LCasc$ 

Len l.cfl$ 

Len 

LTri111 LTrim$ 

¡\ 1 id ~liuS 

Hi~hl$ 

Inrim$ 

' 
Meaning/syntax, examplc, note 

Returns a one-character string for an ANSI 
code argument. For example, Chr$( 13) + 
Chr$(10) is a c::miage retum and line feed, 
which creates as new linc. 

A powcrful function that displilys a.numbcr in 
the format you rcquest. 

Retums the lowcrcase insrancc of an uppercnse 
charactcr. · 

Rcturns a spccificd numbcr of the lcftmost 
charactcrs of a string. l~cft$(.rtrin¡.:e.rprcssion, 
n&) Scc onlinc l-lclp fur i.lll cxmnplc. 

Rcturns thc number of charactcrs in a string or 
the number of storage bytes required by a 
variable. 

Rcturns a copy of a stri1~g with lcfunost spaces 
removed. 

Rcturns a string that is pan of anothcr string. 

!\lid$( stringexpressio¡¡$, sum&, 1 /ength%}) 

Rcturns a spccilicd numbcr of thc riglumost 
dmractcrs in a string. 

H.ight$(stringexpression, 11&) 

Returns a copy of a string with the rightmost 
spaces remOved. 

e 
e 

e 

e 

e 
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Returns Variant 

Str 

Tri m 

UCase 

Rcturns StrinJi 

Str$ 

Trim$ 

UCase$ 

Val 

Convc¡1s a numha to ¡¡ !-.lring of lligit~. 

Removes lcatlin~ amltrailing spm:es frnm ;, 
string. 

Rcturns !he uppnt·a:-.e in-.tanL·e of a ltlWt'l\.'a .... c 
dlilr:u.:tcr. 

Conve11s a strin¡; ~ •f l1igi1.., toa numhcr. 

String Conversion Functions in the Employee Data base 
Function 

Chr$ 

LCase$ 

Left$ 

Len 

LTrim$ 

M id$ 

Right$ 

RTrim$ 

Str$ 

UCase$ 

Val 

SulJ proccdurc 

(not uscd) 

(not uscd) 

(not used) 

FiJIFields 

(not used) 

FiJIFields 

cmdOK_Ciick 

FiJIFiclds 

Furm_LocJd 

FiJIFiclds 

(not uscd) 

cmdView - Click 

Fnrm 

J·:MI'DI!.FRM 

1 éM I'DI! .J.'RM 

Alllll'll< rrn.rRM 

ICMI'Illl.I .. RM 

L~ll'l lll.J.'RM 

I:MI'IJI!.I.-RM 

Numeric Conversion Functions 
There are a number of functions availablc within Visu;d Hasic that will con\'Crl dat;¡ 
types. 

Function 

CCur 

CDbl 

Clnt 

CLng 

CSng 

CStr 

CVar 

CVDatc 

Commenls 

Convcns a muncriL" L'.\pn:ssioniH il Curn·•u·y valuc. 

Convc11s ¡¡ numcrir c.\jlh.'Ssion 111 '' tluuhk-ptc~isionrHunhL'I. 

Converts a muncric e.xpression lo :rn lnll'gt·r hy roundin,!.! lhL· 
frac.:lional par1 nf lile L'.\]li'Cssion. 

Converts a numcri~: C.\pn::ssion tu a Long f-l-hylc imegt:J'l hy 
rounding lhe fractional p:u1 of the L')l,prc .... siorr. 

Convcns a numcric e.,pression trr :r singk-prcc.:ision \';duc. 

Convcns a nurncric expression ltJ <r Slrinl! valuc. 

Convcns <t numL·ric nprl'ssion 111 ·"tring In :r V:~ri:llll. 

Convcrts an cxpn.: . .;.sil)tl lt> 11 Vorri<rrrl of VarType 7 fD<rlt:J. 

--="""'---~--'-""'-'-'" ==··. "' ··--·-·-----
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Format$ Function 

Synlax 

Sub Cornmandl_Click () 

'l'extl.'l'ext = Format$ (Now, "d mnunm yyyy") 

End Sub 
~ Form1 mH::ii 

This fum:tion convcns u number toa string and formats it according to instructions 
l"ontaincd in a fonni.lt expression. 

Form<ll$( 1/lllllerit·-expressionf, fmt$ J ) 

fmt$ 
t\ fm111;r1 c.\prcssion is a string of Visual Basic display-formatcharacters that detail 
how lhl' numcric cxpression is to be displayed. · 

llcrc <lll' severa! samplt: formal cxprcssións ami how the output would b€? displayed. 

1:un11:1 1~( l'mt$) Pusitin 5 Ncgativc 5 Decimal .5 
--------

11.110 5.00 ·5.00 0.50 

#.##11 5 -5 1 

}#.##0.1111:1 '>#.##0.11() 1 $5.00 ($5.00) $0.50 

The Now function can be u sed to return the current system date/time as a serial 
nurnhcr. Date/time serial numbers can then be formattcd with date/time or numeric 
form;IJ'. fhl'cau~c date/time scrialnumbcrs are storcd as tloating-point valucs). 
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Example 

Further Examples 

The following are examples of date and time formal~. 

Formal 

m/d/yy 

d-mmmm-yy 

d-mmmm 

mmmm-yy 

hh:mmAMIPM 

h:mm:ss alp 

h:mm 

h:mm:ss 

m/d/yy h:mm 

Sub cmdDisplayDate tl 

Disphty 

1217/SX 

7-DcccrnhL·r-.'iX 

7-Decemh~..·¡ 

J)cccmhcr-:iX 

IIX:50 PM 

X:511:)5 J1 

20:)0 

2fl:50:3.'i 

L.!I7/5X ~O::lll 

txtTodaysDate.Text Format$(Now, ·nun/dd/YJ'"J 

End Sub 

A complete description ofthe Formal$ funclion can he founu in Visual Basic Hclp 

Application 

IconWorks 

Form 

ABOUTBOX.FRM 

COLORPAL.FRM 

COLORPAL.FRM 

ICONEDIT.FRM 

ICONEDIT.FRM 

ICONEDIT.FRM 

ICONEDIT.FRM 

ICONEDIT.FRM 

VIEWICON.FRM 

YIEWICON.FRM 

VIEWICON.FRM 

YIEWICON.FRM 

) 11'CICCdUrc 

Fnrm_l .. uatl 

Txt_R(; ll_ 1 'lo auge 

1 )isploty _Nt·w _Color_ilmJ_Eicmcnts 

Sn \'c_Scll ing.<i _Tct_ 1 N I_Filc 

PHstc_ CJ ip 1 ~~ 1:1 rcl_ Con ten ts 

S:1 n_ Cnlurs __ Tu_l N I_Filc 

( 1rcparc_Fur_Ncw_l..:on 

1 >ispl:t)' _1\ 1 uu.o;t• _ Cuurcl i na tes 

Fnrm_l.cJ;ul 

l.n;ul_ A 11_1 c·uns 

Filc_Filcl ,i.o;t __ J•:~th<.'lmngc 

Furm_lJnl•••11l 

lconWorks makcs cxtcnsivc use ofthc For111al$ runl·lii•IL Thl' alu1vc tahk is ••nly <~ 

partial Iisting. 

lld!•="~'-~--...-.---'·~·-~-oc·~-===---· --·-~·-·- -
• 1 .. •,, 
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Summary 

/ 

• Visual Basic Procedures 

• Scope o! General Procedures 

• Writing Code in Visual Basic 

• String and Numeric Conversion Funclions 

Objectives 
In thi." 111oUule you lcarncd to: 

• Drfi11c importan! charactcristics of Functions and Sub procedures and write 
codc that corrcctly uses both. 

• Uelinc and corrcctly codc for appropriate scope of data. 

• Wrih.: c1H..Ic th<.lt.uscs the common Basic data types. 

•.J 

... 

.... ... 
~ 
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Lab Time 

Go to thc Writing Proccdurcs portion of your lah m;uw;d 

·-._ 

··---. ..:. . . 
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L. Overview 

• Control Structures 

lf ... Then Blocks 

Module 10: Using Conditionallogic and Loops 221 

Select Case Statements 

Do While Loops 

Do U ntil Loops 

For ... Next Loops 

GoTo Statements 

Overview 
Control structures are a crucial pan of any computcr languagc bccause they cnabk 
systematic decision making within the codc. In this module you willlearn how to 
control the logical. flow ofyour program. You will al so lcarn how to mark off 
blocks of code that are to be executed if a specificd condi1ion is 1ruc or false. You 
will also learn how to specify thc nuinbcr of limes thal a ~ivcn block of statcmcms 
is to be executed. 

Prerequisites 
This module assumes a fairly dctailed undcrstamling or l'oding mcclwnisms in 
Visual Basic. You will o1lso nccU proficienry in d~SÍJ:!IIin~ ;u'¡d huiltling tiH.· usl.'r 
interface for ~oftwarc applic;.llions. You shnuld :tln.:ady lw familiar with: 

• Forms and propcnics 

• Statemcnts, Sub proccdurcs, amJ Function procedttrl:\ 

• General and eve.nt procedurcs, as wcll ;ts 111ethods 

• Visual Basic data typcs 

• Variables and constants 

• Use of thc MsgBox$ statcmcnt amJ concttll'ntttin~ :-.lriti)-'S 

• String handling functions 

Overall Objective 
At the end ofthis module, you will be ablc lo wrilc cmk lhal provides syslcmalic 
dccision making within an applic:nion. 

. -.. ~· ..; 

i' 
: . 



222 Module _10~ Using Condi.:_ti.:_on.:_a,_I.::_Lo-'g'-i'-c :_•n,_d_L:.o.:_o_cp_s __________________ _ 
>) 

Learning Objectives 
Al !he cml of this module, you will be able to use: 

• lf...Then,.Eisc blocks 

• Sl'leét Case s\atcments 

• Do \V hile loops 

• llu lll1tilloops 

• l'ur. .. Ncxt loops 

• (~oTo statCilll'nls 

---------- ---
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I, Control Structures 

• lf ... Then Blocks 

• lf ... Then ... Eise Blocks 

• Select Case Statements 

~!ftt:: .. c.~ .. . -· .. -.- -- ---------·-. /¡ 
-----~- ........ 
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lf ... Then Blocks 

Example 

lf condition Then statement 

lf condition Then 

statements 

End 11 

Thc foil shows that therc are two possible arrangements for If ... Thcn blocks. You 
can usc cithcr a single Jinc or multiple lines containing multiple statements. If you 
h;n'L' nHJÚiple slaiL'Jllents. you JH!CU lo use End lf. 

Operators 
Thl!re are six opcrators that you can use in the condition portian of the If ... Thcn 
olock. 

( )pL·r:~lor l\"lc<lning 

= Equal 

<> Not equnl 

< Lcss than 

<= Less than or equal to 

> Greatcr than 

>= Grcatcr tllan or equal to 

Note In this case thc:: opcrator is 110t being used for an assignment statcmcnt, 
such as: Readout.caption =.·o.·; instcad it is being used foraconditional test. 

If OJ•tFullTime.Value = TRUE Then PositionType = "Full Time• 

Examples in the Employee Database Code 
For" list of cxample lf ... Thcn blocks, If ... Thcn ... Eisc blocks, and Sclcct Case 
st:ltellll'llts in thc Employcc Databasc codc, see thc listing al the end of this module. 
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lf...Then ... Eise Blocks 

IF condition 1 Then 

statementblock 1 

ELSEIF condition2Then 

statementblock2 

ELSE 

statementblockn 

ENDIF 

Here you get a chance to test for severa! diff'crc111 situ;nions anLl rt:act appropri;1tely 
to each one. Adding Elsc to the Jf ... Thcn swtcmcnt pro vides much more llcxihility 
in the response. 

Walk Through-lf...Then ... Eise Example 
I, To use thc If ... Thcn ... Eise statcn1cnt 

l. From the Walk Throughs program group, stan )11;1sc. 

When the application starts, thcre will be a forrn with "chcd box labeled Buld 
with an X in it anda command bulton l;1hclcLl Print Somcthing. 

The purpose of thc applic:-~tion is lo show anl':cllnpk ,,f wlll'l"!.' ;¡n 
If ... Thcn ... Eisc block might be uscd. 

2. Click the Print Something cornmand butl;>n. 

The word "Something" will <~ppcnr onthc fnnn in hold. 

3. Click the Bold check bux . 

. This removes the X from thc check bux. 

4. Click the Print Something command butlun. 

The word Something will nppcar on thc fonn with thL· hold format removed. 

5. Close IfEisc. 

L To crcatc thc H ... Thcn ... Eisc cxamplc 

l. Start Visual Basic. 

2. From the File menu, choose New Project. 

S!arl a ncw projcct. 

..• · 

' '1 
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.l Sclcct Fontllo\J on the Properties list box. 

Vil'w lllt: Form propcrty FontBold. Note that thc default value is Truc. This 
"'"'"" when thc chkBo\d check box is created, its value should be set to 
ChcckcJ. 

4. Dtouh\e-click the check box too\ in the Toolbox. 

Crcate a check box on the form. 

). Sct the foÚowing properties for the check bo~: 

N;nnc chkllo\d 

Valul' 1 - CheckeJ 

h. l>ttllhlc-c\ick 1hc command bunon too\. 

7. Sl'l ihl' t'o\lowing pmpc11ics for thc command button: 

NalnL' CllldPrintSmnctlling 

l)rint Somcthing 

Nuw that you ha ve createJ the interface, you need to add the code to make it 
functil111. 

X. hum the Prujcct window, ciloose Vie~ Code. 

Y. lnthc Object.list box, se\ect chkBold_Click. 

111. Add the fo\lowing code: 

c .. r.st CHECKED = 1 

Tf r:hkBold.Value = CHECKED Then 

F'orml.FontBold TRUE 

El~~ 

Forml.FontBold FALSE 
En< 1 l f 

Th is wi 11 cause the font to be ·set to bo\d or not, depending on how the user has 
se! !he check box. 

1 l. In thc Objcct list box. sclcct cmdPrintSomething_C\ick. 

1 ~. 1\dd !he following: 

!'r i 11r "Something" 

This will print thc word Somcthing to the form. Depending on the value ofthc 
chl'rk hox, il will h~ in bold rormat or noL 

]...¡_ ¡:ll•lllt.he Run lllL'IIll, chuose EnJ. 

1 ). ht•lnthe Fik llll'llll;chonsc Savc As. 

111. S;",. the lúrlll :t.s IFELSE.FRM in \WALKTHRU\LOG!C. 

17. S:"·,· lit•· ptuj•·,·l :IS IFJ:I.Sl:.Mi\1< in \W i\LKTHRU\LOG!C. 

·• 

' ' 
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Select Case Statements 

Select Case testexpression 

Case expressionlist 1 

statementb/ock1 

Case expressionlist2 

statementb/ock2 

Case Else 

statementblockn 

End Select 

Select Case statements Jook a Jot Jike Jf ... Then ... Elsc hlocb. <~mi thcre is '' goml 
reason for this: Sclcct Case statcments nffcr the same ~ind or functionality hut in" 
much more efficient-for both thc cotlc ~111d the cmJcr rnanner. As you can SCL' 

from the example, Sclcct Case statc~1ents WtJ.rk pa11inrbrly WL·II as a mean.s l"t1r 
handling structured choiccs offcred to the user. 
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Walk Through-Coding a Message Box with a Select Case 
Statement 
In anoi11er module. you creatcd a message box that prompted use~s to save their data 
prior lo closing Lile application. This message box allowed users three choices: Y es, 
No, ami Cancel. 

Tilis n1odule has prnvided tile tools needed to write code to detcct wilich buuon the 
uscr.rlil·kcU: the Sclcct Cnsc statcment. 

I To cude a mcss.agc hox n·ilh a Sclcct Case statemcnt: 

l. Starl Visu~1l Basic . 

., Frnn1 the File mcnu, choose Open Project. 

.1. Op<'ll MSGJ!OX2.MAK. 

This file is loc:ncJ in \WALKTHRU\LOGIC and should already contain tilc 
l'ttllc,wing: 

SuJ, t:cmtrnandl_Click () 

The values for MsgBox constant declarations 

~ame from \VB\CONSTANT.TXT 

t-lsgBox parameters 

Const YESNOCANCEL = 3 Yes, No, & Cancel btns 
l'nrlSL JC'OtJ(J!H·:STION : 32 Warning query 

MsgS = "llave you saved al! your work?~ 

MsgBox MsyS, YESNOCANCEL • ICONQUESTION, ·MsgBox WalkThru• 
1·: 1 1 ' 1 : ~ 1 1 ¡, 

111 111 dcr tti gct tllc buttons to rcsponr.J appropriately, you nccr.J to ar.Jd a numbcr of 
si:Jicmcnts lo lhis. Do tilat by declaring a variable and severa! constants. 

.f. _In dl'sign mmlc, r.Jouble-click thc command button on the form. 

Tllis opens thc CoUc window witll the event procedure code in it. 
' 

'\. Add tile following ende to thc Codc window: 

CUIL"'· CANCEl. =; 2 

C'JII.c:' 'lES :: 6 

Cur1;''· NO = 7 

Di u•. r.HI _Respons'J As Integer 

Tlll' l';¡nccl, Y cs. ;~nd N<, dcclarntions dctine more: meaningful names for thc 
v;tlttcs tlwt are rcturncd for cach of the buttons. For example, if thc user clicks 
lhl' No hutton on thc mcssagc box, thc value 7 is returned by the system. For 
mde rcadabiliLy and mainLainability, you should place Const dcclarations in 
yommue anu use Lile constants in the Sclcct Case statement. Remember, you 
can li11d Lile c<>JTcct values LO declare in \VB\CONSTANT.TXT or by scarching 
""linc J·lclp/úr Lhc Lopic Msgllox function and checking-the table of return 
valtiL'S. 
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In the earlier message box example, you crco1tcd <.1 ntt:~sagc hox by calling thc 
MsgBox statement. Even though you cre;.Hcd a mc:-.~;1gc box with thrcc button ..... 
you had no way to tell which button the user clicked. Another way to crea te a 
message box is to callthe MsgBox function. In thi:-. l·:•sc, you nccllto Jcclarc <~~> 
Integer variable to receive the value the l\1sgBox function returns. 

Next, you need to alter the MsgBox statement, making it into a runction cal l. 
Remember. when you calla fun~tion you must assign its rctmn va\uc tn tilL' 
appropriate type of variable. If you pass the functitlll ;•ny argumcnts. lhe 
argument list must be enclosed in parcntheses. 

6. Edit the original MsgBox statcment so that it rcaJs: 

MB_Response = MsgBox (MsgS, YESNOCANCEL .. ICON(!I.JI :-;TION, 

A·MsgBox WalkThru•J 

Now you necd to add thc Sclccl Case statcmcnt. Younwy wantto add only thl' 
aclual code and lea ve lhe commcnts out. 

7. Add the following code: 

' When an integeT val u e is return~cl l1y MsyJ:,,.- : •n,,., i •d: 

Select Ca•e MB_Respcnse 
' if it matches the value of thf· Const. ·,·!· .. ·. r•,¡. 

Ca•e YES 
' .indiCille th.-aL Ltu~ u~;•.:r • 1 i··~··d r ¡, .. 

Print •user clicked Yes" 

1 ,, ; 1 1 "1' 

if it matches the value of the CrmsL IJ•· r·¡¡. 

Ca8e NO 

' indica te that the user el id ... ncJ tl1•· r·I" h•JI t •lll 

Print •u•er clicked No" 
if it matches the value of t.h•· ("r,nsL ,·;,¡JJ"t·:r. '/ 

Caee CANCEL 
' indicate that the user clicY.":d t.h'· ,·,.rwr-1 , .• ,t.ton 

Print •ueer clicked Cancel" 

End Select 

8. From the Run menu, choose Start. 

Test the code. of your application. 

9. From the Run menu, choosc End. 

Close the application. 

End the walk through. 

Examples in lhe Employee Qatabase Cede 
Form 

EMPDB.FRM 

ADDPHOTO.FRM 

Pruccdun·/Houtinc 

FiiiFiclds 

cnul Del ele_ ( :1 id.; 
FiiiFiclds 

cnu!O J(_ Clirk 

Cuntrul strudurc typt• 

lf. . ."rtu:n 
f f. .. 'f'ftl'II ..• Eist• 

Sl'lt•rl COISL' :o;!<llLIIII:Ill 

Sclt.•t'l Case .slatcntcnl 

1 f'. •. Tht•n ... Eisc 

,, , .. 
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L. Loops 

• Do While 

• Do Until 

• For ... Next 

1 

m .~--'?[ - -· 1 CCJCW & 



Do ... Loop 

Do While condition 

statements 

Loop 

-Or-

Do 

statements 

Loop While condition 

' 
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Use a Do ... Loop to execute a block of statcmcnts an i1Hk·finitc number of times. 
(By contrast, For loops let you spccify how many tim~s 11 sct or statcmcnh are 
executed.) In Do ••• Loop Whilc loops thc numbcr of timl'S thc loop is cxecutcd is 
controlled by a True/Falsc condition. Whcn somc othcr l'-vcnt switchcs the valuc 111 
the condition from Truc to Falsc, thc looping stops. 

What's the Difference? 
The location ofthe Whilc condition is thc key diffcrcnn· hctwccnthc two cxampb 

\ of syntax above. but what docs thatmcan? lf thc \Vhill' conJitiun is at thc top of thL' 
block, the Statements within thc loop wii\ lllll be CXCCUIL'd i f thc Ct Hlllition ÍS faiSl' [e 1 

begin with. The block of statcmcnts will always be excnotcd at leas! once if thc 
While condition is placed at the bottom of thc loop. 
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Walk Through-Coding a Do While Loop 
L, Tu codl· a Do \\~hile loop 

J. Stan Visual Basic. 

Fro1n thc File mcnu, choosc Ncw Project. 

, Douhk-click lhe command bullan loo! in lhe Toolbox. 

1\ t'ununllnd. but\On appcars onthe form. 

~- l>ouhh.>click thc command button on the fonn. 

ll1i" wi\1 open the command button Code window. 

4. i\d;l 1 he following code lo Forml.frm: 

Do While 1 <= S 

Print 

Loop 

Errd ;:qh 

I "' 1 • 1 

). 1:1rrn1 lhe Runmcnu, choo~c St~u1. 

Run the applic;!\iun. 

(). Fn rn1 thc Run mcnu, choosc End. 

b~tllhl' walk through. 
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Further Examples 

Do ... Loop 
Do .•• Loop Untilloops are almo~t idcntica/to l>u ... Luop \Vhilt·. hut thcy test to Sl't' 

if condition is falsc rathcr than tn1c. 

For further examples of ... Loop Whilc, scc thc followin~. 

Applic~1tinn 1\:ludulc/Fnn•• 11nlt't'CIIII't•fl{cnllilll' 

lconWorks /CONWRKS.IIi\S lldp Filc_ln_Palh 

Walk Through-Do ... Loop While with Lists 

L To use Do ... Loop Whilc with lisis 

l. From thc Walk Throughs program group, start Do \VI Ji le. with Lists. 

When the application stat1s, a form witll a list box 11nd a Ctllnlnantl buuon 
labeled Add To List appears. 

The purpose ofthe application is to show ;uJ cxarnplt· ~>f usin!-' a Do ... Loop 
Whilc structure. 

2. Choose the Add To List button. 

An input box will appcar prompting thl' tiSL'r to add :u1 itcmto thc list h11.\ . 

. 3. Typc sorne tcxt and choosc OK. 

The textjust typed in the tcxt box will he iiddcU as a11 itcmto the list on the loop 
example form. 

4. Repeat the above step severa! times. 

Note that if you add more itcms to thc list than can hl' displayeJ at OIK'l' in tlw 
list box. a venical scroll bar will automath.:ally he 111hkd to ;dlow you 111 vicw a ti 
itcms. In the case of this cxamplc. you JJHtSI aJJ al h·••-"1 SL'VL'Il itcm:-. ¡,¡ tlJL' li .... t 111 

make a scroll bar appear. 

5. Quit the application. 

L To use Do Whilc loops in list proccssing 

l. Start Visual Basic. 

2. From the File menu, choose Ncw Projccl. 

Stat1 a new projcct. 

3. Set the following properties: 

Caption 

Height 

Width 

Left 

Top 

Do Loop Whi/e Examplc 

4035 (approximately) 

3870 (approximatcly) 

5565 (approx imatcl y) 

1290 (approx i mate/y) 

4. Doublc-click thc list box too/ in thc Too/hm. 

Creme a Jist box on thc form. 

. : ! .. ~ 
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5, Setthe following propenies: 

Hcighl 1455 (approximately) 

Width 1 1215 (approximately) 

, Lefl '160 (approximately) 

Top 360 (approximatcly) 

(,_ Doublc-click thc command button tool in the Toolbox. 

Crcatc a commo.mt.J button. 

7. Sct thr.: fol\owing propertics: 

Nanu: cmdAddToList 

Caption Add to Lisl 

Hci~ht 37.~ (approximatcly) 

Width 1215 (:ipproximatcly) 

Lcli 1080 (approximately) 

Top 1 Y20 (approximately) 

Now that you ha ve created thc interface, you necd lo add the code to make it 
rum:tion. 

X. Fromthe Projcct window, choose View Code. 

<J. In the Objcctlist box, sclect cmdAddToList_Ciick. 

1 O. Add the following code: 

Dim Response As String 

Do 

Response = InputBoxS ( · I tem to add: •, • Add Item•, 

Jí Response<> •• Then Listl.Addltem Response 
Lu••¡• While Hespan se <:> • • 

o. 1000) 

By crealing a Whilc loop with the test al the bottom, you ensure going through 
thc loop once lo prompt for input, befare any conditions are tcsted. 

An input box is similar toa mcssagc box, except it contains a text ticld for uscr 
input. Thc arguments for thc in¡)ut box are: 

Arg 1 = Prompl 

Arg2 =Tille bar caption 

Arg3 = Dcfault valuc for tcxt box 

Arg4 = X-position for input box 

Arg5 =Y -position for input box 

An lf test is ¡¡dJcd so thatthc cmpty string that indicates the user wants to exil 
lhc loop willnot be addcd asan item in the list. 

Kccp this projcct opcn, becausc in jusl a moment you are going lo add a Do 
Uulilloop. 

11, Test ymtr ende. 

F~~tl thl' walk thmngh. 
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Do Until 

Do Until condition 

statements 

Loop 

-Or-

Do 

statements 

Loop Until condition 
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Do Untll is the opposite of Do Whilc. The statements in a Do Untilloop are 
executed only while the condition is Falsc. A Do Until condition is the equivalent 
of a Do While Not condition. 

Walk Through-Do Until Example 
I, To use Do Until 

l. From the Walk Throughs progr.nn group, start Do lJntil. 

This is an enhanced version of thc prcvious Do While cxample. When tl1c 
application statts, a form with a list box, a commanJ hutton labeled AJd To List. 
and another command button labeled Clear List appear. 

The purpose ofthe application is to aJJ an example oi' using a Do Untii 
structure. 

2. Choose the Add to List button. 

An input box wiii appcnr prompting thc uscr to <~dd 1111 itcm 111 thc list hox. 

3. Type sorne text and choose OK. 

The textjust typed into thc tcxt box will be aJJcJ asan itcm to tlle list on thc 
Loop Example form. 

4. Repeat the above step severa! times. 

Add severa! items to thc list. 

5. Choose the Clear List button. 

All items will be clearcd from thc list box. 

6. Quit the application. 
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I To crc.,le lhe Do Unlil cxamplc 

l. Stan Visual Basic. 

Makc surc that you are still working on thc Do Whilc walk through. 

2. Sct thc following propcnics for the form: 

Caption Loop Examplc 

·}. Double-click the command button too! in the Toolbox. 

Crea te another command button. 

4. Sct thc following propCitics of the commanú button: 

N tune cmuCicarList 

Capli(lll Clcar List 

Hcight 375 (approximately) 

Width 1215 (approximatcly) 

l.cft 1 OXO (approximately) 

Top 25211 (appruximatcly) 

Now that you ha ve crcatcú the interface, you nced to add the code to make it 
runt:titm. 

5. Frwi1 thc Project winúow, choose View Coúe. 

h. In thc Objcct list box, sclcct cmdCiearList_Ciick. 

7. Adú the following code: 

Vu Until Listl.ListCount O 
J,i sll.Rcmoveitem O 

1 •""1' 

A Do Unlilloop can be u sed to kecp removing items from List 1 until thc list 
box is cmpty. Thc ListCount propcrty keeps track of the number of itcms 
currcntly in Lhc lisl. 

lnsiLic the loop is a statcment to callthe ncmovcltcm mcthod. Whcn you ¡)ass a 
zcro to H.cmo\'cltcm, you are tclling it to remove the top ítem in the list. 

Rathcr than setting up a loop, you can clear an entire list box with the clcar 
mctlu,J. 

L.isLI.clear 

K. From the File menu, choose Save File As. 

Savc this file as DOUNTIL.FRM and the project as DOUNTIL.MAK in the 
\WALKTHRU\LOGJC subdirectory. You will need these files in the For Loop 
!ah. 

Eml the walk through. 

• 

• 

' 

. ' 
•• 
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For counter= startTo end[ Step increnient] 

[ statements] 

[ Exit Fof] 

[ statements] 

Next [ counter] 

For ••• Next loops are used lo cxecute a block of stntcments a fixed numbcr of times. 
The key difference betwecn a For ... Ncxl loop anda Do ... Loop is that a For ... Ncxt 
loop includes a counter that incrcascs or dccrcascs with each rcpetition of thc loop. 

Complete the demonstration for an examplc of For ... Ncxt loops. 

Walk Through-Using Visual Basic For ... Next Loops 
L To use For ... Next loops 

l. Start Visual Basic. 

Open Visual Basic. Opcn a ncw form. 

2. From the File menu, choosc Ncw Pr<>.jcct. 

3. Double-click the command button tool in thc Toolhox. 

This will open the command button Codc window. 

4. Add thc fr.'lowing codc inthc Cmlt..: wintlow: 

5. Add the appropriatc codc to thc Comntand I_Ciick cv,·rll: 

Sub Commandl_click (J 

Dim I As Integer 
ror I = 1 to 6 

Print I 
Next I 

End Sub 

6. From the Run menu, choosc S tan. 

Test the application you ha ve crcatcd. Thc dcfault value for Stcp is 1. The 
application prints thc numhcrs 1 thro11~h (> nn !he forrn. · 
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7. From !he Run menu, choose End. 

H. In !he Code window, change the Slep value to 2. 

Y. From !he Run menu, choose Start. 

Tes! !he applicmion aga¡n. 

How has !he outpul you are gc!ling changed? 

How would you change !he For : .. Next loop to display only e ven numbers? 

1 O. Fromthe Run mcnu, choosc End. 

EnJ !he walk lhrough. 

A more sophistiC<ItcJ use of thc For ... Next loop can be found in Visual Basic Help. 

' 
4 

S 

6 

7 

8 

9 

10 
11 

12 

13 

· f''or ... N ex t Sta temen t Example 
:~•JI• ForNext.!l<'lnO () 

End 

NI.$" Clu${1)) ,. Chr$110) 

For Repl = 5 To 1 Step -1 
' Define newline, 
' Set up five repetitions. 

Equate alphabet to numbers. 
For Indx" = Ase {~A~ J T" Ase ( ~z·) 

' Append eaeh l.etter to s tring, 
MsgS = MsgS + ChrS(Indx\) 

Next Indx% 
MsgS = MsgS + NLS 

Next Rep% 
MsgBox MsgS 
Sub 

Add newline for each rep. 

Disphy results. 

Nutice that one For .. Ncxt lc.;p is "neste;J" inside the other in this example? This is 
a powcrful too\ for processmg multiplc rows or columns in arrays. 

lf you wunt to scc this code running, fo~!ow the dircctions detailed above and make 
thc appropriate mmlilications to the codeso that it cxccutes as the r~sult of a 
colllnland hutton hcing clickcLI. 

u 
~ ~. •J--
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Further Examples 
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Walk Through-Another For ... Next Loop Example 
I, To use another For ... Next loop 

l. From the Walk Throughs program group. slart ForLoop lo Clcar Lisl. 

This is an enhanced version of the prcvimiS Do Whilc cxamplc. Whcn thc 
application starts, a form with a list box. a cnrnman~ hutton labelcd A~~ Tn List. 
and another command button Jabeled Clcar List appcar . 

The purpose of the application is to change lhe examplc tn use a For ... Ncxt loop 
to clear the list. 

2. Choose the Add to List button. 

An input box will appear prompting the user to add an itern 10 the list box. 

3. Type sorne text and choose OK. 

The textjust typed into thc text box will be added as :111 itcmto lhe Jist nn the 
loop example form. 

4. Repeat the above step severa! limes. 

Add severa! items to thc lis!. 

5. Choose the Clear List button. 

All items will be cleared from the Jist box. 

6. Quit the application. 

I, To crea te the For ... Next loop cxamplc 

J. Start Visual Basic. 

2. From the File menu, choose Open Projccl. 

3. Open DOUNTIL.MAK. 

Open the project from the Do Until Walk Through. 11 is locatcd in thc 
\WALKTifRU\LOGIC subdircctory. . 

4. From the Project window, choose View Code. 

5. In the Object list box, select cmdCJcarList_Ciick. 

6. Replace the existing code will>: 

Dim I As Integer 

For I = OTo Listl.ListCount-1 

Listl.Removeltem O 
Next I 

You can use a For ... Ncxt loop to kccp rcmoving itcrns fmml.ist 1 untilthc list 
box is empty. In this case, thc rangc for thc loop will he fmm O (the top itcm in 
the list) to ListCount- 1 (thc Jast ilcm in thc list). 

Inside the loop is a statement toca JI thc Rcmovcllcm mctho~. Whcn you pass a 
zero to Rcmovcltcm, you are tclling it to remo ve thc top itcm in thc list. 

For further examples of a For ... Ncxt loop scc: 

Applicnlion !'vl1uluk/Fnn11 J•n tft'llll n·/ltuul i m· 

~111ploycc Dutabasc EMI'DIJ.I'I<M 
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The GoTo Statement. 

Style Guidelines 

Further Examples 

.·.;-

/. 

(;oTo Gtuscs cxccution Lo jump from thc GoTo statement to anothcr location 
markcu by a labcl or linc number. 

E ven though thc \.oTo statcmcnt docsn't cnjoy much favor these days, Visual Basic 
suppmts it, amJ thcn.; are severa! pillees whcrc thcrc is t.lll obvious use for it. Error 
hanuling is a particularly good cxamplc. 

Note (;uTus ;m: not Jikc proccJurcs; thcrc is no stuntJ¡¡rd rcturn from a GuTo as 
thcrc is from <.1 proccdure. 

• Eae!J linc labcl must bcgin with an alphabctic charactcr. 

• L;wh linc l:llwl must cnd with ¡¡colon. 

• l·:;tch linc l;d,l·lnnlst he uniquc within its own module. 

• Fach linc lotlll'll·an ha ve no 1norc th¡¡n' 40 ch;trilclcrs. 

• l>u not use Visual Uasic kcywunJs in linc labcls. 

• Linc labels urc not case scnsitive. 

• A linc labclmust start with thc lirst nonblank charactcr on a linc, but it need not 
be in the lirst column. Visual Basic forces it to the Jeftmost column. 

Examples 
Auditional samplc code is Jocatcd in Visual Basic Help. 

For further examples of GaTo statements see the following. 

Applkatiun 

lltiiiWLII~.'i 

E111¡Jic'Y.l!~ Oatabasl! 

Modulc/Form 

ICONWRKS.BAS 

EMPREC.FRM 

Proccdure/Routine 

Validatc_FilcSpcc 

AddEmp 

~~_.-----------------------~-----

" ' • 

~ 

~ 

~ 
'!!! 
~ 

~ 

~. 
·~ 

ll!f 

• 
1 
~ ., 
J 
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Summary 

• 

·.,· 

• Control Structures 

lf .•• Then Blocks 

Module 1 O: Using Condilional Logic and Loops 

Select Case Statements 

Do While Loops 

Do Until Loops 

For ... Next Loops 

Go To Statements 

Objectives 
In lhis module you Jeamed 10 use: 

• If ... Then ... Else blocks 

• Select Case slatements 

• Do While loops 

• Do Untilloops 

• For ... Ncxt Joops , 

• GoTo statements 

241 

---· __________ ,:_~J 
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Lab Time 

Go lo thl· Conditional Logic amJ Loops portion ofyour lab manual. 

i 
. ;'1 
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L. Overview 

..• · 

• Debugging Terms 

• Debugging Code in Visual Basic 

Using the Call Tree 

Using Watch Variables lo Monitor Program Execution 

Overview 
Visual Basic offers programmers of all skill le veis a sct uf robust tools to use during 
application development. 

Prerequisites 
Prior to starting this module, you should airead y be familiar with: 

• Controls, forrns, and propenies 

• Function and Sub procedures 

• General and event procedures 

Overall Objective 
The overall objective of this module is to introduce yo u 1t1 so me of thc most use fui 
debugging tools availablc in Visual l3asic. This is nol in tended lo be co111prchcnsivc 
treatment of debugging techniqucs in general. 

Learning Objectives 
At the end of this module, yo u will be ablc tu: 

• Distinguish among run, dcsign, ami dchu!! moJes in Visual H:tsic. 

• Use the Watch window to display thc cuJTCill val u¡;~ Df variahlcs \\'ithin a 
program. 

• Set breakpoints within code. 

• Single step through application proccdurcs . 



1 

i 1 

'· 1 
1 

246 Module 11: Debugging Cede in Visual Basic 

Debugging Terms 

..• · 

• Watch Expressions 

• Watch Point Variables 

Watch point-break when true 

Watch point-break when changed 

• The Debug Window 

The lmmediate pane (?, =) 

Watch pane 

Watch Expressions 
A watch cxprcssion is a variable whose value is displaycd in the Debug window 
wlu::nt·vcr a program cntcrs break mode. 

You can sct a watch cxprcssion by opening the Dcbug menu and choosing eithet 
AJJ Watch or EJit Watch command. This can be done in either design mode or 
break nuHJe. 

Watch Point Variables 
A watch point variable will cause a program to enter break mode whenever the 
watch point condition is sat~sfied. 

You can .sct a watch point variable by opening the Debug inenu and choosing either 
thc Add W:llch or Edil Watch command. This can be done in either design mode or 
hrl'a~ 111lllk:. 

Watch Pciint-Break When True 
This w;¡tch point variable will cause a program to enter break modc whenever the 
variahll' · s valut.: h~.:comcs truc. 

Watch Point-Break When Changed 
This wa1ch puinl variable wi\1 cause a program to cntcr break modc whcncvcr thc 
variahlc's V<J/uc changcs. 

The Debug Window 
Thc Dchug window is broken into two pans: the Immediate pane (the lower halfof 
tlll' windo\\') and thc Watch panc (lhc uppcr hall). Thc lmmcdiatc panc is whcrc ymi 
c;m havl' :111 interactivc cnnvcrs;1tion with thc dcbuggcr using cilhcr thc qucstion 
111ark t'!J ·~r the cqual sign (=). The Watch pane is where the watch variables are 
tli~playl'Ll Uuring hreak moJe. 
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Debugging Code iti Visual Basic 

Instan! Watch ... 
Edil Watch ... 
Ca lis 

Single Step 
Procedure Step 

Tounle E5!Cf¡:(p:):n! 

Cloar f\11 B: eakpC.'ii'L 

Using the Visual Basic Debugger 

Shift+F9 
Ctri+W 
Ctri+L 

FB 
Shift+FB 

This module is actually made up of a number or walk throughs that introduce you to 
the various tools available within thc VisuaiiJasic dcbugger. 

Walk Through-Using the Call Tree 
2, To sec thc first sample application work 

l. From the Walk Through program group, st:u1 Dchug l. 

2. Click the Call Procedures command button. 

3. Observe the output generated on the form. 

¡¡j Debug -Ca ti U al Exerclse •' ·. . ' ' • El 
Stert Calling Pn>cedure• • Commendl_Ciid<. 

Thit it ProcedUfe A 
Celling Proceduu: O 

T hiJ it P10cedure 8 
Calling Pmcerluu: C 

T hit i1 l'mr.eduu: 1: 
Relumiuu hum f'ru~;o:tlwo: C 

Reluuting hom Procedwe H 
Returning hom ProcedUie A 

Retuminil hom Command1_Ciiclo. 

Note that Commmull_ Click c:llls Pmccdtttt' /\. Prr H 't'r h trc 1\ -i:a lis Pron·dmc H. 
and thcn ProccdurciJ calls l'roccúurcC. 

4. Choose End. 

' ¡ 

i 
i 
1 ¡· 

1 

' ' 1 ' 
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L Tu examine thc ende for the walk through 

Thc purpose or this walk Lhrough is lO introduce you lO two tools that you will Jind 
vcry uscful: lhc Call window and single stepping through code. 

l. Starl Visual llasic. 

2. Opcn the DEIJUGI.MAK lile located in \WALKTHRU\DEBUG. 

J. Sciccl MOD I.BAS in Lh' Project window and click View Code. 

4. From Lhe Proccdurcs drop-down list b?x• select ProcC. 

5. Examine thc cude for ProcC. 

As il stands, this procedure prints two statements at column 49 on your form. 
Thc olher thrce lines are "commented out." 

6. Remo ve the three comment marks in front of the Stop and Print statements. 

Whal will happen when you do this? You have added three new statements to 
thc application. The first one prints a message to the form at column 40 that tells 
you the application is going into break mode. The second statement actually 
slops lhat ;tpplication using Stop. Thc final statcmcnt prints a mcssagc to thc 
/"onn that tclh you that yuu ha ve cntercd singlc·step modc aflcr prcssing FH 
twicc. · 

7. holllthc Run1ncnu, choosc Start. 

X. ('lid thc C;lll Procct.lurcs commam.l buuon. 

lf yo u m ove thc Codc window from on top of Form 1, you will see thatthe out pul 
is slightly changcd. Now il should look like this. 

Oebug • Coll Ust EKerclse 11 
Sle1l Callir'9 P¡oc:edufca · Co-ndl_Ciick. 

HM• ia P1oc:eduro A 
Calling P•ocedu!e B 

Y hit ia P1ocedure D 
C611ing P•oc:ed"'e e 

Thia ia P1ocedufe C 
Goiog lnlo Break. Wodo 

9. Fn•ntthc Dchug mcnu, choosc Co.~lls. Now you shouiU scc a formlike this. 

,,.:. . · . · . · Celia 

Notice thatthe calls are listed with the most recently called at the top. 

'. 

' 

• '• 



' " 

Module 11: Debugging Code in VIsual Basic 249 

10. Click the Show command bullan. 

This retums you to MOD I.BAS. 

You should sec thc codc for ProcC with a box around thc coLic linc containing 
the Stop statement. 

11. Single step by pressing FB once. 

This will start you single stepping through the rest ol' thc proccJurc. This makcs 
Print •aoing into single Step Mode" thc next st~ttcment to execute. 

' 
lf you position both windows so that you c:m see almost all or them, you will sec 
Visual Basic work as you single step through the application. 

12. Press F8 one more time. 

This executes the current Print statemcnt ami m;:~kcs Print. "Returning from 
Procedure e· the next statement to executc. 

13. Press F8 a third time. 

This executes the currcnt l'rint statcmcnt (check thc output on thc fonn) and 
makes the End Sub statement the next statcrncnt to exccutc. 

14. Press F8 a fourth time. 

This executes the End Sub of ProcC and takes you to thc ncxt statement to 
execute in ProcB, which is the Print "Returning from Procedure a~ 

statement. 

15. From the Debug menu, choose Calls or prcss CTRL+t.. 

Note the most recen! proccdurc is now ProceJure B. 

Doing this verifies that the calllist has changéLI sincc thc n.~turn from Pro~C. 

16. Click the Show command bulton to rcturn to Procll. 

17. Press F8 a fifth time and thcn a sixth time. 

This takes you through the rcmaining two Procctlurc B statcmcnt.s and takcs you 
tothenextstatementinProcA-Print "Returning from Procedure A". 

1 R. Press PR twicc more. 

This single steps you through thc rcmaini11g ProccdurL' A st;Hcmcnts ;.uH.i takcs 
you to the next statement in CommamJ I_Ciick- l'r i 111 .. ¡¡, ~1 llrnin~¡ f r 0/H 

commandl_Cl ick •. 

19. Press F8 twice more. 

This takes you through thc rcmt1ining thc CLIJJHll<nld 1 .. CiiL"~ evcnt proccdure. 

20. From the Run menu, choosc Break. 

21. From the Debug menu, choose Ca lis. 

Notice that no calls are listcd. Thnl is beca use no Suh or Function proccdurc is 
currently "opcn" and your application is in iJic waiting for thc uscr to <.lo 
something. 

22. Choose the Clase command button on thc Ca lis Jialog lmx. 

23. From the File menu ofVisual Basic, choosc Exit. 

) f you WUilllO try this CXCI'Ci:-iC <1 SCC(JJld l j Jl H.!, du IH ll Stl VC tllL' chall!!L'S IL 1 l hL' 
lilcs. · 

' . 
,' •. ¿~ • 
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Walk Through-Using Watch Variables to Monitor 
Program Execution 

· Debugging Applications 
Dchugging applications is somewhere belween a science andan art. By careful use 
of your úcbugging tools, such as breakpoints, walch variables, single slepping, and 
proccút;rc slepping, you can zcro in on lhe logical bugs exisling in your code. 

This walk through applies breakpoinls and walch expressions lo locale a number of 
logical crrnrs containcd within the code. 

L To scc the sccond debugging application run 

l. From the Walk Through program group, slart Debug2. 

2. Click thc Print File command button. 

Yo11 gct out pul that Jooks like this. 

111 20 JO 40 su 

1 2 3 4 5 

1UU 50 25 75 2110 

10 9 8 7 6 

11 22 33 .u 55 

um of alllolall • O 
vg ol alltolab • O 

DEBUG2 · .a:íai 
T olel • 150 Average • 30 

T otel • 165 Ave~age • 11i 

Total .. &15 Avotage • •1 

T olal .. 655 AvOrage • 32 

Total• 820 Avefage • 32 

This pmgram lists fivc numbcrs, their total, and their aVerage. lt docs this for 
fiw scts of dat~1. 1\t thC t,;JHJ, it prints thc total of allthc numbcrs and thc average 
for all thc numhcrs. 

~- Hui l'Xaminc thc output carcfully. lL isn't giving you what you want: Thc totals 
aml a veragcs <1rcn' t corree t. 

lf thc applicatiun were coded corrcclly, final oulput should look something like 
this. 

DEBUG2.ffit.1 fCil¡¡j) 
10 20 JO •o 50 Total• 150 Ave1age • JO 

1 2 J • 5 Total • 15 Ave1age • J 

11111 50 25 , 200 Total • 450 Ave1age • 90 

IU 9 ' 7 6 Total • 40 Ave1age • ' 11 n JJ .. !i!i Total • 165 Ave1ago • JJ 

Sum of alltotab • B20 
vg of all totah • J2 

!fitii)P.int· Fii~~;J~ lfii:&!JlCi;".;~;¡¡;¡¡¡. 

You m·cd to corree! Lhc lo~ic, hllt whcrc do you hcgin? 

4 .. IJoublc-click thc Control mcnu on the Debug2 form lo clase lhe application. 



·~~'~='' ____ ..., 

Module 11: DebuggingCodé in VisuaiBasic 251 

L To analyze the variables uscd in the samplc applicilliun 

l. IfVisual Basic is not running already. start il. 

2. From the File menu, choose Open Projectto loca te ailll slan DEBUG2.MAK. 
located in \WALKTIIRU\DEBUG. 

• 
3. Note that there are two files 10 this project: DEIH Ir ;~.FI<M and MOIJ2.BAS. 

4. What are the global-leve/ variables, and where they are located 0 

If you inspect the General Declarmions scction uf MOD2.BAS. yoll will sce 
x 15), an lntcgcr array, and sumcountcr Ucclarcd ;ts 0111 lnlc..:er. 

There is also a String variable callcd Filén:nnc$ in MOD~.IlAS. 

5. What are theform-level variables. and where they are loc:ned 0 

Ifyou inspect the General Declarations section of DEBUG2.FRM, you will find 
Sum declared asan Integer. But, be careful hcrc.'Visually inspecting thc 
General Declarations section doesn'tte/1 you a/1 y .. unccu '" know, anu this will 
come back to haunt you a little later on. 

Why do you need to know this? Awareness of thc typcs and seo pe of thc 
variables within your application will help in the analysis .. r thc coue. 

L To analyze the procedurcs uscd in the samplc applkalinn 

l. In DEBUG2.FRM, examine the cmdPrintFile_Ciick evcnt procedure. 

2. Which general procedure is callcd in this proccuure'! 

lf you said thc Rcaúfilc proccUurc from rvl< >1 >2.B ,\S. Y'lll \\'L' n: corrccl. 

3. Examine the ReadFile general procedure in MOD2.BAS. 

. · .. 

To display the source for the RcadFilc general procedurc. place the cursor in the 
word ReadFile in the cmdPrintFilc_Ciick proccuure anu press.SHIFr + F2 

Note the outer For ... Next loop is controlli:d by J. wlrcrcas thc inner For ... Ncxt 
loop is controlled by l. These two loops c .. ntrol P"rl t1f the c:rlculations in your 
application . 

. 
¡ 
1 

¡,). 
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· .. · 

L Tu use brcakpuints and watch cxpressions lo observe program behavlor 

In urder to observe the logic fiow and 1 and J's vaiues, we wiil use two watch 
expressions anda breakpoint. 

l. Sct a breakpoint on the Next a line. 

Ph1cc the cursor anywhere on the Next n line and press F9. 

2. Hi_ghlight the 1% variable on the For n line. 

3. Fnun the Dcbug Menu, choosc Add Watch. 

A f'orm will appcar on scrccn that looks like this. 

: · AddWalch 

IIEl 1 ¡¡eo~j 

~re::."~:: .. ~============~ l~tc."'C·'•I 
® P<ocedu<e IAeadlite 1@ 
O [o<miModute IM002.BAS F:tl 
O li.lobat 

E.xpreuion: 

Walch lylut 

® ~alch Expreuion 

O Break when Expreuion ia1rue 

O Break when Expreuion has t.hangcd 

4. Makc surc that thc values for the Add Watch window are as follows. 

Cm1lnrl Sctting 

Express ion 1% 

Procedure Readfile 

Fonn/Module MOD2.BAS 

Watch Type Watch Expression 

:i. Choosc OK. 

6. Rcpeat thc abo ve stcps ( 1 thorough 5) for J% toe reate a watch expression for 
.1 <;¡.. 

Younow ha ve two watch cxpressions. Each time your progrnm enters into break 
mmlc, the currcnt values of these lwo variables will be displayed at the top of 
thc Dcbug window. 
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L To observe your watch expresslons in action 

l. Stan your program by pressing F5. 

2. Arrange the windows so that you can see DEBUG2.FRM. thc Dcbug window, 
and MOD2.BAS code window. 

You might want to arrangc thcm so that thcy look likc this. 

For .1\ • 1. lo S 
Input lfnuAI\, X(1), K(2), X(3), X(~), x(S) 
Fon1.Print 

3. Choose the Print File button. 

Because you have seta breakpoint, your application will stop exccution on thc 
line Next n. 

4. Note the values or'J% and J% in the Dcbug window. 

Right now they should each be at 1 bccausc you are in thc first itcration of both 
loops. If you loo k at the outpul of DEB UG2.FRM, yo"' will se e thatthc valuc 1 '' 

has been printcd thcrc. 

5. Continue execution by repeatcdly prcssing F5 until J'k ci1uals 2 and 1% cqúals 5. 

Each time you press F5, your application cntcrs break mude and thc CIIITcnl 
values of !% and J% are displaycd in thc Watch pan e. 

At this point you know that 1% and J% are helwving corrcctly. lt.i:-; time to 

pursue analysis in a diffcrcnt direction. 

6. From the Run menu, choosc End to stop cxccution uf your program. 

7. Press F9 to clear your brcakpoint on the Next n line. 

The Next n line in the Readfilc procedo re of MOD2.1lAS should airead y be 
selected; so press F9. 

To this point, you ha ve seen what we wanted to dcmonstrate about watch points anJ 
watch expressions. If that is all you need from this excrcisc, thcn quit here. lf, 
however, you want to sharpen your dcbugging ski lis. cmHinuc on with thc cxcrcisc. 

The question herc is lhis: What is going wrong with the application? First, it docsn't 
sccm lo be calculating thc intlividu:1l tot;ds properly. Yo11 are ending ur with a 
Va)uc of )(¡5 fur thc scconll SCL of llUillhcrs whcn it should he 1 ). Why llon't you 

ñext seta watch point on Towl%? 

1 

' t 

1 

1 
1 

1' 

! 

' ) 
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L To use watch polnts-break when expression has changed (Total%) 

l. In thc Code window for MOD2.BAS, locate the procedure Readtile and 
highlight thc variable Total% within the For 1% loop. 

2. From the Debug menu, choose Add Watch . 
• 

3. Make sure that all the controls for the watch point are as follows. 

Cmatrol 

. Express ion 

PnM..:edure 

F<ll"lli/Module 

W:uch Type 

Setting 

Total% 

Readfile 

MOD2.BAS 

Break when Expression has Changed 

-1. Chnosc OK lo e lose thc Add window. 

Í: Tu uhscn•c your watch variable in acUon 

1. From the Run mcnu, choose Start to run your program. 

Note the entry addcd to the top of the Debug window. This will cause the 
pro!!r;un toen ter into break modc whcnevcr Total% changes. 

Yuu may nccd to cxpanú thc Watch pane display arca in ordcr to see the 
tlllditic,nul watch variable. 

2. Click the Print File command button to enter the Readtile procedure. 

J. What is thc first value for Total%? 

1 f you said 1 O, yo u were correct. 

4. Prcss F5 six more times (so that 1% equals 1 and J% equals 2). 

). Now. what is thc value ofTotal%? 

·--- --------:---------,.------

lf yo u said 1) 1, yo u wcrc corrcct; but what should thc value of Total% be at this 
poi ni. and wl1;1t Unes thattcll you? 

Thl' v:duc for Total% at this point should be 1, because that is the first value for 
thc sccond pass through the J% loop. What this tells you is that you need to reset 
the value of Total% befare each entry into the 1% loop. 

6. From the Run mcnu, choose End. 

7. Add the following Iinejust befare the For n = 1 to s Iine: 

Total% = O 

1 

1 

' 
' 
' , 
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8. Test your change by running the code again. Noticc 11ia1 lile total is corree!. 

You will·notice that the averages for the last four sets of numbers ha ve thc 
values 1, 30, 2, and 6. That is, they are still wrong. To fix this problem, what 
other variable must you zero out befare rccntering 1he 1% loop' 

If you said counter%, you were corree!. 

9. From the Run menu, choose End. 

1 O. Add the following line just before the Foc n 1 "" ' linc: 

Counter\ = O 

11. Test by running the program again. 

12. · Inspect the Total and Ave'rage for each of the ti ve scts nf dala. 

Total and Average for each set of numbers should now be corree!. Compare 
them with the correct output displayed earlier in this walk through. 

13. Inspect the values displayed for the overall sum and average values. 

They are both O. That can't be right. 

14. From the Run menu, choose En d. 

Í: To clcar all watch v~riablcs and all brcak1wints 

1. From the Debug menu, choose Edit Watch: · 

2. Choose Delete All to delete all watch points you may ha ve set. 

3. Choose Close to close the Edil Watch dialog box. 

4. From the Debug menu, choose Clear All 111 clcar :di hrcakpoinls that are set. 

L. To use watch points-IJrcak whcn cxpn.•ssiun hct:ollll'.'i Tnll' (Suw) 

255 

At this point you havc tixcd thc calculatiun of inUividu;d tolals and avcragcs, but 
the calculation ofthe overall total and avcr:lge is s1ill wrong. For this rcason. 
closer examination of the Su m variable is warrantcd. 

l. From the Debug menu, choose Add Walch. 

2. Fill in the following entries: 

Expression Sum > O 

Form!Mod DEBUG2.FRM 

Procedure cmdCiear_Ciick 

Break when Expression is True 

ChooseOK 

3. From the Run menu, choose Stan. 

4. Note the enlry added lo lhe top of the Dd1ug windnw. 

· 11lis.will cause thc prognun lo en ter iuto break ¡nudc wh~,;ncver Sum >O 
•becomes True. 
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· .. · 

L To ohscrve your watch variable in action 

l. Prc>S the Prinl File command button to run the program. 

0 Did you cvcr cnler Break mode? 

Your prograrn should not have entered break mode because the variable Sum 
waS never grcater than O. 

l. Frnm the Run mcnu, choose Break. Notice in the debug window it specifies Sum 
<Not in Contcxl>. This is because Sum is a local variable and you are not 
currcntly running the proced~re that contains Sum. 

4. From the Run mcnu, choose End. 

L To lix lhc codc-using dcbugging and logical analysis to corrcct the codc 

l. Firsl nf all, hnw many variables named Sumare in this application? 

Rcmernber atthe start of this walk through that we asked that question and said 
lhat there wa.s nnly one. Well, there are really two. lf you said two, you were 
corred. 

0 l.nok inlhc General Declarations section of DEBUG2.FRM. Notice that it 
cnutains an cxplicilly declaredform-leve/ integer variable called Sum. This 
vmiahlc is not available outside this form. 

l. Nnw look atthc code in MOD2.BAS. ls the variable called Sum there, the same · 
onc as in DEI.lUG2.FRM? No,this is an implicit variable local to the Sub 
proccdure Rcadfile. This is the source of your problem. 

How can you rnake sure that the variable called Su m in crndPrintFile in 
DEI.lUG2.FRM and the one referred to in Readfile are the same? 

lf you said delctc lhc loc;d variable dcclaration and makc it Global, you werc 
ri!-!ht. 

4. IJclclc lhc dcclaration in DEBUG2.FRM. 

). /\lid thc following Jcclaratinn lo MODULE2.BAS: 

Gl•d•ill Sum As Integer 

L To tc~l your scoping changcs 

l. Run thc program again. 

Aftcr making thcse changes, you'll discover that the sum of all totals is 2025 and 
average of alltotals is 81. Thcy're still nol right. 

' Chnosc End from the Run menu. 

k•.-..... : ~--------------·-~- -· . 
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3. Set the breakpoint on Next 1% and the watch exprcssions un 1% and J% in thc 
Readfile procedure. (Follow the guidelines outlineJ carlier in the walk through. 
if you need to.) 

L To single step through your program 

l. From the Run menu, choose Start. 

2. Click the Print File command button. 

The next line of code to be executed should be Next 1 '· 

3. Now, query for the current value of Su m by placing ynur cursor in thc Debug 
window and typing: 

?Sum 

Then press the ENTER key. 

4. Observe that the value 10 displuyed in the lmmedialc panc of lhe Debug 
window. That's the current value of Su m. 

5. Step through thc 1% loop again, stopping at lhc sanw point as bcforc, and qucry 
the value of Sum. 

6. Observe that the value 40 is displaycd. Howcver. 10 + 20 docs not equal 40. 

What's the problem? 

If you said the line: sum\ Total + sum ncetls to he movcU hclow the line: Next. 

I\, you're correct. 

7. Cut and pasté the line sum\ Total +- sum to just bclow NexL n. 

L To test your logic changcs 

l. Start and test the application again to see if it"s working propcrlynow. 

2. Compare your output with the desircd final oulput ''""''" bclow. 

l!i '·~ DEBUG2.FRM .:<,·· · :·. :· ". all] 
10 20 30 40 50 Total ~ 150 Avcfage = 30 

1 2 3 4 5 Total = 15 Average= 3 

100 50 25 75 200 Total ~ 450 Average = 90 

10 9 a 7 6 Total = 40 Average·= a 
11 22 33 44 55 Total ~ 165 Average= 33 

S um of afl totals ~ 820 
vg of afllotals = 32 

~ ,,,.--;-·-~-t%!17t??.l' 
;; ~nnLF,ilc:3tf.4:>i~ 1 '·1'f;L~b~¡,; '•· 

3. Closc lhc applicatiun anJ givc yoursclf a pal un lile lt;tl:l. 



., 
""""'"""'"'"""''"Tló' -~~ 

258 Module 11: Oebugging Code In Visual Basic 

Summary 

• Debugging Terms 

• Debugging Code in Visual Basic 

Usirig the Call T re e 

Using Watch Variables lo Monitor Program Execution 

Objectives 
·lulhis llll~tluk you lear!II.!U to: 

• l>istinguish anltmg run, dcsign, and dcbug modcs in Visual Basic. 

• Use lhc Wotch window lo disploy the curren! valucs of variables within a 
pn)gr<1111. 

• Scl hrcokpoinls within code. 

• Single step through application procedures. 

. 1 
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L. Overview 

• Scenario 

• Methods for Printing 

• Print·Related Functions 

• Using PrintForm 

Overview 
Printing to forms and printers can be as complicatcd oras simple as you \\.'ant to 
make it. This module shows you sorne of thc simple tricks that ynu can use to 
prepare lexl for prinling. 

Prerequisites 
To succeed in lhe module, you should airead y be familiar wilh: 

• The general synlax for melhods. 

• Sclect Case slalemenls and lf ... Thcn ... Eisc blocks. 

Overall Objectives 

261 

The purpose ofthis module is to give you an introduction to printing using Visual 
Basic. This r:noúulc is split into two topics: priluing toa fonn and scndinl-! that fonn 
lo a prinler. 

Learning Objectives 
. ' 

At the end of this module, you will be able to: 

• Use the Prlnt method to create output directly nntt> a forrn. 

• ·Describe how thc AutoRcdraw propcrty relates to printing dircctly toa fonn. 

• Use· the CurrentX and CurreniY propertics nf a fnrrn anJ the S pe and Tab 
functions to control thc placcmcnt of output printcd ltl a f1m11. 

• Use lhe Cls melhod lo clear a form. 

• Use thc PrlnlFunn mcthod lo scnJ a hit-!'or-hit illlil!!-e nf <1 lúnnlo thc prinh:r. 
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Scenario 

., 

• Printing a Form 

The specification for the Employee Database requires lhat users be able to print out 
an imliviuual employee's personnel information. 

Individual Reports 
Yuu lwvc Uctcrmincd that uscrs want the individual reportto include the following 
infonnollion on individuallines: 

l. l.ast na me, rir~t name, and middle initial 

2. Elcctronic mail alias and department code 

:1. Pusition typc 

.J. DcdliCtion inronnation 

5. Employee piloto centered at the bottom of the page 

Aflcr much work, you ha ve determined that a workable individual repon form 
wouhJ look likc this. 

Employee Record Details 

Employee: Richardson, Barbara, J. 

Email: barbarar Dept: SAL 

Category: Full time 

Deduct: ESPP 401(k) Uniteci Way 

X X 

D --- ··-· 
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Methods for Printing 

Synlax 

•.,· 

Print 
Next I 

Overview 

1 
2 
3 
4 
5 
6 

There are a number of different methods, funclions. ami propcrties you will nced.lo 
understand in order to print toa form. and then scnd that f"orm toa printcr. 

Me!hods Funclions Prnpcrtics 

Print S pe Curren! X 

Cls Tab CurrcntY 

PrintForm Formal AutoRedraw. 

Fontsize, and so on 

The Printer Object 
The Printer object is a prcdefincd objecl in Visual Basir. You can scnd output.lo lhc 
Printer object using the Print melhod. When you are finished placing informal ion 
on the Printer object, you use the EndDoc rnelhml lo send 1hc <>ulpulto 1hc prinlcr. 
The output will print on your dcfaull prinlcr. 

Printer.Print 
Printer.NewPage 
Printer. Print 
Printer.EndDoc 

The Print Method 

•Here is sorne informaLi¡,¡¡ (,n p;¡(¡r; one." 

'This causes a page brec:d.; 

•He re is sorne more in fe.,¡ lllco!,ion" 

'This sends the output L•-' the printer. 

The l'rinl mcthod is uscd to puta tcxt string on 11 form, a piclllrc box, ur Printcr 
object using the curr~nt color and font. This pnnion or the. module Will c.Jiscuss thc 
Print method by firsl talking aboul it in general amllhcn discussing thc 
implications of printing toa form and prin1ing lo a piclllll' hox. 

r nbjecr.]Prlnl[expre.uinnlisr][ r ;1,}} 

·. Thc· objccl can be cilhcr a furm, a pil:lurc, 111' a prinh.:r ¡., wl1ich lhc cx¡m;ssi1111 li.-.t 
· · will be printed. · 
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··~ 

The cxpression list is either text or numbers that you want to print. Multiple 
cxprcssions can be separated with a semicolon, a comma, ora space. If the 
cxpression list is omitted, Visual Basic prints a blank line. 

The scmicolon and the comma are used to specify the location of the text cursor for 
thc ncxt character displayed. A semicolon means the cursor is placed immediately 
aftcrthc last charactcr displayed. The comma means the cursor is placed at the stan 
of !he ncxt print zone. Print zones begin every 14 columns. 

Note 11 form docs not necd to ha ve the Visible propeny set to Truc to be able to 
SI!IHJ tHHput lO il. 

Walk Through-Printing with For ... Next Loops 
L To print wilh Fnr ... Ncxlloops 

l. Frum the Walk Throughs program group, stan Fancy Print. 

2. Click the form. 

This displays thc output from the code contained on the next page. 

). Fromthe Control menu, choose Close. 

Thc following cxample is available in Visual Basic Help .. 

· Pr int Method Example 

Sub PrintDemo ( J 

Const BLUE = 1 

Const MAGENTA = 5 

Con~t BRIGHTWHITE 15 
Cls 

Width = ,7200 

HeighL = 5000 

BackColol' = QBColor(BLUEJ 
For I\ = 1 Te 3 

Se}t~C1. CüSC 1~ 

Cuse 1 

Clear form. 

Set form width, 

Set f.orm height, 

Set background color. 

' First time. 

'Set foreground color. 

ForeColor = QBColor(MAGENTAJ 

K't = 1: L% = 9: M% = 1 

Msg$ 

ex = 
Case 2 

K% = 
MsgS 

ex = 
Case 3 

"Visual" 

o 

1' L\ = 9' 

= "Basic• 

ScaleWidth 

M\ 1 

Set message." 

Set position variable. 

Second time. 

· Third time. 
ForeCo1or = QBColor(BRIGHTWHITEl 

K% = 9: L% = 1: M% = -1 

Msg$ = "Visual Basic· 

ex = ScaleWidth 1 2 

End Select 

• 
l_ 

·L 

w 

" 
" e .. .. 
"" 
"" ~ 
e 
~ 

!P.'! 

~ 

f! 
e 
~ 
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· .. · 
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For J\ • K\ To L% Step 

Select Case J% 

Case 1' Fontsize 
Case 2' Fontsize 

Case 3'. Fontsize 
Case 4' Fontsize 
Case s, Font"size 

Case 6' Fontsize 
Case 7, Fontsize 
Case a, Fontsize 
Case ., Fontsize 

End Select 

If I\ ~ 1 Then 

Offset\ = O 
Elself I\ = 2 Then 

H% 

8 

10 

= 12 

14 

18 

20 

24 

36 
48 

Offset\ = TextWidth(MsgSl 
El se 

' Text in center. 

' Char1ue font size. 

Tex 1. on r i ~1ht, 

28 

29 
30 

31 
32 

33 
34 

35 

36 
37 
38 

39 
40 

41 

42 

43 

44 

45 

46 
47 
48 

49 

so 
51 

52 

Offset% TextWidth(Msg$) 1 2 

End If 
CurrentX = CX - Offset\ 
Print Msg$ 

Next J\ 

CurrentY = O 
Next I' 

53 End Sub 

Print message. 

Reset Lo top of form. 

For further examples using the Print method, sce the /illlowing. 

Application 

lconWorks 

Employee Datnbase 

Form 

ICONEDIT.FRM 

ICONEDIT.FRM 

VIEWICONrRM 

V!EWICON.FRM 

EMPREC.FRM 

l'roccclaln• 

Displ01 )' 1\ J nuscCuu rd inatcs 

l'ic_SinlusA rc;1_ P;1int 

1 .cmd_,\li_Jcons 

Pk_SciL·t.·l cd 1 conl Ja hcl_Pai nt 

crml A dd J>cletcUpdate_ Clil'k 

265 
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L, Print-Related Functions 

• Spc Function 

• Tab Function 

\ 

·.,· 

1 

1 ' 

1 



Spc Function 

Syntax 

Example 

Further Examples 
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Skip 1 space and print a 1 
Skip 2 spaces and prinl a 2 
Skip 3 spaces and prinl a 3 
Skip 4 spaces and print a 4 
Skip 5 spaces and prinl a 
Skip 6 spaces and prinl a 

This funclion inserts a specified number of blank charac1ers in a l'rinl mclhoJ. 
starting atthe current print posilion. 

Spc(number%) 

The number argument must be an integcr bctwccn O ami .12,7ú7 inclusive. 

Importan! When using fixed pitch fonts (whcre lhe space allowcd for cach 
character is the same size), Spc is not complicaled lo use; hui wilh a proportionally 
spaced font (such as Times New Roman®), lhe width of lhe spacc i.s always 1hc 
average width of all characters in lhe point sizc nf lhal font. 

1 

2 
3 

• 
S 

6 

7 

'Spc Function Example 
Sub Form_Click•() 
FontName = ~courier~ 
Print 1 2 ')" 

Pr int ~ 123456789012345678901234 ~(,'/ll'JO 1 :n,¡•,¡,·¡¡¡•ro 1 :~ l·l •,(,'/H90" 

Print ~I'll skip sorne spaces then print ar1 ;,:"; SpcUl; "x" 

End Sub 

For other examples using the S pe funclion. se e 1hc fol 1< ""ing. 

Applicalion Form l'n'l'l'll11rc 

Employee Database EMPREC.FR~l l'lndA cl1ll' ri 11 tU pda Ll'_ Cl k k 

·-· ". ·-·-~--
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Tab Function 

Syntax 

FontName = "Helv" 
·FontSize = 12 
Print "Tab to"; Tab(10) "10" 
Print "Tab to"; Tab(20); "20" 

Tab ( 3 O) ; 

10 
20 

30 

Thc Tah runction movcs the text cursor toa specified print position when used with 
thc Print methm.l. 

Tab(co/umn%) 

Thc para meter co/umno/o is an Intcgcr expression that is the column number of the 
new print positiun. The Jeftmost print position on an output linc is always l. 

J-=or fmms. thc only limit to the rightmost print position is the range of the Intcgcr 
d<lla typc. 

For a mmplcte ucscription of the Tal> function, sce Visual Basic Help. 



1 

• 
• 
~ 

~ 

~ 

• 
" 
" ,\ 

' 
' 
' 
' 
\ 

' 
\ 

\ 

\ 

Module 12: Prin1ing lo Forms and Printcrs 269 

Using PrintFórm 

Syntax 

Example 

Further Examples 

[form.]PrintForm 

PrintForm 
Once you ha ve finished formatting all the output toa fonn, you can use lhl: 
PrintForm method lo senda bit-by-bit imagc of thc formto a pri111cr. 

(form.]PrintForm 

This example is available in Visual Basic Help. lf your machinc is corrcc11y 
connec1ed lo a printer, this code will send thc currcJll form 10 it. 

1 

2 

3 

4 

5 

'PrintForm Method Example 
Sub PrintFormDemo () 

On Error GoTa ErrorHandler 
Printrorm 
Exi t Sub 

6 ErrorHandler: 

St!L llp ern1r handler. 

Print form. 

7 Msg$ = "The form could not be printed. 

8 MsgBox Msg$ 

9 Resume Next 

10 End sub 

Application Form Prun·durc 

Employee Database EMPREC.FRM ~melA ddPrint Updatc_ Click 

Remember, the Print method is uscd to place thc data on thc fonn. Thc PriniFonn 
method is u sed to send a bit·by-bit imagc or thc.: form ¡; 1 1 he Lkfallh printcr. 

You should set the AutoRedraw property of a fonn tu Trul' if y11u will print it usin~ 
the PrintForm method. If AutoRedraw is not Truc, ~raphics drawn Jircctly on thL' 
form using Print, Linc, Circlc anU othcr graphic statclllt'IIIS will not appcar un tllL' 
prinlcr. 
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------------------------------------

Walk Through-Effects of AutoRedraw 
L Tu scc lhc ciTccls of sctting !he AutoRcdraw Propcrty 

l. l'lom the Walk Throughs program group, start PrintForm & AutoRedraw. 

2. Click the Draw command button. 

This draws lines on the form. 

J. Fwm the AutoRedraw menu notice that AutoRedraw is set to False. 

4. Drag the minimized Program Manager icon onto the form and then move it 
away. 

Notice the fonn now has a gap where the Program Manager icon erased thc 
lincs. Thc lincs are not redrawn.lf you had printed this form using the 
J•rinlFurm lllcthoJ, thc lines Would not appcar. 

~. FlonJthc AutoRcdmw mcnu choosc Truc lo sct AutoRcdnaw to Truc. 

Thl' l·ndc in lhis mcnu sclcction invokcs thc Draw button for you. 

(,, 1 )r;•!-! lht.: rniuin1izcd Program Manager icon unto thc form and then movc it 
;rway. 

N~ttíu: thc i'onn aulomatically rcdraws the lines if necessary. lf you had printed 
this lúnn using thc PrintForm mcthod, the lines would appear. 

'· 
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• Scenario 

• Methods for Printing 

• Print·Related Functions 

• Using Prin!Form 

Objectíves 
In this module you leamed 10: 

• Use the Print method to create output directly onlo a form. 

• Describe how the AutoRedraw propeny rel¡¡lcs lo prinling dircctly 10 a l(mn. 

• Use the CurrentX and CurreniY propcnicsof" form ""d lhc Spc and Tah 
functions to control the placement of oulpul prin1cu to" form. 

• Use the Cls method to clear a form. 

• ·Use the PrintForm method to senda bit-ror-bit im¡¡gc of" form lo thc printc·r. 
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L Overview 

• Overview of a Database 

• How.Does Visual Basic Access Databases? 

• The Data Control 

• Binding Controls to !he Data Control 

• Data Control Walkthru 

• Data Control Methods and Properties 

Objectives 
At the end of this module, you will be able to: 

• Describe how Visual Basic accesses databases. 

• Use the data control to view the contents of a Microsoft AccesS® data base. 

·.,_ 
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Overview of a Database 

Employee ID .!tJI l~:rder ID .l.Jr- Customer ID 
Last Name Customer ID Company Name 
First Name mployee ID Contact Name 

Employees Orders Customers 

. 
NWIND.MDB 

Overview of a Database 
11tc l'ollowing inl'ormation will help you understand sorne of the terminology and 
conccpts associatcd with database structure and design. 

Relational Database Objects 
Visual Basic pro vides a relarional interface to database files. Basically, a relational 
database is one that slores data of tables, made up of colunu!S and rows. In Visual 
Basic, columns are referred to asfields and rows are referrcd toas records. 

Tables 
Atable is a logical grouping of related information. For example, the Northwind 
Traders database has atable that lists all the employees and another table that lists 
all the customers. · 

· .. · 
,. 
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Overview of a~Table 

Example 

Rows 
(records) ~ 

, 

' 

Employees Table 

Employee ID 

135 

284 

Last Name First Name 

Leverting Ti m 

Buchanan B.L. 

··~.uu:s::.a;~~-... 
"""' ,.. 

Co/umns (fields)' 

Fields 
Each column or fíeld in atable contains a single piece uf information. For example. 
the Employees table has fields for Employee ID, Las! Na me, anJ so forth. 

Records 
A row or record in atable contains informal ion about a single entry in atable. For. 
example, a record in the Employees table would ha ve information on a particular 
employee. Generally, you do not want two records in atable to ha ve the exact same 
data. You would not want to ha ve two Employees with the same name and the· same 
ID number. Most tables ha ve a tield br combination of fields thal must be unique. 

Indexes 
To make access to the database faster, most Jmabases use indexe J. Data base table 

· indexes are soned lisis that are faster to search ihan llie tables. 

Structure Ouery Language {SOL) 
Once the data is stored in the database, retrieving it is maJe casicr by using an 
English-like language called Structured Query Langua¡:e, or SQL. SQL has 
evolved into the most widely accepted means lo "converse" with a databuse. The 
user submits a query and the database returns allthc rows that match that query. 

Select [Last Name), Title From Employees Where Title = 'Sales Rep' 

Sample Oatabases 
In this course you will the Nonhwind Traders sample d;l!abasc. This dawbosc is 
included with Microsoft Access. 
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How Does Visual Basic Access Databases? 

Visua: Basic li=j ==• ~ 
~ .. ::::::::=J=I..l~-:l=::i~~ . 

lnstauable lnstallable · 
ODBC ISAM ISAM Other 

. Driver Driver ISAM 
_ --~-. _ Drivers 

:! o!:J~ ~ ~ 
Drivers ~ .....__., 71-- ,...,...., -

SOL 
DB 

OAACLE 

~ 

How Does Visual Basic Access Databases? 
There are lhree typcs of databases that you can access from Visual Basic: 

• "Native" Microsoft Access databases. These databases are accessed directly 
by Visual Basic. 

• lndexed sequential access method (!SAM) databases-for example dBASE, 
Paradox®, and Btrieve® databases. Visual Basic reaches these databases 
lhrough uscr-installable drivers thatlink Visual Basic lo the specific 
databascs. 

• Open Database Connectivity (ODBC)-accessible databases. These include 
client-server database management systems (DBMSs), such as Microsoft 
SQL Servcr and ORACLE®. Visual Basic reaches these databases through 
the appropriatc ODBC drivers. 

Thcrc are various gJtcways that are available to connecl toa mainframe database. 
This is typically irnplernentcd through an ODBC driver. 

., ; 

.. ·; -;,:: . 
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The Data Control 

: ... 

1 
Move Previous 

1 
Move Las! 

Move First Move Next 

Data Control 
The data control allows you to link a Visual Basic formto a database. With the data 
control, you can create an application that displays and updates data from a 
database-without writing a single line of codc! 

Adding the Data Control to the Toolbox 
If the data control is no! visible in thc Toolbox, add the following line althc end of 
the [Visual Basic] section in the VB.INI lile in the C:IWINDOWS directory: 

DataAccess=l ' 

The DatabaseName Property 
The dala control locales the database through the DatabaseNamc propeny. If you 

· .. are connecting lo a dBASE, Paradox, or Btricve, database, setthe DatabaseName 
propeny 10 the directory that contains the database files. 

Datal.DatabaseNarne = ·c:\walkthru\nwind.ffidb• 

The RecordSource Property 
The RecordSource propeny indicates thc na me of a tahlc, qucry or it contains thc' 
text of an SQL string. 

The following example connects the data control lo the Employees table: 

Datal.RecordSource = •Employees" 

Thc following cxamplc rctricvcs a suhsct of the Jimployt•t•s tahlt• .. 

···~Datal.RecordSource = •select • from Employees where [Last Namel > 'M'" 
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Joining Two Tables 
Thc l'ullowing cxamplc joins two tables. Thc brackcts are uscu with lielus that havc 
a spa~.:c in thc name: 

Datal.RecordSource 

Ordering the Records 

~select customers. [Customer Id), 
A{Contact Narne], (Order Id] 

AFrom Customers, Orders 
AWhere Customers. (Customer Id} 
AOrders. [Customer Id)• 

The following example selects only sorne of the fields in the Employees table and 
orders the recorus by last name: 

Datal .R~cordSource = •select (First Name], [Last Name] from 
AEmployees arder by (Last Name]• 



;_-•.. 

. · .. · 
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Binding Controls to the Data Control 

!~ · Form1 J§i~l 

Example 

Binding Controls to the Data Control 
The text, picture, image, check box, masked edit, 3D panel, and 3D check box 
controls can be bound toa data controL When a control is bound toa data control, . 
the data from the database is automatically displayed in thc bound controL In 
addition, if the u ser changes the data in the bound control, thosc changcs are 
automatically posted to thc databasc as thc uscr movcs to anothcr row. 

··To bind a control toa data control, set thc o:uaSo~rce p¡openy to the data control 
name and set the DataField propcrty toa licld namc fronl.lhc data control's tablc. . . : 
'The DataSource property must be set at design ti~e. 

Textl.DataSource = natal ... 

'The DataField property can be set -at ·clesign ur r1m. Llrne 

'Textl.OataField •(Last Name)• 

., '·. 
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Data Control Walkthrough 

· .. · 

--- - --------- r;;;l 
fEl Form1 iilll""'i 

Last Name: Ll ___ _, 

First Name: Ll ____ _, 

Data Control Walkthrough 
'To get a quick overview'of the data control, let's create a simple apptication that 

connects to the'Microsoft Access Northwind database and browses the Employees 
table: · 

l. Start with a new project and add the data control to the form; leave the default 
na me Data l.· '"'' · · 

2. Setth~ follo~i;1g propcrti~s for Data!: 

DatabaseNai11e = c:\walkthru\nwind.mdb 
RecoruSource = Employees 

Note When you set the DatabaseName at design time, Visual Basic attempts to 
connectto thc <latabase. lf itsuccessfully connects to the database, it will display a 
list of possible valucs for the RecordSource property. Notice when you set the 
RecoruSource property, you can type data in directly or choose the DOWN ARROW to 
display a list of possible selections. 

3. Auu two text boxes to the form; leave the names Textl and Text2. 

4. Sctthe following propcrtics for Textl: 

DataSource = Data 1 
UataFielu = Last N ame 

5. Sct the following properties for Text2: 

DataSourcc = Datal 
DataField = First N ame 

·h. Run yuur appli..:ation! 

(continued ollfollowing jJage) 
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7. Click the right arrow button to move forwaru, lefl arrnw bunon to move 
backward. 

8. Change a last name, click the right arrow buuon to move forward, and then click 
the left arrow button to move back. The record should be updated. 

9. Notice you have not wriuen a single line of code! 

. :) 

ii,.; 
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Data Control Methods and Properties 

.. ,· 

• Refresh Method 

• Connect 

• Exclusive 

• ReadOnly 

·' 

Refresh Method 
The <lata control reflects modifications to existing data by other users but does not 
reflect records deleted or added by other users. The Refresh method updates the 
data control with the latest information from thedatabase. 

Oatal.Refresh. 

Connect Property 
The Connect property indicates the type of database that will be opened. The 
Conncct property docs not nccd to be set if you are connecting toa Microsoft 
Acccss uatabase. 

l>alalmsc fnrmal 

Mit.:rosurt At.:ccss 

<liJASE 

Btric"vc 

ODIJC 

Exclusive Property 

Databasc namc 

dri ve:lpathllile.mdb 

drive:\pathl 

Jrive:\p<~lh\ 

drive:\path\ 

Registered data source 
name (server) 

Connccl 

(none) 

"dbase lll;" or "dbase IV;'' 

· "parm..lox;" 

"btrieve;" 

''odbc;dsn=datasource:uid= 
user;pwd=password" 
(Professional Edition only) 

lf you set the Exclusive property to True and then open the database, no other 
application will be allowed to open the database.until you close the database. lf 
anothcr application has the database open and you attemptto open the database 
with Exclusive sct to True, your application will rcceiv~a run-time error. 

ReadOnly Property 
lf you sct the Rca<IOnly property to True, your application will not be allowed to 
writc tn the database. 

-'· 
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·A Sample Application 

loa1 Na~-··. . :.· 'í:: . ),; 

F'utl N ame 

INencyd 

A Sample Application 

¡· ·"' '""'1 :.vtaát~ . 

•,;[··..,·· '· '"'' .• _;: -,.'f,¡\f 

Here is a sample application that adds, finds, updates ami delctcs rccords from a 
database. 

The details on how lo code this application are bcyond thc scopc of thisclass. 
However, you may find this application useful asan examplc. 

The demonstration program DBSAMPLE.MAK is loc;llcd in thc 
IWALKTHRU\DBSAMPLE directory. 

'' 
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I Summary ).: . 

. -~ •' 
···, ...::.: 

• Overview of a Database 

•. How Does Visual Basic Access Databases? 
! ·-... 

• The Data Control . 

• .Biñ-ding Controls to the Data Control-
- l:'~ f 

•"Data Control waikthru 

• Data Control Methods and Properties 
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